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Preface

Thank you for purchasing the DocuPrint CM225 fw.

This guide is intended for users who use the printer for the first time, and provides all the necessary operating 
information about the print, copy, scan, and fax functions.

Please read this guide to achieve the best performance from this printer.

This guide assumes you are familiar with computers and the basics of network operation and configuration.

After reading this guide, keep it safe and handy for future reference.

Fuji Xerox Co., Ltd.
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Types of Manuals

Paper Manuals

Manuals Included on the Software Pack CD-ROM

Safety Guide Describes the information you need to know before using the printer and how to 
operate the printer safely.

Setup Guide Provides step-by-step instructions on how to set up your printer. Also describes 
how to check the network connection.

Lifting Your Printer Describes how to lift and hold your printer.

User Guide (this guide) Describes how to get ready to print and set various features. It also covers the 
operator panel menus, troubleshooting tips, and maintenance information.

Troubleshooting Guide Describes the troubleshooting tips for printer problems such as paper jams.

This guide can be opened from the Launcher.

Product Features Describes the product features.

This guide can be opened from the installer.

Show Me How Describes the error recovery procedures for the printer.

This can be opened from the SimpleMonitor.

PostScript 3 Compatible User Guide Describes how to set up your printer as a PostScript 3 Compatible printer and the 
features that can be configured on your print driver.
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Using This Guide

Organization
This guide is organized into the following chapters. The summary of each chapter is as follows:

Conventions
• In this guide, personal computers and workstations are collectively called "computers".

• The following terms are used throughout this guide:

IMPORTANT: 

• Important information that must be read and followed.

NOTE: 

• Additional information that merits emphasis.

See also: 

• References within this guide.

• Orientation of documents or paper is described in this guide as follows:

, , Long Edge Feed (LEF): Loading the document or paper in landscape orientation.

, , Short Edge Feed (SEF): Loading the document or paper in portrait orientation.

• Some of the items in the screen shots and illustrations may not be displayed or available depending on your 
printer model.

1 Specifications Describes the printer specifications.

2 Basic Operation Describes the main components of the printer, the power saver mode, and how to 
turn on/off the printer.

3 Printer Management Software Describes the software available for the printer.

4 Printer Connection and Software 
Installation

Describes the basic information about how to connect the printer to your computer 
and how to install the print driver.

5 Printing Basics Describes the supported paper, how to load paper, and how to print data using 
various print features.

6 Copying Describes how to copy documents and the adjustment features.

7 Scanning Describes how to set and use the Scan features.

8 Faxing Describes how to set and use the Fax features.

9 Using the Operator Panel Menus 
and Keypad

Describes the setting items available on the operator panel, their setup 
procedures, and how to use the number pad.

10Using the Server Address Book 
and Server Phone Book

Describes how to set the server address book and server phone book.

11Digital Certificates Describes how to create and manage digital certificates.

12Troubleshooting Describes the troubleshooting tips for printer problems such as paper jams.

13Maintenance Describes how to clean the printer, how to replace toner cartridges, and how to 
see the printer status.

14Contacting Fuji Xerox Describes support information.

LEF Orientation SEF Orientation

Paper feed direction Paper feed direction
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Product Features

Easy Wireless Connection Set Up (EZInstall)

You can easily connect the printer to a wireless network 
by using the installer on the Software Pack CD-ROM.

For more information, see "Configuring Wireless 
Connection Settings" on page 62.

Manual Duplex Print

The duplex print feature allows you to print two or more 
pages on the front and back sides of a single sheet of 
paper manually. This feature helps reduce paper 
consumption.

For more information, see "Manual Duplex Printing" on 
page 100.

N-Up (2-in-1 Copy)

The N-Up copy feature allows you to copy two original 
pages on a single sheet of paper. This feature helps 
reduce paper consumption.

For more information, see "N-Up" on page 135.

ID Card Copy

You can copy both sides of an ID card on one side of a 
single sheet of paper in its original size by selecting ID 
Card Copy on the touch panel. This feature helps to 
show both sides of an ID card in one page in its original 
size.

For more information, see "Using the ID Card Copy" on 
page 137.

Scanning to a USB Storage Device

You do not need a computer to connect your USB 
storage device to save the scanned data. Insert your 
USB storage device in the port on the printer, and save 
the scanned data directly to your USB storage device.

For more information, see "Scanning to a USB Storage 
Device" on page 163.

Printing Through Wireless Connection (Wireless 
Print)

The wireless LAN feature on your printer allows you to 
install the printer at any location, and enables printing 
without a wired connection to your computer.

For more information, see "Wireless Connection" on 
page 52.
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USB Direct Print

The Print from USB feature allows you to print directly 
from your USB storage device without requiring you to 
start your computer and an application.

For more information, see "Direct Print Using the USB 
Storage Device" on page 109.

Secure Print

The Secure Print feature allows you to temporarily store 
your print data in the printer memory and output it later. 
You can effectively manage your time when you print 
confidential data or large-volume data at off-peak hours.

For more information, see "Using the Secure Print 
Feature" on page 107.

Multiple Up Print

The multiple up print feature allows you to print multiple 
pages on a single sheet of paper. This feature helps 
reduce the paper consumption.

For more information, refer to the Help provided for the 
print driver.

Scan to E-mail

When you want to send scanned data by e-mail, use the 
Scan to E-mail feature. You can directly send the data 
scanned as an e-mail attachment. You can choose 
destination e-mail addresses from the address book on 
the printer or server. Or, you can enter the address using 
the keyboard displayed on the touch panel.

For more information, see "Sending an E-mail With the 
Scanned Image" on page 165.

Scan From Document Glass

You can scan the pages of a book or a brochure from the 
document glass. When you scan documents using the 
document glass, place them face down.

For more information, see "Making Copies From the 
Document Glass" on page 128.

Scan From ADF

You can scan sheets of unbound paper using the 
automatic document feeder (ADF). When you scan 
documents using the ADF, load them face up.

For more information, see "Making Copies From the 
ADF" on page 130.
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Direct Fax from Computer

You can directly send faxes from your computer using 
the fax driver. You can specify the fax settings like the 
normal fax. Also, you can specify the recipient's fax 
number using the number pad, or the address book.

For more information, see "Sending a Fax from the 
Driver (Direct Fax)" on page 183.

Address Book

Address Book simplifies the recipient specification. You 
can use the address book on the printer as well as on 
the server. Select the desired address or fax number 
from the address book when using the Scan to E-mail or 
Scan to Network feature, or sending faxes.

For more information, see "Address Book Editor" on 
page 42.

Fuji Xerox Imaging Technology

This printer reproduces smooth lines and gradations by 1200  2400 dpi high-resolution LED print heads and Micro 
Accurate Control Screen (MACS) Technology.

In addition, the color registration of each toner is corrected with ultra high precision through a digital process by 
Image Registration Control Technology (IReCT).

Conventional technology

Jagged line

Enhanced image

Smooth line
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1
Specifications

This chapter lists the main specifications of the printer. Note that the specifications of the product may change 
without prior notice.

• "Basic Function/Copy Function" on page 17

• "Print Function" on page 19

• "Scan Function" on page 21

• "Fax Function" on page 22

• "Direct Fax Function" on page 23
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Basic Function/Copy Function

Type Console

Memory 512 MB

Color Capability Full color

Scan Resolution Document glass: 600  600 dpi

Automatic document feeder: 600  300 dpi

Print Resolution 1200  2400 dpi

Halftone/Printable Colors 256 tones/color (16.7 million colors)

Warm-Up Time 35 seconds or less (at 22°C room temperature)

IMPORTANT: 
• It may take longer due to the image quality adjustment.

Original Paper Size Document glass:

The maximum size is 215.9  297 mm for both sheets and books.

Automatic document feeder:

The maximum size is 215.9  355.6 mm.

Output Paper Size Maximum: Legal

Minimum: 76.2  127 mm (3  5")

Image loss width: Top edge, 4 mm or less; bottom edge, 4 mm or less; left and 
right edges, 4 mm or less

Output Paper Weight 60 – 163 gsm

IMPORTANT: 
• Use paper recommended by Fuji Xerox. Copying may not be performed 

correctly depending on the conditions.

First Copy Output Time Monochrome: 20.0 seconds (for A4 /monochrome mode)

Color: 30.0 seconds (for A4 /color mode)

IMPORTANT: 
• The values may vary depending on the machine configuration.

Reduction/Enlargement Size-for-Size: 1:1 ± 1.3%

Preset %: 50%, 70%, 81%, 100%, 122%, 141%, 200%

Variable %: 25 – 400% (1% increments)

Continuous Copy Speed Document glass: 

Monochrome: 18 sheets/minute

Color: 18 sheets/minute

Automatic document feeder:

Monochrome: 18 sheets/minute

Color: 8 sheets/minute

IMPORTANT: 
• Print speed may decrease due to factors such as paper type, paper size, and 

printing conditions.

• When continuously printing a single document of A4 .

Paper Tray Capacity Standard: 150 sheets (Standard 150 sheet tray) 

Maximum paper capacity: 150 sheets (standard)

IMPORTANT: 
• When using Fuji Xerox P paper (64 gsm)

Continuous Copy 99 images

NOTE: 
• The machine may pause temporarily to perform image stabilization.
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Output Tray Capacity Approximately 100 sheets (face down )

IMPORTANT: 
• When using Fuji Xerox P paper (64 gsm)

Power Supply AC 110 – 127 V ± 10%; 7 A; both 50/60 Hz ± 3 Hz

AC 220 – 240 V ± 10%; 5 A; both 50/60 Hz ± 3 Hz

IMPORTANT: 
• Power outlets that provide the above power level are recommended.

Power Consumption Maximum power consumption: 820 W or less

Low power mode: 25 W or less

Sleep mode: 3 W or less

Standby mode: 42 W or less

Dimensions 410 (W)  439 (D)  388 (H) mm

Weight 17 kg

IMPORTANT: 

• The weight of paper is not included.

• The weight of the toner cartridges is included.

Space Requirement 921 (W)  1310 (D) mm

IMPORTANT: 
• When the standard 150 sheet tray is pulled out and the rear cover is open.
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Print Function

Type Built-in

Continuous Print Speed Same as the Copy Function

Print Resolution Same as the Copy Function

Page Description Language PCL and PostScript 3 Compatible

Protocol Ethernet (standard): TCP/IP (IPv4/IPv6, LPD, IPP, IPPS, Port9100, WSD, HTTP, 
HTTPS, SMTP, RARP, AutoIP), SNMP, DHCP, DHCPv6, BOOTP, Bonjour 
(mDNS), AirPrint, Google Cloud Print™

IEEE 802.11b/802.11g/802.11n (standard) 

NOTE: 

• WSD stands for Web Services on Devices.
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Operating System PCL6 driver:

Microsoft® Windows Server® 2003 (32-bit)

Microsoft® Windows Vista® (32-bit)

Microsoft® Windows Server® 2008 (32-bit)

Microsoft® Windows® 7 (32-bit)

Microsoft® Windows® 8 (32-bit)

Microsoft® Windows® 8.1 (32-bit)

Microsoft® Windows Server® 2003 (64-bit)

Microsoft® Windows Vista® (64-bit)

Microsoft® Windows Server® 2008 (64-bit)

Microsoft® Windows® 7 (64-bit)

Microsoft® Windows Server® 2008 R2 (64-bit)

Microsoft® Windows® 8 (64-bit)

Microsoft® Windows Server® 2012 (64-bit)

Microsoft® Windows® 8.1 (64-bit)

Microsoft® Windows Server® 2012 R2 (64-bit)

PostScript 3 Compatible:

Microsoft® Windows Server® 2003 (32-bit)

Microsoft® Windows Vista® (32-bit)

Microsoft® Windows Server® 2008 (32-bit)

Microsoft® Windows® 7 (32-bit)

Microsoft® Windows® 8 (32-bit)

Microsoft® Windows® 8.1 (32-bit)

Microsoft® Windows Server® 2003 (64-bit)

Microsoft® Windows Vista® (64-bit)

Microsoft® Windows Server® 2008 (64-bit)

Microsoft® Windows® 7 (64-bit)

Microsoft® Windows Server® 2008 R2 (64-bit)

Microsoft® Windows® 8 (64-bit)

Microsoft® Windows Server® 2012 (64-bit)

Microsoft® Windows® 8.1 (64-bit)

Microsoft® Windows Server® 2012 R2 (64-bit)

Mac OS X 10.5 Leopard

Mac OS X 10.6 Snow Leopard

Mac OS X 10.7 Lion

OS X 10.8 Mountain Lion

OS X 10.9 Mavericks

Red Hat® Enterprise Linux® 6 Desktop (32-bit)

SUSE® Linux Enterprise Desktop 11 (32-bit)

Ubuntu® 12.04 (32-bit)

Red Hat® Enterprise Linux® 6 Desktop (64-bit)

SUSE® Linux Enterprise Desktop 11 (64-bit)

Ubuntu® 12.04 (64-bit)

IMPORTANT: 

• For information about the latest supported OS, refer to the Fuji Xerox web site.

Fonts PCL/PostScript 3 Compatible:

80 fonts and 36 Symbol Sets

Emulation PCL 6, PostScript 3 Compatible

Interface Standard: Ethernet (100BASE-TX/10BASE-T), USB 2.0 (Hi-Speed), 
IEEE 802.11b/802.11g/802.11n
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Scan Function

Type Color scanner

Scan Resolution 1200  1200 dpi, 600  600 dpi, 300  300 dpi, 200  200 dpi

Scan Speed Monochrome: 18 sheets/minute

Color: 7 sheets/minute

(600 dpi, Scan to PC)

IMPORTANT: 

• The scanning speed varies depending on documents.

Interface Same as the Print Function

Scan to PC Protocol: TCP/IP (SMB, FTP)

Operating System:

Microsoft® Windows Server® 2003 (32-bit)

Microsoft® Windows Vista® (32-bit)

Microsoft® Windows Server® 2008 (32-bit)

Microsoft® Windows® 7 (32-bit)

Microsoft® Windows® 8 (32-bit)

Microsoft® Windows® 8.1 (32-bit)

Microsoft® Windows Server® 2003 (64-bit)

Microsoft® Windows Vista® (64-bit)

Microsoft® Windows Server® 2008 (64-bit)

Microsoft® Windows® 7 (64-bit)

Microsoft® Windows Server® 2008 R2 (64-bit)

Microsoft® Windows® 8 (64-bit)

Microsoft® Windows Server® 2012 (64-bit)

Microsoft® Windows® 8.1 (64-bit)

Microsoft® Windows Server® 2012 R2 (64-bit)

Mac OS X 10.5 Leopard

Mac OS X 10.6 Snow Leopard

Mac OS X 10.7 Lion

OS X 10.8 Mountain Lion

OS X 10.9 Mavericks

IMPORTANT: 

• For information about the latest supported OS, refer to the Fuji Xerox web site.

File Format:

Monochrome binary:

TIFF (Compression type: MMR)

PDF (v1.7) (Compression type: MMR)

Gray scale/Full color:

TIFF (Compression type: JPEG)

JPEG (Compression type: – )

PDF (v1.7) (Compression type: JPEG)

Scan to E-mail Protocol: TCP/IP (SMTP, POP3)

File Format:

Monochrome binary:

TIFF (Compression type: MMR)

PDF (v1.7) (Compression type: MMR)

Gray scale/Full color:

TIFF (Compression type: JPEG)

JPEG (Compression type: – )

PDF (v1.7) (Compression type: JPEG)
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Fax Function

Send Document Size Document glass: Maximum: A4/Letter

Automatic document feeder: Maximum: Legal

Recording Paper Size Maximum: Legal

Minimum: A4/Letter

Transmission Time 3 seconds

IMPORTANT: 

• When transmitting an A4 size 700-character document in the standard quality 
(8  3.85 lines/mm) and high speed mode (28.8 kbps or above: JBIG). This is 
only the transmission speed for image information and does not include the 
controlling time for the communication. Note that the actual transmission time 
depends on the content of documents, the machine that the recipient uses, 
and the status of the communication line.

Transmission Mode ITU-T Super G3/G3 ECM/G3

Scan Resolution Standard: 8  3.85 line/mm

Fine: 8  7.7 line/mm

Super Fine: 8  15.4 line/mm

Ultra Fine: 16  15.4 line/mm

Coding Method MH, MR, MMR, JBIG

Transmission Speed G3:33.6/31.2/28.8/26.4/24.0/21.6/19.2/16.8/14.4/12.0/9.6/7.2/4.8/2.4kbps

Applicable Telephone Line Telephone subscriber line, PBX, Fax communication (PSTN), G3-1 port
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Direct Fax Function

Document Size A4, Letter, Folio, Legal

Transmission Resolution Same as the Fax Function

Transmission Speed Same as the Fax Function

Applicable Telephone Line Same as the Fax Function

Operating System Microsoft® Windows Server® 2003 (32-bit)

Microsoft® Windows Vista® (32-bit)

Microsoft® Windows Server® 2008 (32-bit)

Microsoft® Windows® 7 (32-bit)

Microsoft® Windows® 8 (32-bit)

Microsoft® Windows® 8.1 (32-bit)

Microsoft® Windows Server® 2003 (64-bit)

Microsoft® Windows Vista® (64-bit)

Microsoft® Windows Server® 2008 (64-bit)

Microsoft® Windows® 7 (64-bit)

Microsoft® Windows Server® 2008 R2 (64-bit)

Microsoft® Windows® 8 (64-bit)

Microsoft® Windows Server® 2012 (64-bit)

Microsoft® Windows® 8.1 (64-bit)

Microsoft® Windows Server® 2012 R2 (64-bit)

Mac OS X 10.5 Leopard

Mac OS X 10.6 Snow Leopard

Mac OS X 10.7 Lion

OS X 10.8 Mountain Lion

OS X 10.9 Mavericks

IMPORTANT: 

• For information about the latest supported OS, refer to the Fuji Xerox web site.



24 Basic Operation

2
Basic Operation

• "Main Components" on page 25

• "Turning On/Off the Printer" on page 30

• "Setting Initial Settings on the Operator Panel" on page 32

• "Printing a Panel Settings Page" on page 34

• "Power Saver Mode" on page 35
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Main Components

Front View

1 Output Tray Extension 2 Center Output Tray

3 Operator Panel 4 Automatic Document Feeder (ADF)

5 Document Feeder Tray 6 Document Output Tray

7 Toner Access Cover 8 Print Head Cleaning Rod

9 Power Switch 10 Standard 150 Sheet Tray

11 USB Drive
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Rear View

Automatic Document Feeder (ADF)

1 ADF Cover 2 Ethernet Port

3 USB Port 4 Wall Jack Connector

5 Phone Connector 6 Rear Cover Handle

7 Power Connector 8 Rear Cover

9 Transfer Roller 10 Paper Chute

11 Paper Feed Roller 12 Transfer Belt

13 Levers

1 ADF Cover

2 Document Guides

3 ADF Glass

4 Document Glass

5 Document Feeder Tray

6 Document Cover
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Operator Panel

NOTE: 

• Moving to a different menu or returning to a previous screen cancels the current entry or setting. Make sure to save the 
current entry or setting. 

• For details on how to use the number pad to enter numbers, see "Using the Number Pad" on page 257.

1 (Services Home) button Moves to the top service menu screen.

2 Touch panel Specifies the settings by directly touching the screen.

Displays various settings, instructions, and error messages.

3 Number Pad Enters numbers and characters.

4 (Clear All) button Resets the current setting, and returns to the top menu.

5 (Power Saver) button Exits the power saver mode. When the machine is not used for a while, it 
enters the power saver mode to reduce power consumption. When the power 
saver mode is active, the button blinks.

6 (Stop) button Cancels active or pending jobs.

7 (Start) button Starts a job.

8 Status LED (Mobile) Shows a blue light when the Wi-Fi Direct®, AirPrint, and Google Cloud Print™ 
connections are established, and blinks in certain conditions.

9 Status LED (Error) Shows an amber light when an error occurs and a blinking amber light when 
an unrecoverable print error occurs.

10 Status LED (Data) Shows a green light when the printer is ready and a blinking green light when 
data is being received.

11 C (Clear) button Deletes numbers and characters.

12 Redial / Pause button Re-dials a telephone number.

Inserts a pause into a telephone number.

13 (System) button Moves to the System screen. You can access various information and menus, 
check consumable levels, and print various types of reports and lists.

14 (Job Status) button Moves to the Job Status screen. You can check or cancel active jobs and also 
access Secure Print and Secure Fax Receive.

321 5

6

4

710 9 8111241 31
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Touch Panel - Top Service Menu Screen
This section describes the fields and buttons on the top service menu screen which is displayed by pressing the 

(Services Home) button. This is the default screen that appears when the printer is turned on.

• Message Field
Displays the printer status, error message, and IP address assigned to the printer.

• Toner Status Icon
Displays the condition of toner in 6 levels. (The toner level for each color: 100%, 80%, 60%, 40%, 20%, 0%)

Selecting this icon moves to the Supplies tab.

• Wireless LAN Connection Status Icon
Displays the intensity of wireless signal when wireless connection is established.

Selecting this icon moves to the Wi-Fi Status menu.

• Wi-Fi Direct Connection Status Icon
Displays the Wi-Fi Direct connection status when Wi-Fi Direct is enabled.

• Function Buttons
Displays the features for functions such as Copy, E-mail, Scan To, Fax, Print from USB, and ID Card Copy.

NOTE: 

• Functions that are disabled do not appear on this screen. For details about enabling and disabling functions, see "Enabling 
the Panel Lock" on page 250.

Copy

You can set the features for the Copy function.

For more information, see "Copying" on page 125.

E-mail

You can scan documents and send the scanned data as an e-mail attachment.

For more information, see "Sending an E-mail With the Scanned Image" on page 165.

Scan To

You can set the features for the Scan function.

For more information, see "Scanning" on page 139.

1Message Field

Function Buttons

Toner Status Icon

Wireless LAN Connection
Status Icon

Wi-Fi Direct Connection
Status Icon
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Fax

You can set the features for the Fax function.

For more information, see "Faxing" on page 171.

Print from USB

You can set the features for the Print from USB function.

For more information, see "Direct Print Using the USB Storage Device" on page 109.

ID Card Copy

You can set the features for the ID Card Copy function.

For more information, see "Using the ID Card Copy" on page 137.
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Turning On/Off the Printer

Turning On Your Printer

IMPORTANT: 

• Do not use extension cords or power strips.

• The printer should not be connected to an uninterruptible power supply (UPS) system.

1 Connect the power cord to the power connector on the rear of your printer (see "Rear View" on page 26).

2 Connect the other end of the cord to the power source.

3 Turn on the printer.

NOTE: 

• When you turn on the printer for the first time, follow the on-screen instructions on the touch panel to configure the initial 
settings of your printer.

See also: 

• "Setting Initial Settings on the Operator Panel" on page 32
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Turning Off Your Printer

1 Turn off the printer.

NOTE: 

• The data in the memory is cleared when the printer is turned off.
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Setting Initial Settings on the Operator Panel

You need to set the printer language, country, clock date, time, and fax settings when you turn on the printer for the 
first time.

When you turn the printer on, the wizard screen to perform the initial setup appears on the touch panel. Follow the 
steps below to set the initial settings.

1 Turn on the printer.

The Select Your Language screen appears.

NOTE: 

• If you do not start configuring the initial settings, Ready appears on the touch panel in three minutes. 
After that, you can set the following initial setup by enabling Power On Wizard on the touch panel or the CentreWare 
Internet Services if needed. 
For more information on operator panel, see "Understanding the Printer Menus" on page 206. 
For more information on the CentreWare Internet Services, see "CentreWare Internet Services" on page 38.

2 Select the desired language.

3 Select Next.

The Date/Time screen appears.

4 Select Time Zone.

5 Select the desired geographic region.

6 Select the desired time zone, and then select OK.

7 Select Date.

8 Select a data format from the menu displayed by selecting Format.

9 After selecting the box under Year, select  or , or use the number pad to enter the desired value.

Repeat this step to enter the desired value for Month and Day.

10 Select OK.

11 Select Time.

12 Select the time format from 12 Hour or 24 Hour. If you select 12 Hour, select AM or PM.

13 After selecting the box under Hours, use the number pad to enter the desired value.

Repeat this step to enter the desired value for Minutes.

14 Select Next.

The Fax (Do you want to setup Fax Now?) screen appears.

To set fax settings, select Yes, Setup FAX and follow the procedure below. To end the settings, select No, 
I'll Do it later and proceed to step 19.

15 Enter the fax number of the printer using the number pad.

16 Select Region.

17 Select the desired region.

The default paper size is automatically set when you select a region.

English

Simplified Chinese

Traditional Chinese

Korean
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18 Select Next.

The Setup Complete (Congratulation, setup is complete) screen appears.

19 Select Done.

The printer automatically restarts after selecting Done.
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Printing a Panel Settings Page

Using the Operator Panel

1 Press the  (System) button.

2 Select Report / List.

3 Select Panel Settings.

4 Select Print.

The Panel Settings page is printed.

Using the Printer Setting Utility (Windows Only)
The following procedure uses Microsoft® Windows® 7 as an example.

1 Click Start  All Programs  Fuji Xerox  Fuji Xerox Printer Software for Asia-Pacific  your printer  
Printer Setting Utility.

NOTE: 

• The window to select a printer appears in this step when multiple print drivers are installed on your computer. In this 
case, click the name of the desired printer listed in Printer Name.

The Printer Setting Utility appears.

2 Click the Printer Settings Report tab.

3 Select Reports from the list at the left side of the page.

The Reports page is displayed.

4 Click Panel Settings.

The Panel Settings page is printed.
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Power Saver Mode

The printer has a power saving feature which reduces power consumption during periods of inactivity. This feature 
operates in two modes: Low power mode and sleep mode. As delivered, the printer switches to the low power mode 
five minutes after the last job is finished. The printer then switches to the sleep mode after another six minutes of 
inactivity. When the printer is in the low power mode, the LCD backlight turns off. In the sleep mode, the (Power 
Saver) button lights up. The display goes blank and nothing more appears.

The factory default settings of five minutes (Low Power Timer) and six minutes (Sleep Timer) are changeable within 
the range of 5 to 30 minutes (Low Power Timer) and 1 to 6 minutes (Sleep Timer). The printer returns to the ready-
to-print state in about 28 seconds when re-activated.

Exiting the Power Saver Mode
The printer automatically exits the power saver mode when it receives a job from a computer. To manually exit the 
low power mode, press any button on the operator panel. To exit the sleep mode, press the  (Power Saver) 
button. 

NOTE: 

• When the printer is in the sleep mode, all buttons on the operator panel except for the  (Power Saver) button do not 
function. To use the buttons on the operator panel, press the  (Power Saver) button to exit the power saver mode.

See also: 
• "Setting the Time for the Power Saver Mode" on page 254
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3
Printer Management Software

Use the Software Pack CD-ROM that is shipped with your printer to install a combination of software programs, 
depending on your operating system.

• "Print and Scan Drivers" on page 37

• "CentreWare Internet Services" on page 38

• "Printer Setting Utility (Windows Only)" on page 39

• "SimpleMonitor (Windows Only)" on page 40

• "Launcher (Windows Only)" on page 41

• "Address Book Editor" on page 42

• "Express Scan Manager" on page 43

• "Setup Disk Creation Tool (Windows Only)" on page 44

• "DocuWorks (Windows Only)" on page 45
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Print and Scan Drivers

To access all of your printer's features, install the print and scan drivers from the Software Pack CD-ROM.

• The print driver enables your computer and printer to communicate and provides access to your printer 
features. 

• The scan driver enables you to scan images directly to your personal computer and place scanned images 
directly into an application via USB or the network.

The scan driver is installed with your print driver. It is available for Microsoft® Windows® and Mac OS X.

See also: 
• "Configuring Printer and Installing Software on Windows" on page 60

• "Configuring Printer and Installing Software on Mac OS X" on page 83



38 Printer Management Software

CentreWare Internet Services

The CentreWare Internet Services is a hypertext transfer protocol (HTTP)-based web page service that is accessed 
through your web browser.

Using the CentreWare Internet Services you can confirm the printer status, and change the printer configuration 
options easily. Anyone on your network can access the printer using the CentreWare Internet Services. In 
administrative mode you can change the configuration of the printer, set up your fax directories, and manage your 
printer settings without leaving your computer.

NOTE: 

• Users who are not given passwords by the administrator can still view the configuration settings in user mode. However, they 
cannot save or apply any changes to the current configuration and settings.

Creating an Administrative Password

1 Launch your web browser.

2 Enter the IP address of the printer in the address bar, and then press the Enter key.

3 Click the Properties tab.

4 In the left navigation panel, scroll down to Security and select Administrator Settings.

5 Select Enabled for Administrator Mode. 

6 In the Administrator Login ID field, enter a name for the administrator.

NOTE: 

• The default ID and password are "11111" and "x-admin" respectively.

7 In the Administrator Password and Re-enter Password fields, enter a password for the administrator.

8 In the Maximum Login Attempts field, enter the number of login attempts allowed.

Setting to 0 does not limit the number of login attempts.

9 Click Apply. 

Your new password has been set and anyone with the administrator name and password can log in and 
change the printer configuration and settings.
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Printer Setting Utility (Windows Only)

The Printer Setting Utility is installed with your print driver.

The Printer Setting Utility allows you to view or specify the system settings. You can also diagnose the system 
settings by using the Printer Setting Utility.

The Printer Setting Utility consists of the Printer Settings Report, Printer Maintenance, and Diagnosis tabs.

NOTE: 

• The Password dialog box appears the first time you try to change settings on the Printer Setting Utility when Panel Lock is 
set on the printer. In this case, enter the password you specified, and click OK to apply the settings.
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SimpleMonitor (Windows Only)

The SimpleMonitor is installed with your print driver.

You can check the printer status with the SimpleMonitor. Double-click the SimpleMonitor printer icon on the taskbar 
at the bottom right of the screen. The window to select a printer appears, which displays the printer name, printer 
connection ports, and printer status. Click one of the printer name listed on the window to select a printer. The 
Printer Status window appears. Check the column Status to know the current status of your printer.

The Printer Status window alerts you when there is a warning or when an error occurs, for example, when a paper 
jam occurs or toner is running low.

By default, the Printer Status window launches automatically when printing error occurs. You can specify the 
conditions for starting the Printer Status window in Printer Status Window Properties.

To change the pop-up settings for the Printer Status window:

The following procedure uses Windows 7 as an example.

1 Right-click the SimpleMonitor printer icon on the taskbar at the bottom right of the screen.

2 Select Printer Status Window Properties.

The Printer Status Window Properties window appears.

3 Select the type of the pop-up and then click OK.

You can also check the toner level of your printer and the job information on the Printer Status window.

NOTE: 

• To modify the SimpleMonitor settings, select Settings in the window to select a printer.



Printer Management Software 41

Launcher (Windows Only)

The Launcher is installed with your print driver.

Using the Launcher-Ctype window, you can open the Printer Status window, Printer Setting Utility, Troubleshooting 
Guide, Address Book Editor, and Express Scan Manager.

The following procedure uses Windows 7 as an example.

To open the Launcher-Ctype window:

1 Click Start  All Programs  Fuji Xerox  Fuji Xerox Printer Software for Asia-Pacific  your printer  
Launcher.

The Launcher-Ctype window appears.

2 The Launcher-Ctype window provides the following buttons; Status Window, Printer Setting Utility, 
Troubleshooting, Address Book Editor, and Express Scan Manager.

To exit, click X (Close) at the top-right corner of the window.

For details, see the help for each application.

Status Window Opens the Printer Status window. 

See also: 
• "SimpleMonitor (Windows Only)" on page 40

Printer Setting Utility Opens the Printer Setting Utility. 

See also: 
• "Printer Setting Utility (Windows Only)" on page 39

Troubleshooting Opens the Troubleshooting Guide, which allows you to resolve issues by yourself.

Address Book Editor Opens the Address Book Editor, which allows you to add and edit Address Book 
entries.

See also: 
• "Address Book Editor" on page 42

Express Scan Manager Opens the Express Scan Manager.

See also: 
• "Express Scan Manager" on page 43
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Address Book Editor

The Address Book Editor is installed with your print driver. It is available for Windows and Mac OS X.

The Address Book Editor provides a convenient interface for modifying the printer's Address Book entries. Using it 
you can add:

• Fax entries

• E-Mail entries

• Server entries

When you start the software, the Address Book Editor reads the printer's Address Book. You can add, edit, and 
delete entries. After making changes, you can save the updated Address Book to the printer or to your computer. 
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Express Scan Manager

The Express Scan Manager is installed with your print driver. It is available for Windows and Mac OS X.

The Express Scan Manager handles scan jobs sent from the printer to your computer via USB. When scan jobs are 
sent from the printer to the computer, the Express Scan Manager automatically manages the scan jobs.

Before scanning to your computer, start the Express Scan Manager and configure the output destination of the 
scanned image files.

Select the Open the image file check box to display scanned files saved in the specified destination after scanning.

NOTE: 

• When you separately install the Express Scan Manager from the Software Pack CD-ROM, you also need to install the scan 
driver from the Software Pack CD-ROM.

See also: 
• "Scanning From the Operator Panel - Scan to Application" on page 141
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Setup Disk Creation Tool (Windows Only)

The Setup Disk Creation Tool program located in the MakeDisk folder of the Utilities folder on the Software Pack 
CD-ROM and the print driver located on the Software Pack CD-ROM are used to create driver installation packages 
that contain custom driver settings. A driver installation package can contain a group of saved print driver settings 
and other data such as:

• Print orientation and multiple-up (document settings) 

• Output color (graphic setting)

If you want to install the print driver with the same settings on multiple computers running on the same operating 
system, create a setup disk in a media or in a server on the network. Using the setup disk that you have created will 
reduce the amount of work required when installing the print driver.

• Install the print driver for your printer on the computer on which the setup disk is to be created.

• The setup disk can only be used on the operating system on which the disk was created or computers running 
the same operating system. Create a separate setup disk for each of the operating systems.
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DocuWorks (Windows Only)

When installing the DocuWorks, run the appropriate EXE file in the DocuWorks document handling software.

Windows supports the DocuWorks and the DocuWorks Viewer Light.

The DocuWorks is available only for Windows.

NOTE: 

• For more information on the DocuWorks, refer to the readme file on the DocuWorks document handling software.
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4
Printer Connection and Software Installation

• "Overview of Printer Connection and Software Installation" on page 47

• "Connecting Your Printer" on page 49

• "Setting the IP Address (for IPv4 Mode)" on page 56

• "Configuring Printer and Installing Software on Windows" on page 60

• "Configuring Printer and Installing Software on Mac OS X" on page 83

• "Configuring Printer and Installing the Print Driver on Linux (CUPS)" on page 88
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Overview of Printer Connection and Software Installation

Read this section to know the overall steps to complete the printer connection and software installation.

Select one of the following connection methods.

• USB connection

• Ethernet connection

• Wireless connection

NOTE: 

• If the Software Pack CD-ROM is not available, you can download the latest driver from our web site: 
http://www.fujixeroxprinters.com/

• To use this printer in a Linux® environment, you need to install a Linux driver. For more information on how to install and use 
these, see also "Configuring Printer and Installing the Print Driver on Linux (CUPS)" on page 88.

USB Connection

• For Microsoft® Windows®

1 Connect the printer and the computer with the USB cable. 

Refer to "USB Connection" on page 51.

2 Install the driver software on the computer from the Software Pack CD-ROM.

Refer to "Using Installer to Set Up Connection and Install Software" on page 61.

• For Mac OS X

1 Connect the printer and the computer with the USB cable. 

Refer to "USB Connection" on page 51.

2 Install the driver software on the computer from the Software Pack CD-ROM.

Refer to "Configuring Printer and Installing Software on Mac OS X" on page 83.

Ethernet Connection

• For Windows

1 Connect the printer to a wired network. 

Refer to "Ethernet Connection" on page 51.

2 Set the printer's IP address.

• If DHCP is available on your network, refer to "Dynamic Methods of Setting the Printer's IP Address" on 
page 56.

• You can also manually set the printer's IP address by using the operator panel. Refer to "Assigning an IP 
Address Manually" on page 57.

3 Install the driver software on the computer from the Software Pack CD-ROM.

Refer to "Configuring Printer and Installing Software on Windows" on page 60.

http://www.fujixeroxprinters.com/
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• For Mac OS X

1 Connect the printer to a wired network. 

Refer to "Ethernet Connection" on page 51.

2 Set the printer's IP address.

• If DHCP is available on your network, refer to "Dynamic Methods of Setting the Printer's IP Address" on 
page 56.

• You can also manually set the printer's IP address by using the operator panel. Refer to "Assigning an IP 
Address Manually" on page 57.

3 Install the driver software on the computer from the Software Pack CD-ROM.

Refer to "Configuring Printer and Installing Software on Mac OS X" on page 83.

Wireless Connection

• For Windows

1 Connect the printer to a wireless network. 

Refer to "Wireless Connection" on page 52.

Perform the following steps as necessary.

If you set up wireless connection using the installer on the Software Pack CD-ROM, the following steps are not 
necessary.

2 Set the printer's IP address.

• If DHCP is available on your network, refer to "Dynamic Methods of Setting the Printer's IP Address" on 
page 56.

• You can also manually set the printer's IP address by using the operator panel. Refer to "Assigning an IP 
Address Manually" on page 57.

3 Install the driver software on the computer from the Software Pack CD-ROM.

Refer to "Configuring Printer and Installing Software on Windows" on page 60.

• For Mac OS X

1 Connect the printer to a wireless network. 

Refer to "Wireless Connection" on page 52.

2 Set the printer's IP address.

• If DHCP is available on your network, refer to "Dynamic Methods of Setting the Printer's IP Address" on 
page 56.

• You can also manually set the printer's IP address by using the operator panel. Refer to "Assigning an IP 
Address Manually" on page 57.

3 Install the driver software on the computer from the Software Pack CD-ROM.

Refer to "Configuring Printer and Installing Software on Mac OS X" on page 83.
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Connecting Your Printer

To connect your printer to a computer or device, the following specification must be met for each of the connection 
type:

Connection Type Connection Specifications

Ethernet 10 Base-T/100 Base-TX compatible

USB USB2.0 compatible

Wireless IEEE 802.11b/802.11g/802.11n

Wall Jack Connector RJ11

Phone Connector RJ11

1 Ethernet Port

2 USB Port

3 Wall Jack Connector

4 Phone Connector

3
4

1

2
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Available Features for Each Connection Type
Connect the printer via USB, Ethernet, or Wireless. A USB connection is a direct connection and is not used for 
networking. Ethernet and wireless connections are used for networking. Hardware and cabling requirements vary for 
the different connection methods. Ethernet cable and wireless LAN access point (Registrar) or router are not 
included with your printer and must be purchased separately.

The available features for each connection type are shown in the following table.

Connection Type Available Feature

USB • Instruct print jobs from a computer.

• Scan an image into an application.

• Scan an image to a folder on the computer.

• Use the Address Book Editor to manage Address Book entries.

• Use the Express Scan Manager to handle scan jobs sent from the printer to 
your computer.

• Use the Printer Setting Utility to view, specify or diagnose the system settings. 
(Windows only)

• Use the SimpleMonitor to check the printer status. (Windows only)

Ethernet • Instruct print jobs from a computer on the network.

• Scan an image to a computer on the network.

• Scan an image to an FTP server.

• Scan to e-mail.

• Use the CentreWare Internet Services to view the printer status or specify the 
printer settings.

• Use the Printer Setting Utility to view, specify or diagnose the system settings. 
(Windows only)

• Use the SimpleMonitor to check the printer status. (Windows only)

Wireless • Instruct print jobs from a computer on the network.

• Scan an image to a computer on the network.

• Scan an image to an FTP server.

• Scan to e-mail.

• Use the CentreWare Internet Services to view the printer status or specify the 
printer settings.

• Use the Printer Setting Utility to view, specify or diagnose the system settings. 
(Windows only)

• Use the SimpleMonitor to check the printer status. (Windows only)
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Connecting Printer to Your Computer

USB Connection
To connect the printer to a computer via USB:

1 Make sure that the printer is turned off and unplugged from the power source.

2 Connect the smaller USB connector into the USB port at the rear of the printer and the other end to a USB port 
of the computer.

NOTE: 

• Do not connect the printer USB cable to the USB slot available on the keyboard.

Ethernet Connection
To connect the printer to a computer via Ethernet:

1 Make sure that the printer is turned off and all cables have been disconnected.

2 Connect one end of the Ethernet cable into the Ethernet port at the rear of the printer, and the other end to an 
Ethernet port of a router or hub.

NOTE: 

• Connect the Ethernet cable, only if you need to setup a wired connection. Connecting the Ethernet cable stops some features 
or functions for Wireless network.

USB port

Ethernet port
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Wireless Connection
This section describes how to connect the printer to a computer via wireless network.

Confirm that the Ethernet cable has been disconnected from the printer and the status LED (Mobile) is blinking 
before configuring the wireless connection.

IMPORTANT: 

• The Wireless LAN feature is not available in all locations. Please check with your local Fuji Xerox representative for 
availability of wireless in your location.

• If you are using a method other than Wi-Fi Protected Setup™ (WPS) to configure your wireless network settings, be sure to 
get the SSID and security information from a system administrator before starting the setup procedure.

• Be sure to configure necessary settings on the wireless LAN access point (Registrar) or router before starting the printer 
setup. For information on the access point or router settings, refer to the manual supplied with the product.

The specifications of wireless setting function are described below:

*1 WPA stands for Wi-Fi Protected Access®.
*2 WPS 2.0 compliant. WPS 2.0 works on access points with the following encryption types: Mixed Mode PSK, WPA-PSK-AES, 

WPA2-PSK-AES, Open (No Security)

You can select a method to configure a wireless setting from the following:

*1 WPS-PBC (Wi-Fi Protected Setup-Push Button Configuration) is a method to authenticate and register devices required for 
wireless configuration, by starting WPS-PBC on the printer with the operator panel menu, and then pressing the button provided on 
the wireless LAN access point (Registrar) or router. This setting is available only when the access point supports WPS-PBC.

*2 WPS-PIN (Wi-Fi Protected Setup-Personal Identification Number) is a method to authenticate and register devices required for 
wireless configuration, by entering PIN assignments in the printer and computer. This setting, performed through access point, is 
available only when the access point of your wireless router supports WPS.

Item Specification

Connectivity Wireless

Connectivity Standard IEEE 802.11b/802.11g/802.11n compliant

Bandwidth 2.4 GHz

Data Transfer Rate IEEE 802.11b mode: 11, 5.5, 2, 1 Mbps 

IEEE 802.11g mode: 54, 48, 36, 24, 18, 12, 9, 6 Mbps 

IEEE 802.11n mode: 65 Mbps

Security 64 (40-bit key)/128 (104-bit key) WEP, WPA™-PSK (TKIP, AES)*1, WPA2™-PSK 
(AES)*1 (IEEE 802.1x attestation function of WPA 1x non-corresponds), Mixed 
Mode PSK

Certifications Wi-Fi®, Wi-Fi Direct®, WPA2.0 (Personal)

Wi-Fi Protected Setup (WPS)*2 Push Button Configuration (PBC), Personal Identification Number (PIN)

Using the installer on the Software Pack CD-ROM (Windows Only) (Recommended for initial setup)

Refer to "Launching the FX Printer Installation Screen" on page 61.

WPS-PBC (Operator Panel Menu)*1

Refer to "WPS-PBC" on page 53.

WPS-PIN*2

Refer to "WPS-PIN" on page 53.

Auto SSID Setup

Refer to "Auto SSID Setup" on page 54.

Manual SSID Setup

Refer to "Manual SSID Setup" on page 55.
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• WPS-PBC
You can start WPS-PBC from the operator panel.

NOTE: 

• WPS-PBC is available only when the wireless LAN access point (Registrar) or router supports WPS-PBC.

• Before starting WPS-PBC, confirm the position of the WPS button (button name may vary) on the wireless LAN access point 
(Registrar) or router. For information about the WPS operation on the wireless LAN access point (Registrar) or router, refer to 
the manual supplied with the product.

1 Press the  (System) button.

2 Select the Tools tab.

3 Select Admin Settings.

4 Select Network.

5 Select Wireless.

6 Select WPS Setup.

7 Select Push Button Configuration.

8 Select Start Configuration.

9 Confirm that Setting WPS is displayed, and press the button on the wireless LAN access point, within two 
minutes of the step 8 operation.

NOTE: 

• For details about WPS operation on the wireless LAN access point, refer to the manual supplied with the wireless LAN 
access point.

When WPS is successful, wireless connection is established and setup for wireless LAN is complete.

• WPS-PIN
The PIN code of WPS-PIN can only be configured from the operator panel.

NOTE: 

• WPS-PIN is available only when the wireless LAN access point (Registrar) or router supports WPS-PIN.

• For the WPS operation on the wireless LAN access point (Registrar) or router, refer to the manual supplied with the product.

1 Press the  (System) button.

2 Select the Tools tab.

3 Select Admin Settings.

4 Select Network.

5 Select Wireless.

6 Select WPS Setup.

7 Select PIN Code.

8 Write down the displayed 8-digit PIN code or select Print PIN Code. The PIN code is printed.

9 Select Start Configuration.
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10 Confirm that Setting WPS is displayed, and enter the PIN code displayed on step 8 into the web page of the 
wireless LAN access point.

NOTE: 

• For details about the WPS operation on the wireless LAN access point, refer to the manual supplied with the wireless 
LAN access point.

When WPS is successful, wireless connection is established and setup for wireless LAN is complete.

• Auto SSID Setup

1 Press the  (System) button.

2 Select the Tools tab.

3 Select Admin Settings.

4 Select Network.

5 Select Wireless.

6 Select Wireless Setup Wizard.

The printer automatically searches the access points on wireless network.

7 Select the desired access point.

If the desired access point does not appear, see "Manual SSID Setup" on page 55.

NOTE: 

• Some hidden SSID may not be displayed. If the SSID is not detected turn on SSID broadcast from the access point.

8 Select Next.

9 Enter the passphrase or WEP key.

When the encryption type of the selected access point is WPA2 or Mixed in step 7:

a Select the Enter Password text box, and then enter the passphrase.

b Select OK.

When the encryption type of the selected access point is WEP in step 7:

a Select the Enter Key text box, and then enter the WEP key.

b Select OK.

NOTE: 

• A passphrase is an encryption key for WPA and WPA2 encryption which consists of 8 to 63 alphanumeric (and 64 
hexadecimal) characters. It may be described as a key on some access points or routers. For details, refer to the manual 
supplied with the access point or router.

When the Auto SSID Setup is successful, wireless connection is established and setup for wireless LAN is 
complete.
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• Manual SSID Setup

1 Press the  (System) button.

2 Select the Tools tab.

3 Select Admin Settings.

4 Select Network.

5 Select Wireless.

6 Select Wireless Setup Wizard.

7 Select the Manual SSID Setup check box, and then select Next.

8 Enter the SSID, and then select Next.

9 Select the network mode from Infrastructure or Ad-hoc depending on your environment, and then select 
Next.

10 Select the encryption type from Mixed mode PSK, WPA2-PSK-AES, or WEP.

IMPORTANT: 

• Be sure to use one of the supported encryption types to protect your network traffic.

NOTE: 

• If you have selected Ad-hoc for the network mode, WEP is the encryption type.

To use Mixed mode PSK or WPA2-PSK-AES encryption:

a Select the desired encryption type.

b Select the Enter Password text box, and then enter the passphrase.

c Select OK.

NOTE: 

• A passphrase is an encryption key for WPA and WPA2 encryption which consists of 8 to 63 alphanumeric (and 64 
hexadecimal) characters. It may be described as a key on some access points or routers. For details, refer to the manual 
supplied with the access point or router.

To use WEP encryption:

a Select WEP.

b Select the Enter WEP Key text box, and then enter the WEP key.

c Select Transmit Key, and then select the desired transmit key from WEP Key 1 to WEP Key 4.

d Select OK.

When the Manual SSID Setup is successful, wireless connection is established and setup for wireless LAN is 
complete.
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Setting the IP Address (for IPv4 Mode)

NOTE: 

• To set an IP address for IPv6 in Dual Stack mode, use the CentreWare Internet Services. For more information, refer to the 
online Help on the CentreWare Internet Services. To display the CentreWare Internet Services in an IPv6 network, use a link 
local address. The printer’s link local address is listed in the System Settings page. For details, see "Printing a System 
Settings Page" on page 122.

Printer's TCP/IP and IP Addresses
If your computer is on a large network, contact your network administrator for the appropriate TCP/IP addresses and 
additional system settings information. 

If you are creating your own small local area network or connecting the printer directly to your computer using 
network, follow the procedure for automatically setting the printer's IP address. 

Computers and printers primarily use TCP/IP protocols to communicate over network. With TCP/IP protocols, each 
printer and computer must have a unique IP address. It is important that the addresses are similar, but not the same; 
only the last digit needs to be different. For example, your printer can have the address 192.0.2.1 while your 
computer has the address 192.0.2.2. Another device can have the address 192.0.2.3.

Many networks have a Dynamic Host Configuration Protocol (DHCP) server. A DHCP server automatically 
programs an IP address into every computer and printer on the network that is configured to use DHCP. A DHCP 
server is built into most cable and Digital Subscriber Line (DSL) routers. If you use a cable or DSL router, see your 
router's documentation for information on IP addressing.

Dynamic Methods of Setting the Printer's IP Address
The DHCP and AutoIP protocols are available for dynamically setting the printer's IP address. They are enabled by 
default in your printer.

You can turn on/off both protocols using the operator panel or the CentreWare Internet Services.

NOTE: 
• You can print a report that includes the printer's IP address. For more information, refer to "Printing a System Settings Page" 

on page 122.

Using the Operator Panel

1 Press the  (System) button.

2 Select the Tools tab.

3 Select Admin Settings.

4 Select Network.

5 Select Ethernet or Wireless.

6 Select TCP/IP.

7 Select Get IP Address.

8 Select DHCP/AutoIP, and then select OK.
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Using the CentreWare Internet Services

1 Launch your web browser.

2 Enter the IP address of the printer in the address bar, and then press the Enter key.

3 Select Properties.

4 Select TCP/IP from the Protocol Settings folder on the left navigation panel.

5 In the IP Address Mode field under IPv4, select the DHCP/AutoIP option.

6 Click Apply.

7 Click Reboot Machine to restart the printer.

Assigning an IP Address Manually

NOTE: 

• Assigning an IP address is considered as an advanced function and is normally performed by a system administrator.

• Depending on the address class, the range of the IP address assigned may be different. On Class A, for example, an IP 
address in the range from 0.0.0.0 to 127.255.255.255 will be assigned. For assignment of IP addresses, contact your 
system administrator. 

You can assign the IP address by using the operator panel, the Printer Setting Utility, or the CentreWare Internet 
Services.

For Windows, you can also assign the IP address to the printer using the installer on the Software Pack CD-ROM.

Using the Operator Panel

1 Press the  (System) button.

2 Select the Tools tab.

3 Select Admin Settings.

4 Select Network.

5 Select Ethernet or Wireless.

6 Select TCP/IP.

7 Select Get IP Address.

8 Select Panel, and then select OK.

9 Confirm that Settings Become Effective After Restart. appears, and then select Close.

10 Select IP Address.

The cursor is located at the first digit of the IP address.

11 Enter the value of the IP address using the number pad.

12 Select .

The cursor moves to the next digit.

13 Repeat steps 11 to 12 to set all digits in the IP address, and then select OK.

14 Confirm that Settings Become Effective After Restart. appears, and then select Close.

15 Select Subnet Mask.

The cursor is located at the first digit of the subnet mask.
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16 Enter the value of the subnet mask using the number pad.

17 Select .

The cursor moves to the next digit.

18 Repeat steps 16 to 17 to set the subnet mask, and then select OK.

19 Confirm that Settings Become Effective After Restart. appears, and then select Close.

20 Select Gateway Address.

The cursor is located at the first digit of the gateway address.

21 Enter the value of the gateway address using the number pad.

22 Select .

The cursor moves to the next digit.

23 Repeat steps 21 to 22 to set the gateway address, and then select OK.

24 Make sure that the message Settings Become Effective After Restart. appears, and then select 
Close.

25 Turn off and turn on the printer.

See also: 
• "Operator Panel" on page 27

Using the Printer Setting Utility (Windows Only)
The following procedure uses Windows 7 as an example.

1 Click Start  All Programs  Fuji Xerox  Fuji Xerox Printer Software for Asia-Pacific  your printer  
Printer Setting Utility.

NOTE: 

• The window to select a printer appears in this step when multiple print drivers are installed on your computer. In this 
case, click the name of the desired printer listed in Printer Name.

The Printer Setting Utility appears.

2 Click the Printer Maintenance tab.

3 Select TCP/IP Settings from the list at the left side of the page.

The TCP/IP Settings page is displayed.

4 Select Panel from IP Address Mode, and then enter the values in IP Address, Subnet Mask, and Gateway 
Address.

5 Click Restart printer to apply new settings to take effect.
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Using the Installer on the Software Pack CD-ROM (Windows Only)
You can assign the IP address to the printer when setting up the printer with the installer on the Software Pack CD-
ROM.

When you use the Ethernet or the manual Wireless setup method, and Get IP Address is set to DHCP/AutoIP 
on the operator panel menu, the installer detects the printer by the automatically assigned IP address. You can 
modify the assigned IP address to the desired IP address by clicking Advanced on the Configure Printer screen 
while in the setup process.

See also: 
• "Printing a System Settings Page" on page 122

The IP address is assigned to your printer. To verify the setting, display the web browser on any computer connected 
to the network and enter the IP address into the address bar on the browser. If the IP address is set up correctly, the 
CentreWare Internet Services is displayed in your browser.

Verifying the IP Settings
You can confirm the settings by printing the System Settings page or using the ping command.

Printing the System Settings Page

1 Print the System Settings page.

See also: 

• "Printing a System Settings Page" on page 122

2 Look under the IPv4 heading of TCP/IP on the Wired Network or Wireless Network section of the System 
Settings page to confirm that the IP address, subnet mask and gateway address are appropriate.

If the IP address is 0.0.0.0 (the factory default) or 169.254.xx.xx, an IP address has not been assigned.

If the IP address is not resolved automatically, see "Assigning an IP Address Manually" on page 57.

Using the Ping Command
To verify if the printer is active on the network, run the ping command in your computer.

The following procedure uses Windows 7 as an example.

1 Click Start  All Programs  Accessories  Run.

2 Enter "cmd", and then click OK.

A Command Prompt window is displayed.

3 Enter "ping xxx.xxx.xxx.xxx" (xxx.xxx.xxx.xxx is the IP address of your printer), and then press the Enter key.

Receiving the reply from the printer IP address means that the printer is appropriately connected to the 
network.
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Configuring Printer and Installing Software on Windows

 Identifying Print Driver Pre-install Status (for Network Connection 
Setup)

Before installing the print driver on your computer, check the IP address of your printer and change the firewall 
settings.

Checking the IP Address for Your Printer

1 Print the System Settings page.

See also: 

• "Printing a System Settings Page" on page 122

2 Confirm the IP address next to IP Address under Wired Network or Wireless Network on the System 
Settings page.

If the IP address is 0.0.0.0, wait for a few minutes to resolve the IP address automatically, and then print the 
System Settings page again.

If the IP address is not resolved automatically, see "Assigning an IP Address Manually" on page 57.

Changing the Firewall Settings Before Installing Your Printer
You may need to change the firewall settings before installing the printer software. Contact your network 
administrator for more information.

The following procedure uses Windows 7 as an example.

1 Insert the Software Pack CD-ROM into your computer.

2 Click Start  Control Panel.

3 Click System and Security.

4 Click Allow a program through Windows Firewall.

5 Click Change settings.

6 Click Allow another program.

7 Click Browse.

8 Enter "D:\setup.exe" (in case your optical disk drive is D) in the File name text box, and then click Open.

9 Click Add.

10 Click OK.
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Using Installer to Set Up Connection and Install Software

NOTE: 

• The following procedure sets up printer connection and then install the drivers and software. If you have already established 
printer connection, see "Using Installer to Install Software" on page 64 to install the print driver and software immediately.

Launching the FX Printer Installation Screen

1 Insert the Software Pack CD-ROM into your computer to start the FX Printer Installation screen.

NOTE: 

• For Windows 8, Windows 8.1, Windows Server® 2012, and Windows Server 2012 R2, click the message displayed on 
the upper right corner of the screen, and then select Run setup.exe.

• If the CD does not automatically launch, perform the following steps.

a For Windows Server 2003, Windows Server 2008, and Windows Server 2008 R2, click Start  Run.

For Windows Vista® and Windows 7, click Start  All Programs  Accessories  Run.

For Windows 8 and Windows Server 2012, right-click on the Start screen and click All apps  Run.

For Windows 8.1 and Windows Server 2012 R2, click  on the Start screen  Run.

b Enter "D:\setup.exe" (in case your optical disk drive is D), and then click OK.

2 Click Setup Printer and Install Software.

3 If you agree to the terms of the License Agreement, choose I accept the terms of the license agreement, 
and then click Next.
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4 Select a connection method to the printer.

For the wireless connection, see "Configuring Wireless Connection Settings" on page 62.

For the USB connection, see "Configuring USB Connection Settings" on page 63.

For the Ethernet connection, see "Configuring Ethernet Connection Settings" on page 63.

Configuring Wireless Connection Settings
The installer software connects the printer and installs the required drivers and software.

The connection procedure varies depending on how your network and computer are set up.

1 Confirm that the printer is turned on and the status LED (Mobile) is blinking.

2 Click Wireless on the Select a connection Method screen.

3 Follow the instructions displayed on the screen.

• If the software detects your network and printer, the SSID and Printer Name will be displayed. Confirm the 
SSID and Printer Name and then click Next.

• If the WPS setup screen is displayed, follow the steps displayed on the screen.

• In case the WPS button is not available on your router or you want to set up manually, click Manual settings 
and follow the instructions displayed on the screen.

4 Click Finish to exit the wizard when the Ready to Print! screen appears. If necessary, click Print Test Page to 
verify installation.



Printer Connection and Software Installation 63

Configuring USB Connection Settings

1 Confirm that the USB cable is connected to the computer and the printer, and the printer is turned on.

NOTE: 

• For Windows Vista, Windows Server 2003, or Windows Server 2008, if Found New Hardware Wizard appears, click 
Cancel.

2 Click USB on the Select a connection Method screen.

The Plug and Play installation starts and the required driver and software are automatically installed.

3 Click Finish to exit the wizard when the Ready to Print! screen appears. If necessary, click Print Test Page to 
verify installation.

Configuring Ethernet Connection Settings

1 Click Ethernet on the Select a connection Method screen.

2 Connect the Ethernet cable to the printer and turn on the printer, and then click Next.

3 Select a printer you want to install from the Printer list, and then click Next.

If the target printer is not displayed on the Printer list, click  to refresh the list or click Enter IP Address to 
add a printer manually.
In Enter IP Address, enter the assigned IP address to the printer manually, and then click OK.

NOTE: 

• If the target printer is not displayed on the list, ensure Ethernet cable is correctly inserted to the printer and the router, 
and also confirm the printer IP address is properly appointed.

4 Confirm IP Mode and Type, and then click Next.

If you want to change the printer's IP address settings, click Advanced and configure the items on the 
Configure Printer screen. Especially if you want to set up the printer with fixed IP, select Use Manual 
Address from Type.

5 Check and configure the printer information such as a printer name, default printer/scanner settings, printer 
sharing setting, specify whether to install the fax driver, and then click Next.

6 Select the check box of the software and documentation you want to install, and then click Install.

7 Click Finish to exit the wizard when the Ready to Print! screen appears. If necessary, click Print Test Page to 
verify installation.
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Using Installer to Install Software
If the printer connection via USB/Ethernet/Wireless is already configured and you want to perform the driver and 
software installation only, follow the procedure below.

If you have executed the steps in "Using Installer to Set Up Connection and Install Software" on page 61, the 
following procedure is not necessary. 

1 Click Install Software.

2 If you agree to the terms of the License Agreement, choose I accept the terms of the license agreement, 
and then click Next.

3 Choose an installation type, and then click Next.

For the printer connected to your computer using the USB cable, select Personal Installation.

For the printer connected to a wired or wireless network, select Network Installation.

4 Follow the instructions displayed on the screen to complete the installation.
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 Installing the XML Paper Specification (XPS) Print Driver
This section describes how to install the XML Paper Specification (XPS) print driver using the Windows Add Printer 
wizard.

NOTE: 

• The XML Paper Specification (XPS) driver is supported on Windows Vista and later operating systems.

• To print with the XML Paper Specification (XPS) driver, the following components are required on your computer.

For Windows Vista, Windows Vista 64-bit Edition, Windows Server 2008, Windows Server 2008 64-bit Edition, Windows 
Server 2008 R2, Windows 7, and Windows 7 64-bit Edition:

- .Net Framework 4 or 4.5

- Visual C++® Redistributable Packages for Visual Studio® 2012

For Windows 8, Windows 8 64-bit Edition, Windows Server 2012, Windows 8.1, Windows 8.1 64-bit Edition, and Windows 
Server 2012 R2:

- Visual C++ Redistributable Packages for Visual Studio 2012

Getting the Driver File

1 Insert the Software Pack CD-ROM into your computer.

2 Extract the zip file in the following path to your desired location.

D:\Drivers\XPS\Win_7Vista

D:\Drivers\XPS\Win_8

(in case your optical disk drive is D)

NOTE: 

• XPS stands for XML Paper Specification.

Installing the Print Driver

• USB Connection Setup

Windows Vista or Windows Vista 64-bit Edition

1 Click Start  Control Panel  Hardware and Sound  Printers.

2 Click Add a printer.

3 Click Add a local printer.

4 Select the port connected to your printer, and then click Next.

5 Click Have Disk to display the Install From Disk dialog box.

6 Click Browse, and then select the extracted setup information (.inf) file in "Getting the Driver File" on page 65.

7 Click Open.

8 Click OK.

9 Select your printer name, and then click Next.

10 To change the printer name, enter the printer name in the Printer name box.

To use this printer as the default printer, select the Set as the default printer check box displayed under the 
Printer name.
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11 Click Next.

Installation starts.

If the User Account Control dialog box appears, click Continue.

NOTE: 

• If you are an administrator on the computer, click Continue; otherwise, contact your administrator to continue the desired 
action.

12 Upon completion of the driver installation, click Print a test page to verify installation.

13 Click Finish.

Windows Server 2008 or Windows Server 2008 64-bit Edition

NOTE: 

• You must log in as an administrator.

1 Click Start  Control Panel  Hardware and Sound  Printers.

2 Click Add a printer.

3 Click Add a local printer.

4 Select the port connected to your printer, and then click Next.

5 Click Have Disk to display the Install From Disk dialog box.

6 Click Browse, and then select the extracted setup information (.inf) file in "Getting the Driver File" on page 65.

7 Click Open.

8 Click OK.

9 Select your printer name, and then click Next.

10 To change the printer name, enter the printer name in the Printer name box.

To use this printer as the default printer, select the Set as the default printer check box.

11 Click Next.

Installation starts.

12 If you do not share your printer, select Do not share this printer.

If you share your printer, select Share this printer so that others on your network can find and use it.

13 Click Next.

14 Upon completion of the driver installation, click Print a test page to verify installation.

15 Click Finish.

Windows 7, Windows 7 64-bit Edition, or Windows Server 2008 R2

1 Click Start  Devices and Printers.

2 Click Add a printer.

If the User Account Control dialog box appears, click Yes.

NOTE: 

• If you are an administrator on the computer, click Yes; otherwise, contact your administrator to continue the desired 
action.
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3 Click Add a local printer.

4 Select the port connected to your printer, and then click Next.

5 Click Have Disk to display the Install From Disk dialog box.

6 Click Browse, and then select the extracted setup information (.inf) file in "Getting the Driver File" on page 65.

7 Click Open.

8 Click OK.

9 Select your printer name, and then click Next.

10 To change the printer name, enter the printer name in the Printer name box, and then click Next.

Installation starts.

11 If you do not share your printer, select Do not share this printer.

If you share your printer, select Share this printer so that others on your network can find and use it.

12 Click Next.

13 To use this printer as the default printer, select the Set as the default printer check box.

14 Upon completion of the driver installation, click Print a test page to verify installation.

15 Click Finish.

Windows 8, Windows 8 64-bit Edition, Windows 8.1, Windows 8.1 64-bit Edition, Windows Server 
2012, or Windows Server 2012 R2

1 On the Desktop screen, place the mouse pointer in the upper right corner of the screen and move the mouse 
down, and then select Settings.

2 Click Control Panel  Hardware and Sound (Hardware for Windows Server 2012 and Windows Server 2012 
R2)  Devices and Printers.

3 Click Add a printer.

4 Click The printer that I want isn't listed.

5 Select Add a local printer or network printer with manual settings, and then click Next.

6 Select the port connected to your printer, and then click Next.

7 Click Have Disk to display the Install From Disk dialog box.

8 Click Browse, and then select the extracted setup information (.inf) file in "Getting the Driver File" on page 65.

9 Click Open.

10 Click OK.

11 Select your printer name, and then click Next.

12 To change the printer name, enter the printer name in the Printer name box, and then click Next.

Installation starts.

If the User Account Control dialog box appears, click Yes.

NOTE: 

• If you are an administrator on the computer, click Yes; otherwise, contact your administrator to continue the desired 
action.

13 If you do not share your printer, select Do not share this printer.

If you share your printer, select Share this printer so that others on your network can find and use it.
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14 Click Next.

15 To use this printer as the default printer, select the Set as the default printer check box.

16 Upon completion of the driver installation, click Print a test page to verify installation.

17 Click Finish.

• Network Connection Setup

Windows Vista and Windows Vista 64-bit Edition

1 Click Start  Control Panel  Hardware and Sound  Printers.

2 Click Add a printer.

3 Click Add a network, wireless or Bluetooth printer.

4 Select a printer or click The printer that I want isn't listed.

If you have selected your printer, go to step 7.

If you have clicked The printer that I want isn't listed, go to step 5.

5 Select Add a printer using a TCP/IP address or host name, and then click Next.

6 Select TCP/IP Device from Device type, and enter the IP address in the Hostname or IP address box, and 
then click Next.

If the User Account Control dialog box appears, click Continue.

NOTE: 

• If you are an administrator on the computer, click Continue; otherwise, contact your administrator to continue the desired 
action.

7 Click Have Disk to display the Install From Disk dialog box.

8 Click Browse, and then select the extracted setup information (.inf) file in "Getting the Driver File" on page 65.

9 Click Open.

10 Click OK.

11 Select your printer name, and then click Next.

12 To change the printer name, enter the printer name in the Printer name box.

To use this printer as the default printer, select the Set as the default printer check box.

13 Click Next.

Installation starts.

14 Upon completion of the driver installation, click Print a test page to verify installation.

15 Click Finish.

Windows Server 2008 and Windows Server 2008 64-bit Edition

NOTE: 

• You must log in as an administrator.

1 Click Start  Control Panel  Hardware and Sound  Printers.

2 Click Add a printer.

3 Click Add a network, wireless or Bluetooth printer.
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4 Select a printer or click The printer that I want isn't listed.

If you have selected your printer, go to step 7.

If you have clicked The printer that I want isn't listed, go to step 5.

5 Select Add a printer using a TCP/IP address or host name, and then click Next.

6 Select TCP/IP Device from Device type, and enter the IP address in the Hostname or IP address box, and 
then click Next.

If the User Account Control dialog box appears, click Continue.

NOTE: 

• If you are an administrator on the computer, click Continue; otherwise, contact your administrator to continue the desired 
action.

7 Click Have Disk to display the Install From Disk dialog box.

8 Click Browse, and then select the extracted setup information (.inf) file in "Getting the Driver File" on page 65.

9 Click Open.

10 Click OK.

11 Select your printer name, and then click Next.

12 To change the printer name, enter the printer name in the Printer name box.

To use this printer as the default printer, select the Set as the default printer check box.

13 Click Next.

Installation starts.

14 If you do not want your printer shared, select Do not share this printer. Otherwise, select Share this printer 
so that others on your network can find and use it.

15 Click Next.

16 Upon completion of the driver installation, click Print a test page to verify installation.

17 Click Finish.

Windows Server 2008 R2

1 Click Start  Devices and Printers.

2 Click Add a printer.

3 Click Add a network, wireless or Bluetooth printer.

4 Select a printer or click The printer that I want isn't listed.

NOTE: 

• If you click The printer that I want isn't listed, the Find a printer by name or TCP/IP address screen appears. Find 
your printer on the screen.

If the User Account Control dialog box appears, click Continue.

NOTE: 

• If you are an administrator on the computer, click Continue; otherwise, contact your administrator to continue the desired 
action.

5 Click Have Disk to display the Install From Disk dialog box.

6 Click Browse, and then select the extracted setup information (.inf) file in "Getting the Driver File" on page 65.

7 Click Open.
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8 Click OK.

9 Select your printer name, and then click Next.

10 To change the printer name, enter the printer name in the Printer name box, and then click Next.

Installation starts.

11 If you do not want your printer shared, select Do not share this printer. Otherwise, select Share this printer 
so that others on your network can find and use it.

12 Click Next.

13 To use this printer as the default printer, select the Set as the default printer check box.

14 Upon completion of the driver installation, click Print a test page to verify installation.

15 Click Finish.

Windows 7 and Windows 7 64-bit Edition

1 Click Start  Devices and Printers.

2 Click Add a printer.

3 Click Add a network, wireless or Bluetooth printer.

4 Select a printer or click The printer that I want isn't listed.

If you have selected your printer, go to step 7.

If you have clicked The printer that I want isn't listed, go to step 5.

5 Select Add a printer using a TCP/IP address or host name, and then click Next.

6 Select TCP/IP Device from Device type, and enter the IP address in the Hostname or IP address box, and 
then click Next.

If the User Account Control dialog box appears, click Yes.

NOTE: 

• If you are an administrator on the computer, click Yes; otherwise, contact your administrator to continue the desired 
action.

7 Click Have Disk to display the Install From Disk dialog box.

8 Click Browse, and then select the extracted setup information (.inf) file in "Getting the Driver File" on page 65.

9 Click Open.

10 Click OK.

11 Select your printer name, and then click Next.

12 To change the printer name, enter the printer name in the Printer name box, and then click Next.

Installation starts.

13 If you do not want your printer shared, select Do not share this printer. Otherwise, select Share this printer 
so that others on your network can find and use it.

14 Click Next.

15 To use this printer as the default printer, select the Set as the default printer check box.

16 Upon completion of the driver installation, click Print a test page to verify installation.

17 Click Finish.
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Windows 8, Windows 8 64-bit Edition, Windows 8.1, Windows 8.1 64-bit Edition, Windows Server 
2012, or Windows Server 2012 R2

1 On the Desktop screen, place the mouse pointer in the upper right corner of the screen and move the mouse 
down, and then select Settings.

2 Click Control Panel  Hardware and Sound (Hardware for Windows Server 2012 and Windows Server 2012 
R2)  Devices and Printers.

3 Click Add a printer.

4 Select a printer or click The printer that I want isn't listed.

If you have selected your printer, go to step 7.

If you have clicked The printer that I want isn't listed, go to step 5.

5 Select Add a printer using a TCP/IP address or host name, and then click Next.

6 Select TCP/IP Device from Device type, and enter the IP address in the Hostname or IP address box, and 
then click Next.

7 Click Have Disk to display the Install From Disk dialog box.

8 Click Browse, and then select the extracted setup information (.inf) file in "Getting the Driver File" on page 65.

9 Click Open.

10 Click OK.

11 Select your printer name, and then click Next.

12 To change the printer name, enter the printer name in the Printer name box, and then click Next.

Installation starts.

If the User Account Control dialog box appears, click Yes.

NOTE: 

• If you are an administrator on the computer, click Yes; otherwise, contact your administrator to continue the desired 
action.

13 If you do not want your printer shared, select Do not share this printer. Otherwise, select Share this printer 
so that others on your network can find and use it.

14 Click Next.

15 To use this printer as the default printer, select the Set as the default printer check box.

16 Upon completion of the driver installation, click Print a test page to verify installation.

17 Click Finish.
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Setting Up for Web Services on Devices (WSD)
This section provides information for network printing with Web Services on Devices (WSD), the Microsoft protocol 
for Windows Vista and later operating systems.

For Windows Vista, Windows 7, Windows 8, and Windows 8.1, your printer is added with Web Services on Devices 
(WSD) by using the installer on the Software Pack CD-ROM. For details, see "Using Installer to Set Up Connection 
and Install Software" on page 61.

For Windows Server 2008, Windows Server 2008 R2, Windows Server 2012, and Windows Server 2012 R2, you 
need to add the roles of print services first, and then install the print driver using the Windows Add Printer wizard.

Follow the instructions below.

Adding Roles of Print Services

• For Windows Server 2008:

1 Click Start  Administrative Tools  Server Manager.

2 From the Action menu, select Add Roles.

3 Select the Print Services check box on the Server Roles window in the Add Roles Wizard, and then click 
Next.

4 Click Next.

5 Select the Print Server check box, and then click Next.

6 Click Install.

• For Windows Server 2008 R2:

1 Click Start  Administrative Tools  Server Manager.

2 From the Action menu, select Add Roles.

3 Select the Print and Document Services check box on the Server Roles window in the Add Roles Wizard, 
and then click Next.

4 Click Next.

5 Select the Print Server check box, and then click Next.

6 Click Install.
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• For Windows Server 2012 and Windows Server 2012 R2:

1 On the Start screen, click Server Manager.

2 Click Add roles and features to start Add Roles and Features Wizard.

3 Specify the settings and click Next until the Select server roles screen is displayed.

4 Select the Print and Document Services check box.

5 On the pop-up window, click Add Features.

6 Click Next.

7 Click Next on the Select features screen.

8 Read the explanation for Print and Document Services and click Next.

9 Select the Print Server check box, and then click Next.

10 Click Install.

WSD (Web Services on Devices) Printer Setup
You can install your new printer on the network using Windows Add Printer wizard. When installing using the 
Software Pack CD-ROM that shipped with your printer, see "Using Installer to Set Up Connection and Install 
Software" on page 61.

• Installing a Print Driver Using the Add Printer Wizard

1 For Windows 7 and Windows Server 2008 R2, click Start  Devices and Printers.

For Windows Vista, click Start  Control Panel  Hardware and Sound  Printers.

For Windows Server 2008, click Start  Control Panel  Printer.

For Windows 8 and Windows 8.1, on the Desktop screen, place the mouse pointer in the upper right corner of 
the screen and move the mouse down, and then select Settings. Click Control Panel  Hardware and 
Sound  Devices and Printers.

For Windows Server 2012 and Windows Server 2012 R2, on the Desktop screen, place the mouse pointer in 
the upper right corner of the screen and move the mouse down, and then select Settings. Click Control Panel 
 Hardware  Devices and Printers.

2 Click Add a printer to launch the Add Printer Wizard.

For Windows 8, Windows 8.1, Windows Server 2012, and Windows Server 2012 R2, go to step 4.

3 Select Add a network, wireless or Bluetooth printer.

4 In the list of available printers, select the one you want to use, and then click Next.

NOTE: 

• In the list of available printers, the WSD (Web Services on Devices) printer is displayed in the form of http://IP 
address/[UUID].

• If no WSD (Web Services on Devices) printer is displayed in the list, enter the printer's IP address manually to create a 
WSD (Web Services on Devices) printer. To enter the printer's IP address manually, follow the instructions below.
To create a WSD (Web Services on Devices) printer, you must be a member of Administrators group.

1 Click The printer that I want isn't listed.

2 Select Add a printer using a TCP/IP address or hostname and click Next.

3 Select Web Services Device from Device type.

4 Enter the printer's IP address in the Hostname or IP address text box and click Next.

• Before installing the driver using the Add Printer wizard on Windows Server 2008 R2 or Windows 7, add the print driver 
to your computer.
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5 If prompted, install the print driver on your computer. If you are prompted for an administrator password or 
confirmation, type the password or provide confirmation.

6 Complete the additional steps in the wizard, and then click Finish.

7 Print a test page to verify printer installation.

a Open the Devices and Printers or Printers folder by performing step 1.

b Right-click the printer you just created, and then click Printer properties (Properties for Windows Vista 
and Windows Server 2008).

c On the General tab, click Print Test Page. When a test page is printed successfully, the installation is 
complete.

Setting Up for Shared Printing
You can share your new printer on the network using the Software Pack CD-ROM that shipped with your printer, or 
using Windows Point and Print or peer-to-peer method. 

This section describes Point and Print and peer-to-peer methods. Configure the printer sharing settings on the 
server computer, and then install its driver on all the client computers that use the shared printer by Point and Print 
or peer-to-peer method. Using either of the methods, however, you will not be able to use features such as the 
SimpleMonitor and other printer utilities, which will be installed from the Software Pack CD-ROM.

NOTE: 

• You need to purchase an Ethernet cable separately for shared printing.

Configuring the Sharing Settings of Your Printer

• For Windows Server 2003 and Windows Server 2003 x64 Edition

1 Click Start  Printers and Faxes.

2 Right-click this printer icon and select Properties.

3 From the Sharing tab, select the Share this printer check box, and then enter a name in the Share name text 
box.

4 Click Additional Drivers and select the operating systems of all network clients using this printer.

5 Click OK.

If the files are not present in your computer, insert the server operating system CD.

6 Click Apply, and then click OK.

• For Windows Vista and Windows Vista 64-bit Edition

1 Click Start  Control Panel  Hardware and Sound  Printers.

2 Right-click the printer icon and select Sharing.

3 Click Change sharing options.

The "Windows needs your permission to continue" appears.

4 Click Continue.

5 Select the Share this printer check box, and then enter a name in the Share name text box.

6 Select Additional Drivers and select the operating systems of all network clients using this printer.

7 Click OK.

8 Click Apply, and then click OK.
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• For Windows Server 2008 and Windows Server 2008 64-bit Edition

1 Click Start  Control Panel  Hardware and Sound  Printers.

2 Right-click the printer icon and select Sharing.

3 Select the Share this printer check box, and then enter a name in the Share name text box.

4 Click Additional Drivers and select the operating systems of all network clients using this printer.

5 Click OK.

6 Click Apply, and then click OK.

• For Windows 7, Windows 7 64-bit Edition, and Windows Server 2008 R2

1 Click Start  Devices and Printers.

2 Right-click the printer icon and select Printer properties.

3 On the Sharing tab, select the Share this printer check box, and then enter a name in the Share name text 
box.

4 Click Additional Drivers and select the operating systems of all network clients using this printer.

5 Click OK.

6 Click Apply, and then click OK.

• For Windows 8, Windows 8 64-bit Edition, Windows 8.1, Windows 8.1 64-bit 
Edition, Windows Server 2012, and Windows Server 2012 R2

1 On the Desktop screen, place the mouse pointer in the upper right corner of the screen and move the mouse 
down, and then select Settings.

2 Click Control Panel  Hardware and Sound (Hardware for Windows Server 2012 and Windows Server 2012 
R2)  Devices and Printers.

3 Right-click the printer icon and select Printer properties.

4 On the Sharing tab, select the Share this printer check box, and then enter a name in the Share name text 
box.

5 Click Additional Drivers and select the operating systems of all network clients using this printer.

6 Click OK.

7 Click Apply, and then click OK.

To check that the printer is shared:

• Make sure that the printer object in the Printers, Printers and Faxes, or Devices and Printers folder is 
shared. The share icon is displayed under the printer icon.

• Browse Network or My Network Places. Find the host name of the server and look for the shared name you 
assigned to the printer.

Now that the printer is shared, you can install the printer on network clients using the Point and Print method or the 
peer-to-peer method.
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Point and Print
Point and Print is a Microsoft Windows technology that allows you to connect to a remote printer. This feature 
automatically downloads and installs the print driver.

• For Windows Server 2003 and Windows Server 2003 x64 Edition

1 On the Windows desktop of the client computer, double-click My Network Places.

2 Locate the host name of the server computer, and then double-click the host name.

3 Right-click the shared printer name, and then click Connect.

4 Wait until the driver is copied from the server to the client computer. 

A new printer object is added to the Printers and Faxes folder. The duration of this procedure may vary based 
on the network traffic.

5 Close My Network Places.

6 Print a test page to verify installation.

a Click Start  Printers and Faxes.

b Select the printer you have installed.

c Click File  Properties.

d On the General tab, click Print Test Page.

When a test page is printed successfully, the installation is complete.

• For Windows Vista and Windows Vista 64-bit Edition

1 Click Start  Network.

2 Locate and double-click the host name of the server computer.

3 Right-click the shared printer name, and then click Connect.

4 Click Install driver.

5 Click Continue in the User Account Control dialog box.

6 Wait until the driver is copied from the server to the client computer. 

A new printer object is added to the Printers folder. The duration of this procedure may vary based on the 
network traffic.
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7 Print a test page to verify installation.

a Click Start  Control Panel  Hardware and Sound.

b Select Printers.

c Right-click the printer you just created and select Properties.

d On the General tab, click Print Test Page.

When a test page is printed successfully, the installation is complete.

• For Windows Server 2008 and Windows Server 2008 64-bit Edition

1 Click Start  Network.

2 Locate the host name of the server computer, and then double-click the host name.

3 Right-click the shared printer name, and then click Connect.

4 Click Install driver.

5 Wait until the driver is copied from the server to the client computer. 

A new printer object is added to the Printers folder. The duration of this procedure may vary based on the 
network traffic.

6 Print a test page to verify installation.

a Click Start  Control Panel.

b Select Hardware and Sound.

c Select Printers.

d Right-click the printer you just created and select Properties.

e On the General tab, click Print Test Page.

When a test page is printed successfully, the installation is complete.

• For Windows 7, Windows 7 64-bit Edition, and Windows Server 2008 R2

1 Click Start  Computer Network (Start Network for Windows Server 2008 R2).

2 Locate the host name of the server computer, and then double-click the host name.

3 Right-click the shared printer name, and then click Connect.

4 Click Install driver.
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5 Wait until the driver is copied from the server to the client computer. 

A new printer object is added to the Devices and Printers folder. The duration of this procedure may vary 
based on the network traffic.

6 Print a test page to verify installation.

a Click Start  Devices and Printers.

b Right-click the printer you just created and select Printer properties.

c On the General tab, click Print Test Page.

When a test page is printed successfully, the installation is complete.

• For Windows 8, Windows 8 64-bit Edition, Windows 8.1, Windows 8.1 64-bit 
Edition, Windows Server 2012, and Windows Server 2012 R2

1 On the Desktop screen, place the mouse pointer in the upper right corner of the screen and move the mouse 
down, and then select Settings.

2 Click Control Panel  Network and Internet  View network computers and devices.

3 Locate the host name of the server computer, and then double-click the host name.

4 Right-click the shared printer name, and then click Connect.

5 Click Install driver.

6 Wait until the driver is copied from the server to the client computer. 

A new printer object is added to the Devices and Printers folder. The duration of this procedure may vary 
based on the network traffic.

7 Print a test page to verify installation.

a On the Desktop screen, place the mouse pointer in the upper right corner of the screen and move the 
mouse down, and then select Settings.

b Click Control Panel  Hardware and Sound (Hardware for Windows Server 2012 and Windows Server 
2012 R2)  Devices and Printers.

c Right-click the printer you just created and select Printer properties.

d On the General tab, click Print Test Page.

When a test page is printed successfully, the installation is complete.
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Peer-to-Peer
Peer-to-peer is a technology that allows you to connect to a printer connected to a host computer. You are required 
to download and install the print driver during the connection setup.

• For Windows Server 2003 and Windows Server 2003 x64 Edition

1 Click Start  Printers and Faxes.

2 Double-click the Add Printer icon to launch the Add Printer Wizard.

3 Click Next.

4 Select A network printer, or a printer attached to another computer, and then click Next. 

5 Click Browse for a printer, and then click Next.

6 Select the printer, and then click Next. 

If the printer is not listed, click Back and enter the path to the printer in the text box.

The server host name is the name of the server computer that identifies it on the network. The shared printer 
name is the name assigned during the server installation process.

If this is a new printer, you may be prompted to install a print driver. If no system driver is available, specify the 
location where the driver is available.

7 Select Yes if you want this printer to be set as the default printer, and then click Next.

8 Click Finish.

• For Windows Vista and Windows Vista 64-bit Edition

1 Click Start  Control Panel  Hardware and Sound  Printers.

2 Click Add a printer to launch the Add Printer wizard.

3 Select Add a network, wireless or Bluetooth printer, and then click Next.

If the printer is listed, select the printer, and then click Next.

If the printer is not listed, click The printer that I want isn't listed.

a Click Select a shared printer by name.

b Enter the path to the printer in the text box, and then click Next.

For example: \\<server host name>\<shared printer name>
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The server host name is the name of the server computer that identifies it on the network. The shared printer 
name is the name assigned during the server installation process.

If this is a new printer, you may be prompted to install a print driver. If no system driver is available, specify the 
location where the driver is available.

4 Perform the following as required, and then click Next.

• Click Yes to set this printer as the default printer.

• Click Print a test page to verify installation.

5 Click Finish.

If a test page is printed successfully, the installation is complete.

• For Windows Server 2008 and Windows Server 2008 64-bit Edition

1 Click Start  Control Panel  Hardware and Sound  Printers.

2 Click Add a printer to launch the Add Printer wizard.

3 Select Add a network, wireless or Bluetooth printer, and then click Next.

If the printer is listed, select the printer, and then click Next.

If the printer is not listed, click The printer that I want isn't listed.

a Click Select a shared printer by name.

b Enter the path to the printer in the text box, and then click Next.

For example: \\<server host name>\<shared printer name>

The server host name is the name of the server computer that identifies it on the network. The shared 
printer name is the name assigned during the server installation process.

If this is a new printer, you may be prompted to install a print driver. If no system driver is available, specify 
the location where the driver is available.

4 Perform the following as required, and then click Next.

• Click Yes to set this printer as the default printer.

• Click Print a test page to verify installation.

5 Click Finish.

If a test page is printed successfully, the installation is complete.

• For Windows 7, Windows 7 64-bit Edition, and Windows Server 2008 R2

1 Click Start  Devices and Printers.

2 Click Add a printer to launch the Add Printer wizard.

3 Select Add a network, wireless or Bluetooth printer.

If the printer is listed, select the printer, and then click Next.

If the printer is not listed, click The printer that I want isn't listed.

a Click Select a shared printer by name.

b Enter the path to the printer in the text box, and then click Next.



Printer Connection and Software Installation 81

The server host name is the name of the server computer that identifies it on the network. The shared printer 
name is the name assigned during the server installation process.

If this is a new printer, you may be prompted to install a print driver. If no system driver is available, you need to 
specify the path to the available drivers.

4 Perform the following as required, and then click Finish.

• Click Set as the default printer to set this printer as the default printer.

• Click Print a test page to verify installation.

If a test page is printed successfully, the installation is complete.

For example: \\<server host name>\<shared printer name>
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• For Windows 8, Windows 8 64-bit Edition, Windows 8.1, Windows 8.1 64-bit 
Edition, Windows Server 2012, and Windows Server 2012 R2

1 On the Desktop screen, place the mouse pointer in the upper right corner of the screen and move the mouse 
down, and then select Settings.

2 Click Control Panel  Hardware and Sound (Hardware for Windows Server 2012 and Windows Server 2012 
R2)  Devices and Printers.

3 Click Add a printer to launch the Add Printer wizard.

4 If the printer is listed, select the printer, and then click Next.

If the printer is not listed, click The printer that I want isn't listed.

a Click Select a shared printer by name.

b Enter the path to the printer in the text box, and then click Next.

The server host name is the name of the server computer that identifies it on the network. The shared printer 
name is the name assigned during the server installation process.

If this is a new printer, you may be prompted to install a print driver. If no system driver is available, specify the 
location where the driver is available.

5 Confirm the printer name, and then click Next.

6 Perform the following as required, and then click Finish.

• Click Set as the default printer to set this printer as the default printer.

• Click Print a test page to verify installation.

If a test page is printed successfully, the installation is complete.

For example: \\<server host name>\<shared printer name>
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Configuring Printer and Installing Software on Mac OS X

 Installing the Print Driver
For information on how to install the print driver, refer to the PostScript 3 Compatible User Guide.

 Installing Software

1 Run the Software Pack CD-ROM on the Mac OS X.

2 Double-click the CD-ROM icon displayed on the desktop.

3 Double-click the installer icon.

4 Click Continue on the Introduction screen.

5 Select a language for the Software License Agreement.

6 After reading the Software License Agreement, click Continue.

7 If you agree to the terms of the Software License Agreement, click Agree to continue the installation process.

NOTE: 

• When the screen to select the installation destination appears, select an installation location and click Continue.

8 Click Install to perform the standard installation. 

9 For Mac OS X 10.5 and Mac OS X 10.6, enter the administrator's name and password, and then click OK.

For Mac OS X 10.7, OS X 10.8, and OS X 10.9, enter the administrator's name and password, and then click 
Install Software.

10 Click Continue Installation.

11 Click Restart to complete the installation.

Adding a Printer

Adding a Printer on OS X 10.9

• When Using a USB connection

1 Turn on the printer.

2 Connect the printer and your computer with the USB cable.

3 Display System Preferences, and then click Printers & Scanners.

4 Confirm your printer is added to Printers & Scanners.

If your printer is not displayed, execute the following procedures.

5 Click the plus (+) sign, and then click Default.

If Add Printer or Scanner is displayed, select Add Printer or Scanner, and then click Default.

Proceed to step 6.

6 Select the printer connected via USB from the Name list.

Name, Location, and Use are automatically entered.

7 Click Add.
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• When Using Bonjour

1 Turn on the printer.

2 Make sure that your computer is connected to the network.

If you use wired connection, make sure that the Ethernet cable is connected between the printer and the 
network.

If you use wireless connection, make sure that wireless connection is configured properly on your computer 
and printer.

3 Display System Preferences, and then click Printers & Scanners.

4 Click the plus (+) sign, and select the printer from Nearby Printers.

The printer will be added to Printers & Scanners.

If there are no printers in Nearby Printers, select Add Printer or Scanner, and then click Default.

Proceed to step 5.

5 Select the printer connected via Bonjour from the Name list.

Name and Use are automatically entered.

NOTE: 

• If AirPrint is automatically selected for Use, select the model of your printer for Use manually.

6 Click Add.

• When Using IP Printing

1 Turn on the printer.

2 Make sure that your computer is connected to the network.

If you use wired connection, make sure that the Ethernet cable is connected between the printer and the 
network.

If you use wireless connection, make sure that wireless connection is configured properly on your computer 
and printer.

3 Display System Preferences, and then click Printers & Scanners.

4 Click the plus (+) sign, and then click IP.

If Add Printer or Scanner is displayed, select Add Printer or Scanner, and then click IP.

Proceed to step 5.

5 Select Line Printer Daemon - LPD for Protocol.

6 Enter the IP address of the printer in the Address area.

7 Select the model of your printer for Use.

NOTE: 

• When the printing is set up using IP printing, the queue name is displayed as blank. You do not need to specify it.

8 Click Add.
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Adding a Printer on Mac OS X 10.7 and OS X 10.8

• When Using a USB connection

1 Turn on the printer.

2 Connect the printer and your computer with the USB cable.

3 Display System Preferences, and then click Print & Scan.

4 Confirm your printer is added to Print & Scan.

If your printer is not displayed, execute the following procedures.

5 Click the plus (+) sign, and then click Default.

If Add Other Printer or Scanner (Add Printer or Scanner for OS X 10.8) is displayed, select Add Other 
Printer or Scanner (Add Printer or Scanner for OS X 10.8), and then click Default.

Proceed to step 6.

6 Select the printer connected via USB from the Printer Name (Name for OS X 10.8) list.

Name, Location, and Print Using (Use for OS X 10.8) are automatically entered.

7 Click Add.

• When Using Bonjour

1 Turn on the printer.

2 Make sure that your computer is connected to the network.

If you use wired connection, make sure that the Ethernet cable is connected between the printer and the 
network.

If you use wireless connection, make sure that wireless connection is configured properly on your computer 
and printer.

3 Display System Preferences, and then click Print & Scan.

4 Click the plus (+) sign, and select the printer from Nearby Printers.

The printer will be added to Print & Scan.

If there are no printers in Nearby Printers, select Add Other Printer or Scanner (Add Printer or Scanner for 
OS X 10.8), and then click Default.

Proceed to step 5.

5 Select the printer connected via Bonjour from the Printer Name (Name for OS X 10.8) list.

Name and Print Using (Use for OS X 10.8) are automatically entered.

NOTE: 

• If AirPrint Printer (AirPrint for OS X 10.8) is automatically selected for Print Using (Use for OS X 10.8), select the 
model of your printer for Use manually.

6 Click Add.

• When Using IP Printing

1 Turn on the printer.

2 Make sure that your computer is connected to the network.

If you use wired connection, make sure that the Ethernet cable is connected between the printer and the 
network.
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If you use wireless connection, make sure that wireless connection is configured properly on your computer 
and printer.

3 Display System Preferences, and then click Print & Scan.

4 Click the plus (+) sign, and then click IP.

If Add Other Printer or Scanner (Add Printer or Scanner for OS X 10.8) is displayed, select Add Other 
Printer or Scanner (Add Printer or Scanner for OS X 10.8), and then click IP.

Proceed to step 5.

5 Select Line Printer Daemon - LPD for Protocol.

6 Enter the IP address of the printer in the Address area.

7 Select the model of your printer for Print Using (Use for OS X 10.8).

NOTE: 

• When the printing is set up using IP printing, the queue name is displayed as blank. You do not need to specify it.

8 Click Add.

Adding a Printer on Mac OS X 10.5.8 and Mac OS X 10.6

• When Using a USB connection

1 Turn on the printer.

2 Connect the printer and your computer with the USB cable.

3 Display System Preferences, and then click Print & Fax.

4 Confirm your printer is added to Print & Fax in System Preferences.

If your printer is not displayed, execute the following procedures.

5 Click the plus (+) sign, and then click Default.

6 Select the printer connected via USB from the Printer Name list.

Name, Location, and Print Using are automatically entered.

7 Click Add.

• When Using Bonjour

1 Turn on the printer.

2 Make sure that your computer is connected to the network.

If you use wired connection, make sure that the Ethernet cable is connected between the printer and the 
network.

If you use wireless connection, make sure that wireless connection is configured properly on your computer 
and printer.

3 Display System Preferences, and then click Print & Fax.

4 Click the plus (+) sign, and then click Default.

5 Select the printer connected via Bonjour from the Printer Name list. 

Name and Print Using are automatically entered.

6 Click Add.
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• When Using IP Printing

1 Turn on the printer.

2 Make sure that your computer is connected to the network.

If you use wired connection, make sure that the Ethernet cable is connected between the printer and the 
network.

If you use wireless connection, make sure that wireless connection is configured properly on your computer 
and printer.

3 Display System Preferences, and then click Print & Fax.

4 Click the plus (+) sign, and then click IP.

5 Select Line Printer Daemon - LPD for Protocol.

6 Enter the IP address of the printer in the Address area.

7 Select the model of your printer for Print Using.

NOTE: 

• When the printing is set up using IP printing, the queue name is displayed as blank. You do not need to specify it.

8 Click Add.
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Configuring Printer and Installing the Print Driver on Linux 
(CUPS)

Your printer supports the following OS versions:

• Red Hat® Enterprise Linux® 6 Desktop (32-bit)

• SUSE® Linux Enterprise Desktop 11 (32-bit)

• Ubuntu® 12.04 (32-bit)

• Red Hat Enterprise Linux 6 Desktop (64-bit)

• SUSE Linux Enterprise Desktop 11 (64-bit)

• Ubuntu 12.04 (64-bit)

This section provides information for installing or setting up the print driver with CUPS (Common UNIX Printing 
System) on Red Hat Enterprise Linux 6 Desktop, SUSE Linux Enterprise Desktop 11, or Ubuntu 12.04.

NOTE: 

• When using a CD drive in a Linux environment, you need to mount the CD according to your system 
environment. The command strings are mount/media/CD-ROM.

• The print drivers, the rpm file and deb file, are included in the Linux folder on the Software Pack CD-ROM.

 Installing the Print Driver

For Red Hat Enterprise Linux 6 Desktop

1 Double-click the rpm file.

2 Click Install.

3 Enter the administrator password, and click Authenticate.

Installation starts. When the installation is complete, the window is automatically closed.

For SUSE Linux Enterprise Desktop 11

1 Double-click the rpm file.

2 Click Install.

3 Enter the administrator password, and click Authenticate.

Installation starts. When the installation is complete, the window is automatically closed.

For Ubuntu 12.04

1 Double-click the deb file.

2 Click Install.

3 Enter the user password, and click OK.

4 Click Close.

5 Click X (Close) at the top-left of the dialog box to close the Package Installer dialog box.
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Setting Up the Queue
To execute printing, you must set up the print queue on your workstation.

NOTE: 

• When you have finished setting up the queue, you can print jobs from the applications. Start the print job from the application, 
and specify the queue in the print dialog box. 
However, you may be able to print only from the default queue depending on the application. In these cases, before you start 
printing, set the queue you want to print to as the default queue. For information on specifying the default queue, see also 
"Setting the Default Queue" on page 90.

For CUPS Web UI
The following procedure uses CUPS 1.4.3 as an example.

1 Open the URL "http://localhost:631" using a web browser.

2 Click Administration.

3 Click Add Printer.

4 Enter root as the user name, and then enter the administrator password.

5 Click OK.

6 Select either of the following according to the type of your printer connection.

For network connections:

a Select LPD/LPR Host or Printer from the Other Network Printers menu, and then click Continue.

b Enter the IP address of the printer in Connection.

Format: lpd://xxx.xxx.xxx.xxx (the IP address of the printer)

c Click Continue.

d Enter the name of the printer in Name in the Add Printer window, and then click Continue.

You can optionally specify the location and description of the printer for further information.

If you want to share the printer, select the Share This Printer check box.

For USB connections:

a Select FUJI XEROX DocuPrint XXX (FUJI XEROX DocuPrint XXX) from the Local Printers menu, and 
then click Continue.

b Enter the name of the printer in Name in the Add Printer window, and then click Continue.

You can optionally specify the location and description of the printer for further information.

If you want to share the printer, select the Share This Printer check box.

7 Select FX from the Make menu, and then click Continue.

8 Select FX Printer Driver for Linux from the Model menu, and then click Add Printer.

The setup is complete.

You can optionally specify the default options settings of the printer.
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Setting the Default Queue

For CUPS Web UI
The following procedure uses CUPS 1.4.3 as an example.

1 Open the URL "http://localhost:631" using a web browser.

2 Click Administration.

3 Click Manage Printers.

4 Click the queue name for which you want to specify the printing options.

5 Click the Administration drop-down list box, and then select Set AS Server Default.

6 Enter root as the user name, enter administrator password and click OK.

The setting is complete.

Specifying the Printing Options

For CUPS Web UI
The following procedure uses CUPS 1.4.3 as an example.

1 Open the URL "http://localhost:631" using a web browser.

2 Click Administration.

3 Click Manage Printers.

4 Click the queue name for which you want to specify the printing options.

5 Click the Administration drop-down list box, and then select Set Default Options.

6 Specify the required settings, and click Set Default Options.

7 Enter root as the user name, enter administrator password and click OK.

The message Printer xxx default options have been set successfully. appears.

The setting is complete.
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5
Printing Basics

• "About Print Media" on page 92

• "Supported Print Media" on page 95

• "Loading Print Media" on page 96

• "Setting Paper Sizes and Types" on page 104

• "Printing" on page 105



92 Printing Basics

About Print Media

Using paper that is not appropriate for the printer can cause paper jams, image quality problems, or printer failure. 
To achieve the best performance from your printer, we recommend you to use only the paper described in this 
section.

When using paper other than that recommended, contact the Fuji Xerox local representative office or an authorized 
dealer.

Print Media Usage Guidelines
The printer tray accommodates various sizes and types of paper and other specialty media. Follow these guidelines 
when loading paper and media:

• Fan paper or other specialty media before loading in the tray.

• Do not print on label stock once a label has been removed from a sheet.

• Use only paper envelopes. Do not use envelopes with windows, metal clasps, or adhesives with release strips.

• Print all envelopes single-sided only. 

• Some wrinkling and embossing may occur when printing envelopes.

• Do not overload the tray. Do not load print media above the fill line on the inside of the paper width guides.

• Adjust the paper width guides to fit the paper size.

• If excessive jams occur, use paper or other media from a new package.

See also: 
• "Loading Print Media in the Standard 150 Sheet Tray" on page 96

• "Loading Envelope in the Standard 150 Sheet Tray" on page 98

• "Printing on Custom Size Paper" on page 113

WARNING:

• Do not use conductive paper such as origami paper, carbonic paper or conductively-coated paper. When paper jam 
occurs, it may cause short-circuit and eventually a fire accident.
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Automatic Document Feeder (ADF) Guidelines
The ADF accommodates the following original sizes:

• Width: 148 – 215.9 mm (5.83 – 8.50 inches)

• Length: 210 – 355.6 mm (8.27 – 14.00 inches)

The weight range includes 60 – 105 gsm.

Follow these guidelines when loading original documents into the ADF:

• Load documents face up so that the top of the document enters the printer first.

• Place only loose sheets of paper in the ADF.

• Adjust the document guides so that they fit against the documents.

• Insert paper in the document feeder tray only when the ink on the paper is completely dry.

• Do not load documents above the MAX fill line. You can load up to 15 sheets of 64 gsm documents.

NOTE: 

• You cannot load the following documents in the ADF. Be sure to place them on the document glass.

Print Media That Can Damage Your Printer
Your printer is designed to use a variety of media types for print jobs. However, some media can cause poor output 
quality, increased paper jams, or damage to your printer.

Unacceptable media includes:

• Rough or porous media

• Plastic media

• Paper that has been folded or wrinkled

• Paper with staples

• Envelopes with windows or metal clasps

• Padded envelopes

• Non-laser glossy or coated paper

• Perforated media

Curled originals Pre-punched paper

Lightweight originals Folded, creased or torn originals

Cut and paste originals Carbon paper

WARNING:

• Do not use conductive paper such as origami paper, carbonic paper or conductively-coated paper. When paper jam 
occurs, it may cause short-circuit and eventually a fire accident.
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Print Media Storage Guidelines
Providing good storage conditions for your paper and other media contributes to optimum print quality.

• Store print media in dark, cool, and relatively dry locations. Most paper items are susceptible to damage from 
ultraviolet (UV) and visible light. UV radiation, which is emitted by the sun and fluorescent bulbs, is particularly 
damaging to paper items. The intensity and length of exposure to visible light on paper items should be 
reduced as much as possible.

• Maintain constant temperatures and relative humidity.

• Avoid attics, kitchens, garages, and basements for storing print media. 

• Store print media flat. Print media should be stored on pallets, cartons, shelves, or in cabinets.

• Avoid having food or drinks in the area where print media is stored or handled.

• Do not open sealed packages of paper until you are ready to load them into the printer. Leave paper in the 
original packaging. For most commercial cut-size grades, the ream wrapper contains an inner lining that 
protects the paper from moisture loss or gain.

• Leave the media inside the bag until you are ready to use it; reinsert unused media in the bag and reseal it for 
protection. Some specialty media is packaged inside resealable plastic bags. 
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Supported Print Media

Using unsuitable print media may lead to paper jams, poor print quality, breakdown and damage to your printer. To 
use the features of this printer effectively, use the suggested print media that is recommended here.

IMPORTANT: 

• The toner may come off the print media if it gets wet by water, rain, steam, and so on. For details, contact the Fuji Xerox local 
representative office or an authorized dealer.

Usable Print Media
The types of print media that can be used on this printer are as follows:

Standard 150 Sheet Tray

* Monarch and DL can be supported by LEF with their flaps open.

NOTE: 

• SEF and LEF indicate the paper feed direction; SEF stands for short-edge feed. LEF stands for long-edge feed.

• Use only laser print media. Do not use ink jet paper in this printer.

See also: 
• "Loading Print Media in the Standard 150 Sheet Tray" on page 96

• "Loading Envelope in the Standard 150 Sheet Tray" on page 98

• "Loading Letterhead in the Standard 150 Sheet Tray" on page 100

Using print media, which is different from the paper size or paper type set on the print driver, may lead to paper jams. 
To make sure that printing is correctly performed, select the correct paper size and paper type.

Paper Size A4 SEF (210  297 mm)

B5 SEF (182  257 mm)

A5 SEF (148  210 mm)

Letter SEF (8.5  11 inches)

Legal SEF (8.5  14 inches)

Folio SEF (8.5  13 inches)

Executive SEF (7.25  10.5 inches)

C5 SEF (162  229 mm)

Monarch SEF (3.875  7.5 inches)

Monarch LEF (7.5  3.875 inches)*

Com 10 SEF (4.125  9.5 inches)

DL SEF (110  220 mm)

DL LEF (220  110 mm)*

Custom size:

Width: 76.2 – 215.9 mm (3 – 8.5 inches)

Length: 127 – 355.6 mm (5 – 14 inches)

Paper Type Plain (60 – 90 gsm)

Bond (91 – 105 gsm)

Lightweight Cardstock (106 – 163 gsm)

Lightweight Glossy Cardstock (106 – 163 gsm)

Envelope

Labels

Recycled (60 – 105 gsm)

Loading Capacity 150 sheets of standard paper
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Loading Print Media

Loading print media properly helps prevent jams and ensures trouble-free printing.

Before loading print media, identify the recommended print side of the print media. This information is usually on the 
print media package.

NOTE: 

• After loading paper in the standard 150 sheet tray, specify the same paper type on the operator panel.

Capacity
The standard 150 sheet tray can hold:

• 150 sheets of standard paper

• 16.2 mm (0.64 inches) of thick paper

• One sheet of coated paper

• Five envelopes

• 16.2 mm (0.64 inches) of labels

Print Media Dimensions
The standard 150 sheet tray accepts print media within the following dimensions:

• Width: 76.2 – 215.9 mm (3.00 – 8.50 inches)

• Length: 127 – 355.6 mm (5.00 – 14.00 inches)

Loading Print Media in the Standard 150 Sheet Tray

NOTE: 

• To avoid paper jams, do not remove the tray while printing is in progress.

• Use only laser print media. Do not use ink jet print media in this printer.

1 Hold the tray with both hands, and remove it from the printer.
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2 Adjust the paper guides.

NOTE: 

• When loading Legal size or user-specified print media, slide the extendable part of the tray while pinching the lever.

3 Before loading the print media, flex the sheets and fan them. Straighten the edges of the stack on a level 
surface.

4 Load the print media into the tray with the recommended print side facing up.

NOTE: 

• Do not exceed the maximum fill line in the tray. Overfilling the tray may cause paper jams.

• When loading coated paper, load coated paper one sheet at a time.

5 Align the width guides and length guide against the edges of the print media.
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6 After confirming that the guides are securely adjusted, insert the tray into the printer.

NOTE: 

• If the front side of the tray is extended, the tray protrudes when it is inserted into the printer.

7 Select the paper size and type from the print driver if the loaded print media is not the standard paper.

NOTE: 

• For more information about setting the paper size and type on the print driver, refer to the Help provided for the print 
driver.

Loading Envelope in the Standard 150 Sheet Tray

NOTE: 

• When you print on envelopes, be sure to specify the envelope setting on the print driver. If not specified, the print image will be 
rotated 180 degrees.

• When Loading Com 10, DL, or Monarch
Load envelopes with the flaps closed. Place the print side facing up, and the flaps come at the right when you face 
towards the printer.
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To prevent DL and Monarch from being wrinkled, they are recommended to be loaded with the flaps opened. Place 
the print side facing up, and the flaps come at the bottom when you face towards the printer.

NOTE: 

• When you load the envelopes in the long-edge feed (LEF) orientation, be sure to specify the landscape orientation on the print 
driver.

• When Loading C5
Load envelopes with the flaps opened. Place the print side facing up, and the flaps come at the bottom when you 
face towards the printer.

IMPORTANT: 

• Never use envelopes with windows, or coated linings. These lead to paper jams and can cause damage to the printer.

NOTE: 

• Up to 5 envelopes can be loaded in the standard 150 sheet tray.

• If you do not load envelopes in the standard 150 sheet tray right after they have been removed from the packaging, they may 
bulge. To avoid jams, flatten the envelopes before loading them in the standard 150 sheet tray. When flattening the envelopes, 
firmly press down on the entire surface of the envelopes as shown below.

Feed direction
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• If envelopes are still not fed correctly, curl the edge of the envelopes as shown in the following illustration. The amount of the 
curl should be 5 mm (0.20 inches) or less, 2 or 3 mm (0.08 or 0.12 inches) is recommended. The area of the curl should be 
8 – 10 mm (0.32 – 0.39 inches) from the top edge of the envelopes. Do not curl the envelopes too much or make a crease.

• To confirm the correct orientation of envelopes, see the instruction on the Envelope/Paper Setup Navigator on the print driver.

Loading Letterhead in the Standard 150 Sheet Tray
Load the letterhead in the printer with the print side facing up. Make sure that the title on the letterhead enters the 
printer first.

Manual Duplex Printing

NOTE: 

• When printing on curled paper, straighten the paper, and then insert it into the standard 150 sheet tray.

Operations on Your Computer

• Using the Windows Print Driver
The following procedure uses Microsoft® Windows® 7 as an example.

NOTE: 

• The way to display the printer Properties/Printing Preferences dialog box differs according to the application software. 
Refer to the manual of your respective application software.

Feed direction

2 or 3 mm
(0.08 or 0.12 inches)

8 – 10 mm
(0.32 – 0.39 inches)
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1 From the application menu, select Print.

2 Select the printer from Select Printer, and then click Preferences.

The Paper/Output tab of the Printing Preferences dialog box appears.

3 From Duplex, select either Flip on Long Edge or Flip on Short Edge to define the way 2-sided print pages 
are bound.

4 From Paper Size, select the size of the document to be printed.

5 From Paper Type, select the paper type to be used.

6 Click OK to close the Printing Preferences dialog box.

7 Click Print in the Print dialog box to start printing.

IMPORTANT: 

• When you start manual duplex printing, the instruction window appears. Note that the window cannot be reopened once it is 
closed. Do not close the window until duplex printing is complete.

4

3

5
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Loading Print Media in the Standard 150 Sheet Tray

1 Print the even pages (back sides).

For a six-page document, back sides are printed in the order of page 6, page 4, then page 2.

The status LED (Data) blinks and Insert Output to Tray appears on the touch panel when the printer 
finishes printing the even pages.

2 After the even pages are printed, remove the paper stack from the center output tray.

NOTE: 

• Warped or curled paper can cause paper jams. Straighten them before setting.

3 Stack the paper and set them as they are (with the blank side facing up) into the standard 150 sheet tray.

Pages are printed in the order of page 1 (back of page 2), page 3 (back of page 4), and then page 5 (back of 
page 6).

NOTE: 

• Printing on both sides of the paper is not possible if the document consists of various sizes of paper.
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Using the Output Tray Extension
The output tray extension is designed to prevent print media from falling from the printer after the print job is 
complete.

Before printing a long length document, make sure that the output tray extension is fully extended.
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Setting Paper Sizes and Types

When loading print media, set the paper size and type on the operator panel before printing.

This section describes how to set the paper size and type on the operator panel.

See also: 
• "Understanding the Printer Menus" on page 206

Setting Paper Sizes

IMPORTANT: 

• Paper size settings must match those of the actual print media loaded in the tray. Otherwise, paper size mismatch errors or 
paper jams may occur.

1 On the operator panel, press the  (System) button.

2 Select the Tools tab, and then select Paper Tray Settings.

3 Select Size.

4 Select the desired paper size.

5 Select OK.

Setting Paper Types

IMPORTANT: 

• Paper type settings must match those of the actual print media loaded in the tray. Otherwise, print-quality problems can occur.

1 On the operator panel, press the  (System) button.

2 Select the Tools tab, and then select Paper Tray Settings.

3 Select Type.

4 Select the desired paper type.

5 Select OK.
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Printing

This section covers how to print documents from your printer and how to cancel a job.

Printing from the Computer
Install the print driver to use all the features of the printer. When you choose Print from an application, a window 
representing the print driver opens. Select the appropriate settings for the file to print. Print settings selected from 
the driver have precedence over the default menu settings selected from the operator panel or the Printer Setting 
Utility.

For information on PostScript 3 Compatible driver printing for Mac OS X, refer to the PostScript 3 Compatible User 
Guide.

Printing from the Computer (Windows)

1 Open the file you want to print.

2 From the application menu, select Print.

3 Verify that the correct printer is selected in the dialog box. Modify the system settings as needed (such as the 
pages you want to print or the number of copies).

4 To adjust system settings not available from the first screen, such as Paper Size, Paper Type, or Feed 
Orientation, click Preferences.

The Printing Preferences dialog box appears.

5 Specify the system settings. For more information, click Help.

6 Click OK to close the Printing Preferences dialog box.

7 Click Print to send the job to the selected printer.
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Canceling a Print Job
There are several methods for canceling a print job.

For information on PostScript 3 Compatible driver printing for Mac OS X, refer to the PostScript 3 Compatible User 
Guide.

Canceling a Print Job From the Operator Panel
To cancel a job after it has started printing:

1 Press the  (Stop) button.

NOTE: 

• Printing is canceled only for the current job. All the following jobs will continue to print.

Canceling a Print Job From the Computer (Windows)

• Canceling a Print Job From the Taskbar
When you send a job to print, a small printer icon appears in the right corner of the taskbar.

1 Double-click the printer icon. 

A list of print jobs appears in the printer window.

2 Select the job you want to cancel.

3 Press the Delete key.

4 Click Yes on the Printers dialog box to cancel a print job.

• Canceling a Print Job From the Desktop

1 Minimize all programs to reveal the desktop.

For Windows Server® 2003, click Start  Printers and Faxes.

For Windows 7 and Windows Server 2008 R2, click Start  Devices and Printers.

For Windows Vista® and Windows Server 2008, click Start  Control Panel  Hardware and Sound  
Printers.

For Windows 8 and Windows 8.1, on the Desktop screen, place the mouse pointer in the upper right corner of 
the screen and move the mouse down, and then select Settings. Click Control Panel  Hardware and 
Sound  Devices and Printers.

For Windows Server 2012 and Windows Server 2012 R2, on the Desktop screen, place the mouse pointer in 
the upper right corner of the screen and move the mouse down, and then select Settings. Click Control Panel 
 Hardware  Devices and Printers.

A list of available printers appears. 

2 Double-click the printer you selected when you sent the job.

A list of print jobs appears in the printer window.

3 Select the job you want to cancel.

4 Press the Delete key.

5 Click Yes on the Printers dialog box to cancel a print job.
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Using the Secure Print Feature
When you send a job to the printer, you can specify the information such as user ID, passcode, and job name in the 
print driver to store the job in the memory. When you are ready to print the job, use the operator panel menus of the 
printer to identify which job in the memory you want to print.

NOTE: 

• The Secure Print feature is available only when RAM Disk under System Settings is set to On.

• The data in the memory is cleared when the printer is turned off.

Secure Print
You can store print jobs secured with a passcode in the memory. Users with the passcode can print them from the 
operator panel. This feature can be used to print confidential documents. The stored job in the memory is deleted 
automatically after printing. You can select to delete the stored job before printing, or the stored job is deleted by 
turning off the printer.

NOTE: 

• Secure Print is available when you use the PCL or PostScript 3 Compatible driver.

Procedures for Printing Secure Print
The following are procedures for storing and printing jobs.

• Storing Print Jobs
For Secure Print, select Secure Print for Job Type and specify the user ID, passcode and job name by clicking 
Setup in the Paper/Output tab of the print driver. When you send the job to the printer, the job will be stored in the 
memory until you request to print from the operator panel or turn off the printer.

NOTE: 

• If a print job is too large for the memory available, the printer may display error messages.

• If a document name is not assigned to your print job in the print driver, the job's name will be identified using the printer's time 
and date of submission to distinguish it from other jobs you have stored under your name.

• Printing the Stored Jobs
Once jobs are stored, you can use the operator panel to specify printing.

Printing the Secure Print Job
Secure Print requires the passcode you specified in the driver when you sent the job.

1 Press the  (Job Status) button.

2 Select Secure Print.

3 Select a user ID you specified in the print driver.

4 Enter the passcode you specified in the print driver using the number pad, and select OK.

For details about specifying the passcode, see "Specifying Your Passcode on the Operator Panel" on 
page 108.

Send confidential data.

Enter the passcode from 
the operator panel.

Print data.

Confidential
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5 Select the document you want to print.

NOTE: 

• By default, the driver setting is used for the number of copies to print. You can select Quantity to change the setting.

6 Select Print.

NOTE: 

• If you want to delete the data in the memory after printing, select the Print and Delete check box.

7 Select OK.

The stored document will be printed.

• Specifying Your Passcode on the Operator Panel
When you select your user ID for Secure Print, a screen to enter the passcode appears.

Use the number pad to enter the numeric passcode you specified in the print driver. The passcode you entered will 
be displayed as asterisks (*******) to ensure confidentiality.

If you enter an invalid passcode, Wrong Password Re-enter appears. Wait for three seconds, or select Close to 
return to the screen to enter the passcode.

When you enter a valid passcode, you have access to all print jobs matching the user name and passcode you 
entered. The print jobs matching the passcode you entered appear on the screen. You can then choose to print or to 
delete jobs matching the passcode you entered. For details, see "Printing the Stored Jobs" on page 107.

• Deleting Stored Jobs
A job that has been stored will be deleted after printing if selected to do so on the operator panel. Otherwise, the job 
remains stored until you delete them on the operator panel.

NOTE: 

• The data in the memory is cleared when the printer is turned off.



Printing Basics 109

Direct Print Using the USB Storage Device
The Print from USB feature allows you to print files stored in a USB storage device by operating the operator panel.

IMPORTANT: 

• To prevent damage to your printer, DO NOT connect any device other than USB storage device to the USB drive of the printer.

• DO NOT remove the USB storage device from the USB drive until the printer has finished printing.

NOTE: 

• If the Service Lock setting for Print from USB is set to Password Locked or Color Password Locked, you need 
to enter the four digit passcode to use the Print from USB feature. If the Service Lock setting for Print from USB is set 
to Locked, the Print from USB feature is disabled and the menu is not displayed on the screen. For details, see "Service 
Lock" on page 236.

The USB drive of the printer is designed for USB 2.0 devices. You must use only an authorized USB storage device 
with an A plug type connector. Use only a metal shielded USB storage device.

To print a file in a USB storage device:

1 Press the  (Services Home) button.

2 Insert the USB storage device into the USB drive of the printer.

NOTE: 

• If the USB Drive Detected menu appears, select Print a File, and proceed to step 4.

3 Select Print from USB.

4 Select the desired file, and then select OK.

NOTE: 

• Some characters may not be displayed correctly on the operator panel.

5 Select printing options as required.

6 Press the  (Start) button to start printing.

NOTE: 
• Color printing is secured with a passcode if the Service Lock setting for Print from USB is set to Color 

Password Locked. If you set Output Color to Full Color and the Service Lock setting for Print from USB 
to Color Password Locked, you will need to enter the four digit passcode after pressing the  (Start) button.

• You can print files scanned and stored using the Scan To USB feature. Files saved without using the feature such as files 
created by user may not be printed properly.

IMPORTANT: 

• Before removing the USB storage device, ensure that the printer is not accessing the USB storage device. If you remove the 
USB storage device while the printer is accessing, the data in the USB storage device or the USB storage device itself may be 
damaged.

A plug type
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Supported File Formats
Files in the following file formats, created using the Scan To USB feature, are supported and can be printed directly 
from the USB storage device.

• PDF

• TIFF

• JPEG

NOTE: 

• Files created without using the Scan To USB feature may not be printed properly.

Selecting Printing Options
For information on PostScript 3 Compatible driver printing for Mac OS X, refer to the PostScript 3 Compatible User 
Guide.

Selecting Printing Preferences (Windows)
Printing preferences control all of your print jobs, unless you override them specifically for a job. For example, if you 
want to use duplex printing for most jobs, set this option in printing preferences.

To select printing preferences:

1 For Windows Server 2003, click Start  Printers and Faxes.

For Windows 7 and Windows Server 2008 R2, click Start  Devices and Printers.

For Windows Vista and Windows Server 2008, click Start  Control Panel  Hardware and Sound  
Printers.

For Windows 8 and Windows 8.1, on the Desktop screen, place the mouse pointer in the upper right corner of 
the screen and move the mouse down, and then select Settings. Click Control Panel  Hardware and 
Sound  Devices and Printers.

For Windows Server 2012 and Windows Server 2012 R2, on the Desktop screen, place the mouse pointer in 
the upper right corner of the screen and move the mouse down, and then select Settings. Click Control Panel 
 Hardware  Devices and Printers.

A list of available printers appears. 

2 Right-click the icon for your printer, and then select Printing preferences.

The printer's Printing Preferences screen appears.

3 Make selections on the driver tabs, and then click OK to save your selections.

NOTE: 

• For more information about Windows print driver options, click Help on the print driver.

Selecting Options for an Individual Job (Windows)
If you want to use special printing options for a particular job, change the driver settings before sending the job to the 
printer. For example, if you want to use Photo print-quality mode for a particular graphic, select this setting in the 
driver before printing that job.

1 With the desired document or graphic open in your application, access the Print dialog box.

2 Select your printer and click Preferences to open the print driver.

3 Make selections on the driver tabs.

NOTE: 

• When using the PCL or PostScript 3 Compatible driver, you can save current printing options with a distinctive name and 
apply them to other print jobs. Select either the Paper/Output, Graphics, Layout, Watermark/Forms, or Advanced 
tab, and then click Save under Favorites on the Paper/Output tab. Click Help for more information.

4 Click OK to save your selections.
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5 Print the job.

See the following table for specific printing options:

The table shown below uses the PCL driver as an example.

Printing Options for Windows

Driver Tab Printing Options

Paper/Output tab • Job Type

– Setup

• Favorites

– Save

– Edit

• Duplex

• Output Color

• Copies

– Collated

• Paper Summary

• Paper Size

• Paper Type

• Feed Orientation

• Print as Bitmap

• Envelope/Paper Setup Navigator

• Printer Status

• Restore Defaults

Graphics tab • Output Color

• Image Adjustment Mode

• Image Types

• Screen

• Toner Saving Mode

• Gray Guaranteed

• Image Settings

• Color Balance

• Profile Settings

• Restore Defaults

Layout tab • Image Orientation

• Multiple Up

• Booklet / Poster / Mixed Document

• Output Size

• Reduce / Enlarge

• Margin Shift/Margin

• Restore Defaults
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Printing on Custom Size Paper
This section explains how to print on custom size paper using the print driver.

The way to load custom size paper is the same as the one to load standard size paper.

See also: 
• "Loading Print Media in the Standard 150 Sheet Tray" on page 96

• "Setting Paper Sizes and Types" on page 104

For information on PostScript 3 Compatible driver printing for Mac OS X, refer to the PostScript 3 Compatible User 
Guide.

Defining Custom Paper Sizes
Before printing, set the custom size on the print driver.

NOTE: 

• When setting the paper size on the print driver and the operator panel, be sure to specify the same size as the actual print 
media used. Setting the wrong size for printing can cause printer failure. This is especially true if you configure a bigger size 
when using a narrow width paper.

• Using the Windows Print Driver
On the Windows print driver, set the custom size in the Custom Paper Size dialog box. This section explains the 
procedure using Windows 7 as an example.

An administrator's password only allows users with administrator rights to change the settings. Users without 
administrator rights can only view the contents.

1 Click Start Devices and Printers.

2 Right-click the printer, and then select Printer properties.

3 Select the Configuration tab.

4 Click Custom Paper Size.

5 Select the custom setup you want to define from Details.

Watermarks/Forms tab • Watermarks

– New Text

– New Bitmap

– Edit

– Delete

– First Page Only

• Forms

– Off

– Create / Register Forms

– Image Overlay

– File Name

– Browse

• Header / Footer Options

• Restore Defaults

Advanced tab • Items

• Settings for

• Font Settings

• Restore Defaults

Driver Tab Printing Options
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6 Specify the length of the short edge and long edge under Change Setting For. 

You can specify the values either by entering them directly or using the up arrow and down arrow buttons. The 
length of the short edge cannot be longer than the long edge even if it is within the specified range. The length 
of the long edge cannot be shorter than the short edge even if it is within the specified range.

7 To assign a paper name, select the Name the Paper Size check box, and then enter the name in Paper Name. 
Up to 24 characters can be used for the paper name.

8 If necessary, repeat steps 5 to 7 to define another custom size.

9 Click OK twice.

Printing on Custom Size Paper
Use the following procedures to print using the Windows print driver.

• Using the Windows Print Driver
This section explains the procedure using Windows 7 as an example.

NOTE: 

• The way to display the printer Properties/Printing Preferences dialog box differs according to the application software. 
Refer to the manual of your respective application software.

1 From the application menu, select Print.

2 Select your printer and click Preferences.

3 Select the Paper/Output tab.

4 Select the size of the document to be printed from Paper Size.

5 Select the paper type to be used from Paper Type.

6 Click the Layout tab.

7 From Output Size, select the custom size you defined. If you have selected the custom size from Paper Size 
in step 4, select Same as Paper Size.

8 Click OK.

9 Click Print in the Print dialog box to start printing.
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Checking Status of Print Job

Checking Status via the SimpleMonitor (Windows Only)
You can check the printer status and print job status with the SimpleMonitor.

See also: 
• "SimpleMonitor (Windows Only)" on page 40

For more information about the SimpleMonitor, see Help:

The following procedure uses Windows 7 as an example.

1 Click Start  All Programs  Fuji Xerox  Fuji Xerox Printer Software for Asia-Pacific  your printer 
SimpleMonitor-Ctype for Asia-Pacific.

The window to select a printer appears.

2 Click the name of the desired printer from the list.

The Printer Status window appears.

3 Click Help.

Checking Status via the CentreWare Internet Services
You can check the status of the print job sent to the printer at the Jobs tab of the CentreWare Internet Services.

See also: 
• "CentreWare Internet Services" on page 38

Printing With Wi-Fi Direct
This section provides information for Wi-Fi Direct® printing. Wi-Fi Direct allows your Wi-Fi® mobile devices such as 
computers, smart phones, and tablets, to connect to the printer directly via a Wi-Fi network. With Wi-Fi Direct, you 
can print documents, photos, or e-mail on your Wi-Fi mobile devices directly without a wireless access point.

NOTE: 

• Wi-Fi Direct supports only IPv4 connection.

• Only printing function is available via the Wi-Fi Direct network.

• The maximum number of devices that can be connected via the Wi-Fi Direct network is one.

• You cannot connect your mobile device to the Internet via the printer's Wi-Fi Direct network.

• Depending on the device, the channel used to connect the device to the printer via Wi-Fi Direct may differ from the channel 
used by the printer to connect to a network via Wi-Fi infrastructure mode. In such a case, simultaneous connection with Wi-Fi 
Direct and Wi-Fi infrastructure mode may not work properly.

• The printer connected with Wi-Fi Direct supports the following protocols; LPD, Port9100, WSD (Web Services on Devices) 
(print), Bonjour (mDNS), SNMPv1/v2c, CentreWare Internet Services.
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Setting Up Wi-Fi Direct
To use Wi-Fi Direct, you need to first set up the Wi-Fi Direct settings from the operator panel of the printer. To 
connect the mobile device to the printer via Wi-Fi Direct, you need to operate the mobile device to establish 
connection.

• Setting Up the Printer

1 Press the  (System) button.

2 Select the Tools tab, and then tap Admin Settings.

3 Select Network.

4 Select Wi-Fi Direct.

5 In the Wi-Fi Direct menu, select Wi-Fi Direct.

6 Select Enable, and then select OK.

When you use a Wi-Fi Direct certified mobile device (including the device with the Wi-Fi Direct PIN function), 
proceed to step 9.

When you use a mobile device that is not Wi-Fi Direct certified, or mobile device with WPS-PBC (Wi-Fi 
Protected Setup™-Push Button Configuration), WPS-PIN (Wi-Fi Protected Setup-Personal Identification 
Number), proceed to step 7.

7 Select Group Role.

8 Select Group Owner, and then select OK.

For a mobile device with WPS-PBC

a Select WPS Setup.

b Select Push Button Configuration.

The printer is ready to use the WPS-PBC connection.

For a mobile device with WPS-PIN

a Select WPS Setup.

b Select PIN Code to check the PIN code.

The printer is ready to use the WPS-PIN connection.

NOTE: 

• To confirm the printer's PIN code, you can also print the list by selecting Print PIN Code under the WPS 
Setup menu.

9 Select Connection Status.

10 Confirm no device is connected with the Wi-Fi Direct connection.

NOTE: 

• When other device is connected (the mobile device name is displayed on Connection Status), you cannot use the 
Wi-Fi Direct connection. Disconnect the other device from the Wi-Fi Direct network. For details, see "Disconnecting Wi-Fi 
Direct Network" on page 118.

The printer is ready to use the Wi-Fi Direct connection.
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• Connecting a Wi-Fi Direct Certified Mobile Device
The following is a typical procedure for connecting a mobile device to the printer using Wi-Fi Direct. The procedure 
varies depending on the mobile device you are using. Refer to the manual provided with your mobile device.

1 From the mobile device, start the procedure to connect using Wi-Fi Direct.

2 Accept the invitation for Wi-Fi Direct connection displayed on the touch panel of the printer. 

NOTE: 

• If you want to change the printer's group role of the Wi-Fi Direct network, select Group Role under the Wi-Fi Direct 
menu.

• Connecting a Wi-Fi Direct Certified Mobile Device With PIN Code
The following is a typical procedure for connecting a mobile device to the printer using Wi-Fi Direct PIN code. The 
procedure varies depending on the mobile device you are using. Refer to the manual provided with your mobile 
device.

NOTE: 

• Before you connect the mobile device to the printer, confirm that WPS Setup is set to PIN Code.

1 From the mobile device, start the procedure to connect using Wi-Fi Direct PIN code.

When the mobile device tries to connect through the Wi-Fi Direct network using the PIN code, the following 
pop-up message is displayed on the operator panel.

PIN Code: XXXXXXXX

2 Input the PIN code to your mobile device.

3 Accept the invitation for Wi-Fi Direct connection displayed on the touch panel of the printer.

• Connecting a Mobile Device That is not Wi-Fi Direct Certified

1 Press the  (System) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select Network.

4 Select Wi-Fi Direct.

5 Select  until SSID and Passphrase appears, and then select each menu to check what the SSID and 
passphrase is.

NOTE: 

• To confirm the printer's SSID and passphrase, you can also print the list by selecting Print Passphrase under the 
Passphrase menu.

6 Connect the mobile device to the Wi-Fi Direct network.

For Windows 8, Windows 8.1, Windows RT, and Windows RT 8.1

a Tap Settings in the PC settings menu.

b Tap the Wi-Fi icon.

c Tap the printer's SSID, and then tap Connect.

d Enter the passphrase, and then tap Next.

The mobile device will connect to the printer.
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For Windows 7

a Click the network icon on the taskbar.

b Click the printer's SSID, and then click Connect.

c Enter the passphrase, and then click OK.

d Click Cancel to exit the Set Network Location window.

The mobile device will connect to the printer.

For Windows Vista

a Click Start  Connect To.

b Click the printer's SSID.

c Enter the passphrase, and then click Connect.

The mobile device will connect to the printer.

For iOS

a Tap Settings  Wi-Fi.

b Tap the printer's SSID.

c Enter the passphrase, and then tap Join.

The mobile device will connect to the printer.

For Android™

The procedure varies depending on the mobile device you are using. Refer to the manual provided with your 
mobile device.

7 Install the printer on the mobile device.

For Windows 8, Windows 8.1, Windows RT, and Windows RT 8.1

a Tap Devices in the PC settings menu.

b Tap Add a device in the Devices sub-menu.

c Tap DIRECT-XXXXX.

The printer is ready for use.

For Windows Vista and Windows 7

You need to install the print driver on the mobile device. For details, see "Configuring Printer and Installing 
Software on Windows" on page 60.

For iOS

You need to install the printing application such as Print Utility for iOS, and then the printer is ready for use.

For Android

You need to install the printing application such as Fuji Xerox Print Utility for Android, and then the printer is 
ready for use.

• Connecting a Mobile Device With WPS-PBC and WPS-PIN
The following is a typical procedure for connecting a mobile device to the printer using WPS-PBC or WPS-PIN. The 
procedure varies depending on the mobile device you are using. Refer to the manual provided with your mobile 
device.

1 From the mobile device, start the procedure to connect using the WPS-PBC or WPS-PIN.

The procedure varies depending on the mobile device you are using. Refer to the manual provided with your 
mobile device.

2 Accept the invitation for Wi-Fi Direct connection using the printer on the operator panel.



118 Printing Basics

Printing via Wi-Fi Direct
The printing procedure varies depending on the mobile device you are using. Refer to the manual provided with your 
mobile device to print as you normally do from the device.

Disconnecting Wi-Fi Direct Network

1 Press the  (System) button.

2 Select Wi-Fi Status.

3 Select the device name to disconnect.

4 Select Disconnect Now or Disconnect and Reset Passphrase.

NOTE: 

• If the mobile device  automatically reconnects to the printer, select Disconnect and Reset Passphrase.

5 Select Yes.

The selected device is successfully disconnected.

You can also disconnect the device from the following steps.

1 Press the  (System) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select Network.

4 Select Wi-Fi Direct.

5 Select Connection Status.

6 Select the device name to disconnect.

7 Select Disconnect now.

8 Select Yes.

Resetting the Passphrase

1 Press the  (System) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select Network.

4 Select Wi-Fi Direct.

5 Select  until Passphrase appears, and then select Passphrase.

6 Select ResetPassphrase.

7 Select Yes.

The Wi-Fi Direct is disconnected and the passphrase is reset.
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Mobile Printing
This printer supports printing from a variety of mobile devices using the Fuji Xerox Print Utility for Android or Print 
Utility for iOS.

For Android OS, download for free from Google Play™, or please visit our online support at 
http://www.fxap.com.sg/product/productDescription.jsp?id=174 

For iOS, download for free from App Store, or please visit our online support at 
http://www.fxap.com.sg/product/productDescription.jsp?id=166 

Printing With AirPrint

Setting Up AirPrint on Your Printer
To use AirPrint, Bonjour (mDNS) and IPP protocols are required on your printer. Make sure that Bonjour (mDNS) 
and IPP are set to Enable on the operator panel menu. For details, see "IPsec" on page 218. Bonjour (mDNS) 
and IPP can also be enabled by selecting the Enabled check box for Enable AirPrint from the CentreWare Internet 
Services. Follow the procedure below to configure the environment settings for AirPrint from the CentreWare 
Internet Services.

1 Confirm that the printer is connected to the network.

2 Launch the CentreWare Internet Services by entering the IP address of the printer in your web browser.

3 Click the Properties tab.

4 In the left navigation panel, scroll down to Protocol Settings and click AirPrint.

5 Select the Enabled check box for Enable AirPrint.

NOTE: 

• If the Enabled check box is not active, it means that both Bonjour(mDNS) and IPP are already set to Enable on the 
operator panel menu and the printer is ready for AirPrint.

6 Click Apply.

7 Click Reboot Machine to restart the printer.

The printer is ready for AirPrint.

Printing via AirPrint
The following procedure uses the iPhone running iOS 7 as an example.

1 Open your e-mail, photo, web page, or document you want to print.

2 Tap the action icon .

3 Tap Print.

4 Select your printer and set printer options.

5 Tap Print.

NOTE: 

• To cancel the printing job, double-click the Home button, tap the Print Center icon . If there are more than one job in 
the queue, select the job you want to cancel, then tap Cancel Printing.

This section provides information for printing with AirPrint. AirPrint allows you to print through a network 
with iPad (all models), iPhone (3GS or later), and iPod touch (3rd generation or later) running the latest 
version of iOS. AirPrint also allows you to accomplish basic network printing with Macintosh (Mac OS X 
10.7 or later) without installing additional drivers.

http://www.fxap.com.sg/product/productDescription.jsp?id=174
http://www.fxap.com.sg/product/productDescription.jsp?id=166
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Printing With Google Cloud Print
This section provides information for Google Cloud Print™ service with your smart phone, tablet, or any other 
device. By registering the printer to your Google™ account, you can use the Google Cloud Print service to print from 
various devices connected to the Internet. You can print documents, photos or e-mails using the Google Chrome™ 
browser or applications such as Google Drive™ on your mobile device. For more information about Google Cloud 
Print, visit the Google web site.

Preparing to Use the Printer with Google Cloud Print
To use Google Cloud Print, you need to prepare the following in advance:

• Connect the printer to a network that has access to the Internet.

NOTE: 

• Google Cloud Print supports only IPv4 connection.

• If the printer is connected to a network that uses a proxy server, you need to specify the settings in Proxy Server from the 
CentreWare Internet Services. For more information, see "CentreWare Internet Services" on page 38.

• Acquire a Google account and a Gmail™ address.

• Set Google Cloud Print to Enable from the operator panel menu, or set GCP to Enabled from the 
CentreWare Internet Services.

• When using the operator panel

1 Press the  (System) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select Network.

4 Select Protocols.

5 Select  until Google Cloud Print appears, and then select Google Cloud Print.

6 Select Enable.

7 Turn off the printer, and turn it on again to apply the settings.

• When using the CentreWare Internet Services

1 Launch the CentreWare Internet Services by entering IP address of the printer in your web browser. 

For more information, see "CentreWare Internet Services" on page 38.

2 Click the Properties tab.

3 In the left navigation panel, click Port Status.

4 Select the Enabled check box for GCP.

5 Click Apply.

6 Click Reboot Machine to restart the printer.

The printer is ready for Google Cloud Print.
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Registering the Printer to Your Google Account
To register the printer to your Google account, follow the procedure below.

1 Launch the CentreWare Internet Services by entering IP address of the printer in your web browser. 

For more information, see "CentreWare Internet Services" on page 38.

2 Click the Properties tab.

3 In the left navigation panel, scroll down to Protocol Settings and click Google Cloud Print.

4 Click Register This Device to Google Cloud Print.

A sheet with a URL for the Google Cloud Print printer registration web site is printed.

5 From the web browser of your computer, visit the Google web site and sign in with your Google account. Visit 
the Google Cloud Print registration web site by entering the URL on the printout into your web browser. You can 
also visit the site by scanning the QR code with your mobile device.

6 On the Google Cloud Print registration web site, click Finish printer registration.

7 Click Manage your printers. Your printer will be listed in the Printers list and will be ready for use with the 
Google Cloud Print service.

Printing via Google Cloud Print
The printing procedure varies depending on the application or the device you are using. You can see the application 
list that supports Google Cloud Print service on the Google web site.

• Printing From an Application on a Mobile Device
The following procedure uses the Google Drive application on an Android mobile device as an example.

1 Install the Google Drive application on your mobile device.

NOTE: 

• You can download the application from Google Play.

2 Access the Google Drive application from your mobile device and tap  to select the document.

3 Tap  and then tap Print.

4 Select your printer from the list.

5 Select printer options and then tap Print.

• Printing From Google Chrome
The following procedure uses the Google Chrome browser on a Windows PC as an example.

1 Open the Google Chrome browser.

2 Open the web page or e-mail that you want to print.

3 Click  or  (varies depending on the version of the Google Chrome browser) in the top right corner and then 
click Print.

4 Click Change in the Destination area.

5 Choose your printer from the Google Cloud Print area.

6 Click Print.
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Printing a Report Page
You can print various types of reports and lists. For details on each report and list, see "Report / List" on page 206.

This section describes how to print a report page using the System Settings page as an example.

Printing a System Settings Page
To verify detailed printer settings, print a System Settings page.

• Using the Operator Panel

1 Press the  (System) button.

2 Select Report / List.

3 Select System Settings, and then select Print.

The System Settings page is printed.

• Using the Printer Setting Utility (Windows Only)
The following procedure uses Windows 7 as an example.

1 Click Start  All Programs  Fuji Xerox  Fuji Xerox Printer Software for Asia-Pacific  your printer  
Printer Setting Utility.

NOTE: 

• The window to select a printer appears in this step when multiple print drivers are installed on your computer. In this 
case, click the name of the desired printer listed in Printer Name.

The Printer Setting Utility appears.

2 Click the Printer Settings Report tab.

3 Select Reports from the list at the left side of the page.

The Reports page is displayed.

4 Click System Settings.

The System Settings page is printed.
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Printer Settings

Using the Operator Panel to Change the Printer Settings
You can select menu items and corresponding values from the operator panel.

When you first browse through the menus from the operator panel, a list of menu items is displayed. The values 
displayed for each menu item are the factory default and original system settings.

When you select a new value or setting in the menu item, the newly selected value or setting is displayed to indicate 
the current user setting.

NOTE: 

• Factory defaults may vary for different regions.

• These settings are active until new ones are selected or the factory defaults are restored.

• The print driver settings may have precedence over the settings made on the operator panel.

To select a new value as a setting:

1 Press the  (System) button.

2 Select the Tools tab, and then select the desired menu.

3 Select the desired menu or menu item.

• If a menu is selected, the menu is opened and the list of menu items appears.

• If a menu item is selected, the default menu setting for the menu item appears.

Each menu item has a list of values for the menu item. A value can be:

• A phrase or word to describe a setting

• A numerical value that can be changed

• An On or Off setting

4 Select the desired value.

NOTE: 

• Some menu items require you to use the screen keyboard or the number pad to enter the value.

5 Select OK.

6 Select  to return to the previous menu.

To continue setting other items, select the desired menu. To quit setting new values, select .

Using the Printer Setting Utility to Change the Printer Settings (Windows 
Only)
You can select menu items and corresponding values from the Printer Setting Utility.

The following procedure uses Windows 7 as an example.

NOTE: 

• Factory defaults may vary for different regions.

• These settings are active until new ones are selected or the factory defaults are restored.

• The print driver settings may have precedence over the settings made on the Printer Settings Utility.
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To select a new value as a setting:

1 Click Start  All Programs  Fuji Xerox  Fuji Xerox Printer Software for Asia-Pacific  your printer  
Printer Setting Utility.

NOTE: 

• The window to select a printer appears in this step when multiple print drivers are installed on your computer. In this 
case, click the name of the desired printer listed in Printer Name.

The Printer Setting Utility appears.

2 Click the Printer Maintenance tab.

3 Select the desired menu item.

Each menu item has a list of values for the menu item. A value can be:

• A phrase or word to describe a setting

• A numerical value that can be changed

• An On or Off setting

4 Select the desired value, and then click Apply New Settings or Restart printer to apply new settings.

Adjusting the Language
To display a different language on the operator panel:

• Using the Operator Panel

1 Press the  (System) button.

2 Select the Tools tab, and then select Language Settings.

3 Select Panel Settings, and then select desired language.

4 Select OK.

• Using the Printer Setting Utility (Windows Only)
The following procedure uses Windows 7 as an example.

1 Click Start  All Programs  Fuji Xerox  Fuji Xerox Printer Software for Asia-Pacific  your printer 
Printer Setting Utility.

NOTE: 

• The window to select a printer appears in this step when multiple print drivers are installed on your computer. In this 
case, click the name of the desired printer listed in Printer Name.

The Printer Setting Utility appears.

2 Click the Printer Maintenance tab.

3 Select System Settings from the list at the left side of the page.

The System Settings page is displayed.

4 Select the desired language from Panel Language, and then click Apply New Settings.
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6
Copying

• "Loading Paper for Copying" on page 126

• "Preparing a Document" on page 127

• "Making Copies From the Document Glass" on page 128

• "Making Copies From the ADF" on page 130

• "Setting Copy Options" on page 131

• "Using the ID Card Copy" on page 137

• "Changing the Default Settings" on page 138
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Loading Paper for Copying

The instructions for loading print media are the same whether you are printing, faxing, or copying.

See also: 
• "Usable Print Media" on page 95

• "Loading Print Media" on page 96
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Preparing a Document

You can use the document glass or the automatic document feeder (ADF) to load an original document for copying, 
scanning and sending a fax. You can load up to 15 sheets of 64 gsm documents for one job using the ADF or one 
sheet at a time using the document glass.

IMPORTANT: 

• Avoid loading documents that are smaller than 148.0  210.0 mm (5.83  8.27 inch) or larger than 215.9  355.6 mm (8.5  14 
inch), different sizes or weights together, booklets, pamphlets, transparencies, or documents having other unusual 
characteristics in ADF.

• Carbon-paper or carbon-backed paper, coated paper, onion skin or thin paper, wrinkled or creased paper, curled or rolled 
paper or torn paper cannot be used in ADF.

• Do not use the documents with staples, paper clips or exposed to adhesives or solvent based materials such as glue, ink and 
correcting fluid in ADF.

NOTE: 

• To get the best scan quality, especially for color or gray scale images, use the document glass instead of the ADF.
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Making Copies From the Document Glass

NOTE: 

• A computer connection is not required for copying. 

• Make sure that no document is in the ADF. If any document is detected in the ADF, it takes priority over the document on the 
document glass.

• Dust on the document glass may cause black spots on the copies. For best results, clean the document glass before use. For 
more information, see "Cleaning the Scanner" on page 317.

To make a copy from the document glass:

1 Open the document cover.

2 Place the document facing down on the document glass and align it with the registration guide on the top left 
corner of the document glass.

3 Close the document cover.

NOTE: 

• Leaving the document cover open while copying may affect the copy quality and increase the toner consumption.

• If you are copying a page from a book or magazine, lift the document cover until its hinges are caught by the stopper, and 
then close the document cover. If the book or magazine is thicker than 20 mm, start copying with the document cover 
open. 

4 Press the  (Services Home) button.

To simply make a copy without changing the default copy settings, proceed to step 8.

5 Select Copy.

CAUTION:

• Do not apply excessive force to hold thick document on the document glass. It may break the glass and cause 
injuries.
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6 Customize the copy settings such as the number of copies, copy size, and image quality.

See also: 

• "Setting Copy Options" on page 131

To clear the settings, press the  (Clear All) button.

NOTE: 

• The copy options automatically return to their default status after the auto clear timer is expired.

7 Enter the number of copies from 1 to 99 using the number pad.

8 Press the  (Start) button to start copying.

NOTE: 

• Press the  (Stop) button to cancel a copy job at any time while scanning a document.



130 Copying

Making Copies From the ADF

IMPORTANT: 

• Do not load more than 15 sheets on the ADF or allow more than 15 sheets to be fed to the document output tray. The 
document output tray should be emptied before it holds more than 15 sheets or your source documents may be damaged.

NOTE: 

• To get the best scan quality, especially for color or gray scale images, use the document glass instead of the ADF.

• A computer connection is not required for copying. 

• You cannot load the following documents in the ADF. Be sure to place them on the document glass.

To make copy from the ADF:

1 Load up to 15 sheets of 64 gsm documents facing up on the ADF with top edge of the documents in first. Then 
adjust the document guides to the correct document size.

NOTE: 

• Be sure to adjust the document guides before copying a legal-size document.

2 Press the  (Services Home) button.

To simply make a copy without changing the default copy settings, proceed to step 6.

3 Select Copy.

4 Customize the copy settings such as number of copies, copy size, and image quality. 

See also: 

• "Setting Copy Options" on page 131

To clear the settings, press the  (Clear All) button.

NOTE: 

• The copy options automatically return to their default status after the auto clear timer is expired.

5 Enter the number of copies from 1 to 99 using the number pad.

6 Press the  (Start) button to start copying.

NOTE: 

• Press the  (Stop) button to cancel a copy job at any time while scanning a document.

Curled originals Pre-punched paper

Lightweight originals Folded, creased or torn originals

Cut and paste originals Carbon paper
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Setting Copy Options

Set the following options for the current copy job before pressing the  (Start) button to start copying.

For details about making copies, see "Making Copies From the Document Glass" on page 128 and "Making Copies 
From the ADF" on page 130.

NOTE: 

• The copy options automatically return to their default status after the auto clear timer is expired.

Output Color
To select the mode for color or black and white copying.

1 Select Output Color.

2 Select Full Color or Black & White, and then select OK.

Lighten / Darken
To adjust the contrast to make the copy lighter or darker than the original.

1 Select Lighten / Darken.

2 Select the desired level on the Lighten / Darken bar, and then select OK.

You can select a contrast level from five levels between Darken and Lighten.

Selecting a cell on the left side of the bar makes the document contrast darker, and selecting a cell on the right 
side of the bar makes the document contrast lighter.

NOTE: 

• The value marked by an asterisk (*) is the factory default setting.

Document Type
To select the copy image quality.

1 Select the Quality tab, and then select Document Type.

2 Select the desired setting, and then select OK.

NOTE: 

• The value marked by an asterisk (*) is the factory default setting.

Lighten +2 Works well with dark documents.

Lighten +1

Normal* Works well with normal typed or printed documents.

Darken +1 Works well with light documents or faint pencil markings.

Darken +2

Mixed* Used for documents with photos and text.

Text Used for documents with text.

Photo Used for documents with photos.
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Sharpness
To adjust the sharpness to make the copy image sharper or softer than the original.

1 Select the Quality tab, and then select Sharpness.

2 Select the desired setting, and then select OK.

NOTE: 

• The value marked by an asterisk (*) is the factory default setting.

Auto Background Suppression
To suppress the background of the original to enhance text on the copy.

1 Select the Quality tab, and then select Auto Background Suppression.

2 Select the desired setting, and then select OK.

NOTE: 

• The value marked by an asterisk (*) is the factory default setting.

Collated
To sort the copy output. For example, if you make two sets of a three-page document, the first set will be printed 
followed by the second set.

1 Select the Output tab, and then select Collated.

2 Select the desired setting, and then select OK.

NOTE: 

• The value marked by an asterisk (*) is the factory default setting.

When you are using the document glass and it is set to Collated, the display prompts you for another page 
after pressing the  (Start) button.

a If you want to place a new document, replace the document with a new document, and then select Scan 
Another Page or press the  (Start) button.

b If you finish copying, select Done. Print Now.

Sharpen2 Makes the copy sharper than the original.

Sharpen1

Normal* Does not make the copy sharper or softer than the original.

Soften1 Makes the copy softer than the original.

Soften2

Off

On*

Uncollated* Does not copy in collated order.

Collated Copies in collated order.
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Reduce / Enlarge
To reduce or enlarge the size of a copied image from 25 to 400% when you copy original documents from the 
document glass or the ADF.

NOTE: 

• When you make a reduced copy, black lines may appear at the bottom of your copy.

1 Select the Output tab, and then select Reduce/Enlarge.

2 Select the desired setting, and then select OK.

• mm series

NOTE: 

• The value marked by an asterisk (*) is the factory default setting.

• inch series

NOTE: 

• You can also specify the value in increments of 1% from 25 to 400 by selecting  or  or entering a value using the 
number pad. See the following table for specific zoom ratios.

The method to load print media vary depends on the size and orientation of the print media, "Loading Print 
Media in the Standard 150 Sheet Tray" on page 96.

For print media that can be loaded, refer to "Usable Print Media" on page 95.

100%*

50%

70%

A4A5

81%

B5A5

122%

A5B5

141%

A5A4

200%

100%*

50%

64%

78%

8.5  14"8.5  11"

129%

154%

8.5  11"8.5  14"

200%

Copy

Original

A5 B5 A4

A5 100% 122% 141%

B5 81% 100% 115%

A4 70% 86% 100%
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Document Size
To select the default document size.

1 Select the Output tab, and then select Document Size.

2 Select the desired setting, and then select OK.

• mm series

NOTE: 

• The value marked by an asterisk (*) is the factory default setting.

• inch series

A4*

A5

B5

8.5 11"

8.5 13"

8.5 14"

7.25  10.5"

8.5 11"*

8.5 13"

8.5 14"

A4

A5

B5

7.25  10.5"
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N-Up
To copy two original images to fit into one sheet of paper.

1 Select the Output tab, and then select N-Up.

2 Select the desired setting, and then select OK.

NOTE: 

• The value marked by an asterisk (*) is the factory default setting.

When you are using the document glass and it is set to Auto or Manual, the display prompts you for another 
page after pressing the  (Start) button.

a If you want to place a new document, replace the document with a new document, and then select Scan 
Another Page or press the  (Start) button.

b If you finish copying, select Done. Print Now.

Off* Does not perform pages per sheet printing.

Auto Automatically reduces the original pages to fit into one sheet of paper.

Manual Prints the original pages into the one sheet of paper in the size specified in 
Reduce/Enlarge.

Auto:
Automatically 
reduces the 
pages to fit in 
one page.

Manual:
Reduces the pages in 
the custom size 
according to the setting 
of the Reduce / Enlarge 
menu.
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Edge Erase
To specify the top and bottom margins of the copy.

NOTE: 

• The value marked by an asterisk (*) is the factory default setting.

1 Select the Output tab.

2 Select  until Edge Erase appears, and then select Edge Erase.

3 Select  or , or use the number pad to enter the desired value.

Top / Bottom
(0  50 mm)
(0  2.0 inch)

4 mm* (0.2 inch*) Specify the value in increments of 1 mm (0.1 inch).

Left / Right
(0  50 mm)
(0  2.0 inch)

4 mm* (0.2 inch*) Specify the value in increments of 1 mm (0.1 inch).

Middle
(0  50 mm)
(0  2.0 inch)

0 mm* (0 inch*) Specify the value in increments of 1 mm (0.1 inch).
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Using the ID Card Copy

NOTE: 

• If the Service Lock setting for ID Card Copy is set to Locked, the ID Card Copy function is disabled and the menu is not 
displayed on the screen. For details, see "Service Lock" on page 236.

You can copy both sides of an ID card on one side of a single sheet of paper in its original size by selecting ID Card 
Copy on the touch panel. This feature helps to show both sides of an ID card in one page in its original size.

To make a copy:

1 Place an ID card facing down on the document glass, and close the document cover. 

For details about loading a document, see "Making Copies From the Document Glass" on page 128.

2 Press the  (Services Home) button.

3 Select ID Card Copy.

4 Specify the copy settings below as required.

• Output Color

• Lighten / Darken

• Sharpness

• Auto Background Suppression

See also: 

• "Setting Copy Options" on page 131

5 Press the  (Start) button to start copying.

After the front side of the ID card is scanned, the display prompts you to turn over the card.

To scan the back side of the ID card, turn the ID card over and select Scan Side 2.

NOTE: 

• Color copy is secured with a password if the Service Lock setting for Copy is set to Color Password Locked. If 
you set Output Color to Full Color and the Service Lock setting for Copy to Color Password Locked, you 
will need to enter the four digit password after pressing the  (Start) button. 
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Changing the Default Settings

The default settings of the Copy menu options such as Output Color and Lighten / Darken can be set to the 
most frequently used modes. When you copy a document, the specified default settings are used unless they are 
changed by using the operator panel.

1 Press the  (System) button.

2 Select the Tools tab.

3 Select Default Settings.

4 Select desired menu item.

5 Select the desired setting or enter the value using the number pad, and then select OK.

6 Repeat steps 4 and 5 as needed.

7 To return to the top level of the System menu, press the  (Clear All) button.
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• "Scanning Overview" on page 140

• "Scanning to a Computer" on page 141

• "Scanning to a Computer or Server via SMB/FTP" on page 145

• "Scanning to a USB Storage Device" on page 163

• "Sending an E-mail With the Scanned Image" on page 165

• "Adjusting Scanning Options" on page 168
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Scanning Overview

You can use your printer to turn pictures and text into editable images on your computer. 

The resolution setting to use when you scan an item depends on the item type and how you plan to use the image or 
document after you scan it into your computer. For the best results, use these recommended settings. 

Scanning beyond these recommended resolutions may exceed the capabilities of the application. If you require a 
recommended resolution mentioned in the above table, reduce the size of the image by previewing (or pre-scan) 
and crop it before scanning the image.

Scanning - From Computer
• To scan and export the scanned data to a graphic software application such as the Adobe® Photoshop® using 

the TWAIN driver, see "Scanning Using the TWAIN Driver" on page 143. This method is supported both on the 
Microsoft® Windows® and Mac OS X operating systems but requires a USB or network connection and a 
graphic software application.

• To scan and export the scanned data to Microsoft's program such as the Windows Photo Gallery and the 
Microsoft Paint, using the Windows Image Acquisition (WIA) driver, see "Scanning Using the Windows Image 
Acquisition (WIA) Driver" on page 144. This method is supported only on the Windows operating system and 
requires a USB or network (Web Services on Devices (WSD) only) connection.

Scanning - From Printer
• To scan and send the scanned data to a computer connected with a USB cable, see "Scanning From the 

Operator Panel - Scan to Application" on page 141. This method is supported both on the Windows and Mac 
OS X operating systems but requires a USB connection and the Express Scan Manager, a bundled software 
tool. The scanned data will be saved in the location on your computer that is specified on the Express Scan 
Manager.

• To scan and send the scanned data to a computer connected to a network via Web Services on Devices 
(WSD), see "Scanning From the Operator Panel - Scan to WSD (Web Services on Devices)" on page 141.

• To scan and send the scanned data to a computer or server connected to a network, see "Sending the 
Scanned File to the Network" on page 162.

• To scan and save the scanned data onto a USB storage device, see "Scanning to a USB Storage Device" on 
page 163.

• To scan and send the scanned data through e-mail, see "Sending an E-mail With the Scanned Image" on 
page 165. 

Type Resolution

Documents 300 dpi black-and-white or 200 dpi grayscale or color

Documents of poor quality or that contain small text 400 dpi black-and-white or 300 dpi grayscale

Photographs and pictures 100 – 200 dpi color or 200 dpi grayscale

Images for an inkjet printer 150 – 300 dpi

Images for a high-resolution printer 300 – 600 dpi
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Scanning to a Computer

Scanning From the Operator Panel - Scan to Application

NOTE: 

• Make sure that the printer is connected to the computer using the USB cable.

• You must use the Express Scan Manager on your computer to configure the output destination of the scanned image files. 

• This service is supported both on the Windows and Mac OS X operating systems.

1 Load the top edge of document(s) with facing up into the ADF or place a single document facing down on the 
document glass and close the document cover.

See also: 

• "Making Copies From the ADF" on page 130

• "Making Copies From the Document Glass" on page 128

2 Press the  (Services Home) button.

3 Select Scan To.

4 Select PC.

5 Configure the scanning settings as necessary.

6 Press the  (Start) button.

A scanned image file is saved to the location you have specified.

NOTE: 

• If the window to select the program appears on your computer, select Express Scan Manager-Ctype, and then click 
OK.

• File type of scanned data varies depending on application on computer. 

See also: 
• "Express Scan Manager" on page 43

Scanning From the Operator Panel - Scan to WSD (Web Services 
on Devices)

If the printer is connected to a computer via network using Web Services on Devices (WSD), you can use the Scan 
to WSD (Web Services on Devices) function to send scanned images to a computer.

NOTE: 

• To use Scan to WSD (Web Services on Devices), you need to setup connection using Web Services on Devices (WSD).

• Web Services on Devices (WSD) is supported only on Windows Vista®, Windows Server® 2008, Windows 7, Windows Server 
2008 R2, Windows 8, Windows Server 2012, Windows 8.1, and Windows Server 2012 R2.

Printer Setup for Scan to WSD (Web Services on Devices)
Setup the printer and computer for connection using Web Services on Devices (WSD).

• Checking the Printer Setting
To use the Scan to WSD (Web Services on Devices) function, WSD (Web Services on Devices) needs to be set to 
Enable. For details, see "Protocols" on page 219.
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• Setting Up the Computer

NOTE: 

• For Windows 8, Windows Server 2012, Windows 8.1, and Windows Server 2012 R2, a computer automatically connects the 
printer using Web Services on Devices (WSD). There is no need to install the printer manually.

For Windows 7 and Windows Server 2008 R2:

1 Click Start  Computer  Network.

2 Right-click the icon for the printer, and then click Install.

The printer is connected by Web Services on Devices (WSD).

For Windows Vista and Windows Server 2008:

1 Click Start  Network.

2 Right-click the icon for the printer, and then click Install.

3 Click Continue.

The printer is connected by Web Services on Devices (WSD).

Procedures for WSD (Web Services on Devices) Scan

1 Load the document(s) facing up with top edge in first into the ADF or place a single document facing down on 
the document glass.

See also: 

• "Making Copies From the ADF" on page 130

• "Making Copies From the Document Glass" on page 128

2 Press the  (Services Home) button.

3 Select Scan To.

4 Select WSD (Web Services on Devices).

5 Select  until the desired computer you want to send the scan job to appear, and then select that computer.

6 Select Event, and specify the type of scan.

Available types:

• Scan

• ScanToPrint

• ScanToEmail

• ScanToFax

• ScanToOCR

7 Press the  (Start) button.
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Scanning Using the TWAIN Driver
Your printer supports the Tool Without An Interesting Name (TWAIN) driver for scanning images. TWAIN is one of 
the standard components provided by Windows Server 2003, Windows Vista, Windows Server 2008, Windows 
Server 2008 R2, Windows 7, Windows 8, Windows Server 2012, Windows 8.1, Windows Server 2012 R2, Mac OS X 
10.5, Mac OS X 10.6, Mac OS X 10.7, OS X 10.8, OS X 10.9, and works with various scanners. 

The following procedure uses Windows 7 as an example.

NOTE: 

• Make sure that the printer is connected to the computer with a USB cable or to a network.

The following procedure to scan an image uses Microsoft Clip Organizer as an example.

1 Load the top edge of document(s) with facing up into the ADF or place a single document facing down on the 
document glass and close the document cover.

See also: 

• "Making Copies From the ADF" on page 130

• "Making Copies From the Document Glass" on page 128

2 Click Start  All Programs  Microsoft Office  Microsoft Office 2010 Tools  Microsoft Clip Organizer.

3 Click File  Add Clips to Organizer  From Scanner or Camera.

4 In the Insert Picture from Scanner or Camera window, under Device, select your TWAIN device.

5 Click Custom Insert.

6 Select your scanning preferences and click Preview to display the preview image.

NOTE: 

• Preview is grayed out and disabled when you select Document Feeder Tray from Scan From.

• File type of scanned data vary depending on application on computer.

7 Select the desired properties from the Image Quality and Image Options tabs.

8 Click Scan to start scanning.

The scanned image file is generated.
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Scanning Using the Windows Image Acquisition (WIA) Driver
Your printer also supports the Windows Image Acquisition (WIA) driver for scanning images. Windows Image 
Acquisition (WIA) is one of the standard components provided by Windows operating systems and works with digital 
cameras and scanners. Unlike the TWAIN driver, the Windows Image Acquisition (WIA) driver allows you to scan an 
image and easily manipulate those images without using additional software.

The following procedure uses Windows 7 as an example.

NOTE: 

• Make sure that the printer is connected to the computer using the USB cable.

1 Load the top edge of document(s) with facing up into the ADF or place a single document facing down on the 
document glass and close the document cover.

See also: 

• "Making Copies From the ADF" on page 130

• "Making Copies From the Document Glass" on page 128

2 Start the drawing software, such as Paint for Windows.

NOTE: 

• When you use Windows Vista or Windows Server 2008, use Windows Photo Gallery instead of Paint.

3 Click the Paint button  From scanner or camera.

The WIA (Windows Image Acquisition) window appears.

4 Select your scanning preferences and click Adjust the quality of the scanned picture to display the 
Advanced Properties window.

5 Select the desired properties including brightness and contrast, and then click OK.

6 Click Scan to start scanning.

7 Click the Paint button  Save as.

8 Enter a picture name, and select a file format and destination to save the picture.
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Scanning to a Computer or Server via SMB/FTP

Overview
The Scan to Server/Computer feature allows you to scan documents and send the scanned document to a network 
computer via the FTP or SMB protocol. 

You can select the kind of the server and specify a destination to store the scanned document with the CentreWare 
Internet Services or the Address Book Editor.

The following items are required to use the Scan to Server/Computer feature.

• Using SMB

To transfer data via SMB, your computer must run on one of the following operating systems that includes 
folder sharing.

For Mac OS X, a shared user account is required on the Mac OS X.

• Windows Server 2003

• Windows Server 2008

• Windows Server 2008 R2

• Windows Server 2012

• Windows Server 2012 R2

• Windows Vista

• Windows 7

• Windows 8

• Windows 8.1

• Mac OS X 10.5

• Mac OS X 10.6

• Mac OS X 10.7

• OS X 10.8

• OS X 10.9

Scan
Using FTP

Using SMB

FTP Server

Computer

Computer
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• Using FTP

To transfer data via FTP, one of the following FTP servers and an account to the FTP server (login name and 
password) are required.

• Windows Vista, Windows 7, Windows Server 2003, Windows Server 2008, and Windows Server 2008 R2

FTP service of Microsoft Internet Information Services 6.0

• Windows 8 and Windows Server 2012

FTP service of Microsoft Internet Information Services 8.0

• Windows 8.1 and Windows Server 2012 R2

FTP service of Microsoft Internet Information Services 8.5

• Mac OS X 10.5, Mac OS X 10.6, Mac OS X 10.7, OS X 10.8, and OS X 10.9

FTP service of Mac OS X

For information on how to configure the FTP service, contact your system administrator.

Follow the procedure below to use the Scan to Server/Computer feature.

Confirming a Login Name and Password

When Using SMB
The Scan to Computer/Server feature requires a user login account with a valid and non-empty password for 
authentication. Confirm a login user name and password.

If you do not use a password for your user login, you need to create a password for your user login account with the 
following procedure.

"Confirming a Login Name and Password" on page 146

"Specifying a Destination to Store the Document" on page 148

"Configuring the Printer Settings" on page 156

"Sending the Scanned File to the Network" on page 162
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• For Windows Server 2003:

1 Click Start  Administrative Tools  Computer Management.

2 Click Local Users and Groups.

3 Double-click Users.

4 Right-click your account, and then select Set Password.

NOTE: 

• When an alert message appears, confirm the message and then click Proceed.

5 Add in a password for your user login account.

• For Windows Vista and Windows 7:

1 Click Start  Control Panel.

2 Click User Accounts and Family Safety.

3 Click User Accounts.

4 Click Create a password for your account and add in a password for your user login account.

• For Windows Server 2008 and Windows Server 2008 R2:

1 Click Start  Control Panel.

2 Click User Accounts.

3 Click User Accounts.

4 Click Create a password for your account and add in a password for your user login account.

• For Windows 8 and Windows Server 2012:

1 Place the mouse pointer in the upper right corner of the screen and move the mouse down, and then select 
Settings  Change PC settings.

2 Click Users.

3 Click Create a password and add in a password for your user login account.

• For Windows 8.1 and Windows Server 2012 R2:

1 Place the mouse pointer in the upper right corner of the screen and move the mouse down, and then select 
Settings  Change PC settings.

2 Click Accounts  Sign-in options.

3 Click Add under Password, and add in a password for your user login account.
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• For Mac OS X 10.5 and Mac OS X 10.6:

1 Click System Preferences  Accounts.

2 Select your account.

3 Select Change Password.

4 Enter a password for your user login account in New Password (New password for Mac OS X 10.6).

5 Re-enter the password in Verify.

6 Click Change Password.

• For Mac OS X 10.7, OS X 10.8, and OS X 10.9:

1 Click System Preferences  Users & Groups.

2 Select your account.

3 Select Change Password.

4 Enter a password for your user login account in New password.

5 Re-enter the password in Verify.

6 Click Change Password.

After you confirmed a login user name and password, see "Specifying a Destination to Store the Document" on 
page 148.

When Using FTP
The Scan to Computer/Server feature requires a user name and a password. For your user name and password, 
contact your system administrator.

Specifying a Destination to Store the Document

When Using SMB
Share a folder to store the scanned document using the following procedure.
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• For Windows Server 2003:

1 Create a folder in the desired directory on your computer (Example of folder name, MyShare).

2 Right-click the folder, and then select Properties.

3 Click the Sharing tab, and then select Share this folder.

4 Enter a shared name in the Share name box.

NOTE: 

• Note down the shared name as you need to use this name in the next setting procedure.

5 Click Permissions to give write permission for this folder.

6 Click Add.

7 Search user login name by clicking Advanced, or enter the user login name in the Enter the object names to 
select box and click Check Names to confirm (Example of user login name, MySelf).

8 Click OK.
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9 Click the user login name that you have just entered. Select the Full Control check box. This will grant you 
permission to send the document to this folder.

NOTE: 

• Do not use Everyone as the user login name.

10 Click OK.

11 Configure other settings as necessary, and then click Apply and click OK.

NOTE: 

• To add sub-folders, create new folders in the shared folder you have created.
Example: Folder name: MyShare, Second-level folder name: MyPic, Third-level folder name: John
You should now see MyShare\MyPic\John in your directory.

After you created a folder, see "Configuring the Printer Settings" on page 156.



Scanning 151

• For Windows Vista, Windows 7, Windows Server 2008, and Windows Server 2008 
R2:

1 Create a folder in the desired directory on your computer (Example of folder name, MyShare).

2 Right-click the folder, and then select Properties.

3 Click the Sharing tab, and then select Advanced Sharing.

For Windows Vista, when User Account Control window appears, click Continue.

4 Select the Share this folder check box.

5 Enter a shared name in the Share name box.

NOTE: 

• Note down the shared name as you need to use this name in the next setting procedure.

6 Click Permissions to give write permission for this folder.

7 Click Add.
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8 Search user login name by clicking Advanced, or enter the user login name in the Enter the object names to 
select box and click Check Names to confirm (Example of user login name, MySelf).

9 Click OK.

10 Click the user login name that you have just entered. Select the Full Control check box. This will grant you 
permission to send the document to this folder.

NOTE: 

• Do not use Everyone as the user login name.

11 Click OK.

12 Click OK to exit the Advanced Sharing window.

13 Click Close.

NOTE: 

• To add sub-folders, create new folders in the shared folder you have created.
Example: Folder name: MyShare, Second-level folder name: MyPic, Third-level folder name: John
You should now see MyShare\MyPic\John in your directory.

After you created a folder, see "Configuring the Printer Settings" on page 156.
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• For Windows 8, Windows 8.1, Windows Server 2012, and Windows Server 2012 
R2:

1 Create a folder in the desired directory on your computer (Example of folder name: MyShare).

2 Right-click the folder, and then select Properties.

3 Click the Sharing tab, and then click Advanced Sharing.

4 Select the Share this folder check box.

5 Enter a shared name in the Share name box.

NOTE: 

• Note down the shared name as you need to use this name in the next setting procedure.

6 Click Permissions to create a write permission for this folder.

7 Click Add.
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8 Search user login name by clicking Advanced, or enter the user login name in the Enter the object names to 
select box and click Check Names to confirm (Example of user login name: MySelf).

9 Click OK.

10 Click the user login name that you have just entered. Select the Full Control check box. This will grant you 
permission to send the document into this folder.

NOTE: 

• Do not use Everyone as the user login name.

11 Click OK.

12 Click OK to exit the Advanced Sharing dialog box.

13 Click Close.

NOTE: 

• To add sub-folders, create new folders in the shared folder you have created.
Example: Folder name: MyShare, Second-level folder name: MyPic, Third-level folder name: John
You should now see MyShare\MyPic\John in your directory.

After you created a folder, see "Configuring the Printer Settings" on page 156.
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• For Mac OS X 10.5 and Mac OS X 10.6:

1 Create a folder in the desired directory on your computer (Example of folder name, MyShare).

NOTE: 

• Note down the folder name as you need to use this name in the next setting procedure.

2 Select the created folder, and then select Get Info from the File menu.

3 Select the Shared Folder (Shared folder for Mac OS X 10.6) check box, and then close the window.

4 Open System Preferences, and then click Sharing.

5 Select the File Sharing check box, and then click Options.

6 Select the Share files and folders using SMB (Share files and folders using SMB (Windows) for Mac OS 
X 10.6) check box and your account name.

7 Enter your account password, and then click OK.

8 Click Done.

• For Mac OS X 10.7, OS X 10.8, and OS X 10.9:

1 Create a folder in the desired directory on your computer (Example of folder name, MyShare).

NOTE: 

• Note down the folder name as you need to use this name in the next setting procedure.

2 Select the created folder, and then select Get Info from the File menu.

3 Select the Shared folder check box, and then close the window.

4 Open System Preferences, and then click Sharing.

5 Select the File Sharing check box, and then click Options.

6 Select the Share files and folders using SMB check box and your account name.

7 Enter your account password, and then click OK.

8 Click Done.

When Using FTP
For a destination to store the document, contact your system administrator.
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Configuring the Printer Settings
You can configure the printer settings to use the Scan to Server/Computer feature with the CentreWare Internet 
Services or Address Book Editor.

From the CentreWare Internet Services

1 Launch your web browser.

2 Enter the IP address of the printer in the address bar, and then press the Enter key.

The printer's web page appears.

NOTE: 

• For details on how to check the IP address of the printer, see "Verifying the IP Settings" on page 59.

3 Click the Address Book tab.

If user name and password are required, enter the correct user name and password.

NOTE: 

• The default User ID and password are 11111 and x-admin respectively.

4 Click Computer/Server Address Book under Network Scan (Comp./Serv.).
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5 Select any unused number and click Add.

The Add Network Scan Address page appears.

9

8

7

6

5

4

3

2

1
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6 To fill in the fields, enter the information as follows: 

7 Click Apply.

After you configured settings, see "Sending the Scanned File to the Network" on page 162.

1 Name (Displayed on Printer) Enter a friendly name that you want it to appear on the Address Book.

2 Network Type Select Server FTP if you use a FTP server.

Select Computer SMB if you store the document in a shared folder of your 
computer.

3 Host Address (IP Address or 
DNS Name)

Enter a server name or IP address of your computer or the FTP server that 
you have shared out.

The following are examples:

• For Server FTP:

Server name: myhost.example.com

(myhost: host name, example.com: domain name)

IP address: 192.0.2.0

• For Computer SMB:

Server name: myhost

IP address: 192.0.2.0

4 Port Number Enter the server port number. If you are unsure, you can enter the default 
value of 21 for FTP and 139 for SMB.

5 Login Name (if required by 
host)

Enter the user account name that has access to the shared folder on your 
computer or FTP server.

6 Login Password Enter the password corresponding to the above login name.

NOTE: 

• Empty password is not valid in the Scan to Computer feature. Make sure 
that you have a valid password for the user login account. (See 
"Confirming a Login Name and Password" on page 146 for details on how 
to add a password in your user login account.)

7 Re-enter Password Re-enter your password.

8 Name of Shared Directory For Computer SMB only.

On the Windows operating system, enter the share name of the folder to store 
the scanned document on the recipient computer.

On the Mac OS X, enter the folder name to store the scanned document on 
the recipient computer.

9 Subdirectory Path (optional) For Computer SMB

To store the scanned document in the share folder directly without creating 
any subfolder, leave the space blank.

To store the scanned document in the folder you created under the share 
folder, enter the path as following.

Example: Share Folder name: MyShare, Second-level folder name: MyPic, 
Third-level folder name: John

You should now see MyShare\MyPic\John in your directory.

In this case, enter the following item.

Server Path: \MyPic\John

For Server FTP

Enter the server path to store the scanned document.

MyShare (Share folder)

MyPic

John
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From the Address Book Editor
The following procedure uses Windows 7 as an example.

1 Click Start  All Programs  Fuji Xerox  Fuji Xerox Printer Software for Asia-Pacific  your printer  
Address Book Editor.

NOTE: 

• The window to select a printer appears in this step when multiple print drivers are installed on your computer. In this 
case, click the name of the desired printer listed in Device Name.

• The Enter Password window appears when Panel Lock Set is set to Enable. In this case, enter the password you 
specified, and click OK.

2 Click OK on the "Retrieval Successful" message window.

3 Click Tool  New (Device Address Book)  Server.
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The Server Address window appears.

4 To fill in the fields, enter the information as follows: 

1 Name Enter a friendly name that you want it to appear on the Address Book.

2 Server Type Select Computer if you store the document in a shared folder of your 
computer. 

Select Server if you use a FTP server.

3 Computer Settings wizard For Computer only.

Clicking this button opens the wizard screen which guides you through several 
steps.

When you complete the steps in the wizard, the settings for Server Address 
are automatically configured. For details, click Help.

4 Server Name / IP Address Enter a server name or IP address of your computer or the FTP server that 
you have shared out.

The following are examples:

• For Computer:

Server name: myhost

IP address: 192.0.2.0

• For Server:

Server name: myhost.example.com

(myhost: host name, example.com: domain name)

IP address: 192.0.2.0

5 Share Name For Computer only.

Enter the name of the shared folder on the recipient computer. 

9

10

8

7

6

5

4

3

2

1
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5 Click OK.

6 Click the Save All icon on the toolbar.

After you configured settings, see "Sending the Scanned File to the Network" on page 162.

6 Path For Computer

To store the scanned document in the share folder directly without creating 
any subfolder, leave the space blank.

To store the scanned document in the folder you created under the share 
folder, enter the path as following.

Example: Share Folder name: MyShare, Second-level folder name: MyPic, 
Third-level folder name: John

You should now see MyShare\MyPic\John in your directory.

In this case, enter the following item.

Path: \MyPic\John

For Server

Enter the path to store the scanned document.

7 Login Name Enter the user account name that has access to the shared folder on your 
computer or FTP server.

8 Login Password Enter the password corresponding to the above login name.

NOTE: 

• Empty password is not valid in the Scan to Server/Computer feature. Make 
sure that you have a valid password for the user login account. (See 
"Confirming a Login Name and Password" on page 146 for details on how 
to add a password in your user login account).

9 Confirm Login Password Re-enter your password.

10 Port Number Enter the port number. If you are unsure, you can enter the default value of 
139 for SMB and 21 for FTP.

MyShare (Share folder)

MyPic

John
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Sending the Scanned File to the Network

1 Load the document(s) facing up with top edge in first into the ADF or place a single document facing down on 
the document glass.

See also: 

• "Making Copies From the ADF" on page 130

• "Making Copies From the Document Glass" on page 128

2 Press the  (Services Home) button.

3 Select Scan To.

4 Select Network.

5 Select  until the desired address appears and then select that address.

6 Select OK.

7 Select scanning options as required.

For details, see "Scan Defaults" on page 244.

8 Press the  (Start) button to send the scanned files.

When you are using the document glass, the display prompts you for another page. Select Scan Another 
Page or Done. Upload Now.

If you want to place a new document, replace the document with a new document, and then select Scan 
Another Page.
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Scanning to a USB Storage Device

The Scan To USB feature allows you to scan documents and save the scanned data to a USB storage device. To 
scan documents and save them, follow the steps below: 

1 Load the top edge of document(s) first with facing up into the ADF or place a single document facing down on 
the document glass and close the document cover.

See also: 

• "Making Copies From the ADF" on page 130

• "Making Copies From the Document Glass" on page 128

2 Press the  (Services Home) button. 

3 Insert the USB storage device into the USB drive of the printer.

NOTE: 

• If the USB Drive Detected menu appears, select Scan To USB, and proceed to step 6.

4 Select Scan To.

5 Select USB Memory.

6 Select scanning options as required. For details, see "Scan Defaults" on page 244.

You can also specify the folder to save the scanned image. For details, see "Specifying a Folder to Save the 
Scanned Image" on page 164.

7 Press the  (Start) button.

When you are using the document glass, the display prompts you for another page. Select Scan Another 
Page or Done. Save Now.

If you want to place a new document, replace the document with a new document, and then select Scan 
Another Page.

8 Remove the USB storage device from the printer.

IMPORTANT: 

• Before removing the USB storage device, ensure that the printer is not accessing the USB storage device. If you remove 
the USB storage device while the printer is accessing, the data in the USB storage device or the USB storage device 
itself may be damaged.
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Specifying a Folder to Save the Scanned Image
To save the scanned image to a folder in the USB storage device, specify the folder before executing the scan job.

1 Select Change Folder on the Scan To USB tab.

2 Select a folder to save the scanned image.

NOTE: 

• The default saving location is the root directory of the USB storage device.

• You cannot directly enter a folder path using the number pad.

• You can select any folder in the USB storage device but cannot create a new folder in this step. You should always 
create a new folder before connecting the storage device to the printer.

If you want the printer to automatically create a folder and then save the scanned image to that folder, set Create 
Folder to On. For details, see "Create Folder" on page 247.

If the name of the scanned image has already existed in the folder, the printer automatically generates a new 
file name to save the data.
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Sending an E-mail With the Scanned Image

To send an e-mail attached with the scanned image from your printer, follow the steps below:

• Set up your SMTP (Simple Mail Transfer Protocol) server information. SMTP is a protocol for sending e-mail. 
Refer to the Setup Guide for more details.

• Set up the E-mail Address Book through the CentreWare Internet Services. For details, see "Setting an E-mail 
Address Book" on page 165.

Setting an E-mail Address Book

1 Launch your web browser.

2 Enter the IP address of the printer in the address bar, and then press the Enter key.

The printer's web page appears.

NOTE: 

• For details on how to check the IP address of the printer, see "Verifying the IP Settings" on page 59.

3 Click the Address Book tab.

If user name and password are required, enter the correct user name and password.

NOTE: 

• The default User ID and password are 11111 and x-admin respectively.

4 Click Personal Address under Fax / E-mail.
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5 Select any unused number and click Add.

The Add Personal Address page appears.

6 Enter a name in the Name field and an e-mail address in the E-mail Address field.

7 Click Apply.
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Sending an E-mail With the Scanned File

1 Load the document(s) facing up with top edge in first into the ADF or place a single document facing down on 
the document glass.

See also: 

• "Making Copies From the ADF" on page 130

• "Making Copies From the Document Glass" on page 128

2 Press the  (Services Home) button.

3 Select E-mail.

4 Specify a recipient from the following, and then select OK.

New Recipient: Enter an e-mail address directly.

Address Book: Select from the following types of address books.

• Device Address Book - Individuals: Select the e-mail address registered in the address book.

• Device Address Book - Groups: Select the e-mail group registered in the address book.

• Search Network Address Book: Search the e-mail address from the LDAP server address book.

Select the recipient you specified by New Recipient to remove or edit the recipient.

Select the recipient you specified from Address Book to remove or see details of the recipient. You can also 
change the e-mail to Bcc.

NOTE: 

• Users need to be registered in the E-mail address book before you can select Address Book on the operator panel.

• For more information on address book and server address book, see "Address Book Editor" on page 42.

• If you are using the LDAP server address book, Email Server Address Book must be set to On. 
For details, see "E-mail Server Address Book" on page 230.

5 Select scanning options as required. For details, see "Scan Defaults" on page 244.

6 Press the  (Start) button to send e-mail.

When you are using the document glass, the display prompts you for another page. Select Scan Another 
Page or Done. Send Now.

If you want to place a new document, replace the document with a new document, and then select Scan 
Another Page.
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Adjusting Scanning Options

Adjusting the Default Scan Settings
For a complete list of all of the defaults settings, see "Defaults Settings" on page 239.

Setting the Scanned Image File Type
To specify the file type of the scanned image:

1 Press the  (System) button.

2 Select the Tools tab, and then select Default Settings.

3 Select Scan Defaults.

4 Select File Format.

5 Select the type, and then select OK.

Available types:

• PDF (factory default)

• Multi-Page TIFF

• TIFF

• JPEG

Setting the Color Mode
You can scan an image in color or in black and white. Selecting black and white significantly reduces the file size of 
the scanned images. An image scanned in color will have a larger file size than the same image scanned in black 
and white.

1 Press the  (System) button.

2 Select the Tools tab, and then select Default Settings.

3 Select Scan Defaults.

4 Select Output Color.

5 Change the color setting to Color, Black & White or Gray Scale, and then select OK.

NOTE: 

• The Black & White mode is available only when File Format is set to PDF or TIFF.
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Setting the Scan Resolution
You may want to change the scan resolution depending on the way you plan to use the scanned image. Scan 
resolution affects both the size and image quality of the scanned image file. The higher the scan resolution, the 
larger the file size.

To select the scan resolution:

1 Press the  (System) button.

2 Select the Tools tab, and then select Default Settings.

3 Select Scan Defaults.

4 Select Resolution.

5 Select one of the following options, and then select OK:

• 200dpi: Produces the lowest resolution and smallest file size. (factory default)

• 300dpi: Produces medium resolution and a medium file size.

• 400dpi: Produces high resolution and a large file size.

• 600dpi: Produces the highest resolution and largest file size.

Setting the Original Size
To specify the size of the original:

1 Press the  (System) button.

2 Select the Tools tab, and then select Default Settings.

3 Select Scan Defaults.

4 Select Original Size, and then select OK.

5 Select a specific paper size to determine the area to be scanned, and then select OK.

The factory default setting is A4 (210  297mm).

Automatically Suppressing Background Variations
When scanning document has light gray background such as newspapers, the printer automatically can detect the 
background and whiten it when outputting the image.

To turn on/off automatic suppression:

1 Press the  (System) button.

2 Select the Tools tab, and then select Default Settings.

3 Select Scan Defaults.

4 Select Auto Background Suppression.

5 Select either On or Off, and then select OK.

The factory default setting is On.
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Changing the Scan Settings Options
Use the scan options to configure a variety of scanner features when scanning to a Network, PC, or USB storage 
device.

• Scan To Network / Scan To PC / Scan To USB Tab

You can set the basic options of the scan such as Output Color, Resolution, and File Format.

• Quality Tab

You can set the options concerning image quality such as Lighten / Darken, Sharpness and Auto 
Background Suppression.

• Options Tab

You can set other options for the scan such as Original Size and Edge Erase.

To temporarily change a scan setting when sending a scanned image by e-mail:

1 Press the  (Services Home) button.

2 Select E-mail.

3 Select scan options on the Quality and Options tabs.

4 Change the selected setting, and then select OK.

5 Press the  (Start) button to begin the scan.

To temporarily change a scan setting when scanning to a computer:

1 Press the  (Services Home) button.

2 Select Scan To.

3 Select the scan destination.

4 Select scan options on the Scan To PC, Quality and Options tabs.

5 Change the selected setting, and then select OK.

6 Press the  (Start) button to begin the scan.
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Connecting the Telephone Line

IMPORTANT: 

• PTC 200 warning

General warning 

The grant of a Telepermit for any item of terminal equipment indicates only that Telecom has accepted that the 
item complies with minimum conditions for connection to its network. It indicates no endorsement of the 
product by Telecom, nor does it provide any sort of warranty. Above all, it provides no assurance that any item 
will work correctly in all respects with another item of Telepermitted equipment of a different make or model, nor 
does it imply that any product is compatible with all of Telecom's network services Warnings taken from 
Specification text

2.11.1 Compliance testing (6) & (7) (Functional tests)

"This equipment is not capable, under all operating conditions, of correct operation at the higher speeds for 
which it is designed. Telecom will accept no responsibility should difficulties arise in such circumstances"

4.5.1 Off-hook line impedance

(4) "This equipment does not fully meet Telecom's impedance requirements. Performance limitations may 
occur when used in conjunction with some parts of the network. Telecom will accept no responsibility should 
difficulties arise in such circumstances"

4.9.3 Non-voice equipment

(4) "This equipment is not capable, under all operating conditions, of correct at the higher speeds for which it is 
designed. Telecom will accept no responsibility should difficulties arise in such circumstances"

5.6.1 General requirements (automatic dialling devices)

(3) "This equipment shall not be set up to make automatic calls to the Telecom '111' Emergency Service

5.5.5 User instructions

(4) If a charge for local calls is unacceptable, the 'Dial' button should NOT be used for local calls. Only the 
7-digits of the local number should be dialled from your telephone. DO NOT dial the area code digit or the '0' 
prefix

8.1.7 User Instructions (automatic call set-up)

(b) This equipment shall not be set up to make automatic calls to the Telecom '111' Emergency Service

8.2.1(b) Call answering

When this equipment is set up call answering not within 3~30 sets., the telephone or answering machine shall 
answer incoming call with 3~30sec.

NOTE: 

• Do not connect your printer directly to a DSL (digital subscriber line). This may damage the printer. To use a DSL, you will 
need to use an appropriate DSL filter. Contact your service provider for the DSL filter.
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1 Plug one end of a telephone line cord to the wall jack connector and the other end to an active wall jack.

2 To connect a telephone and/or answering machine to your printer, plug the telephone or answering machine 
line cord into the phone connector ( ).

Wall jack connector

To the wall jack

Phone connector

To an external telephone 
or answering machine
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Configuring Fax Initial Settings

NOTE: 

• The following settings can be configured also using Fax Setup on the FX Printer Installation screen which is launched from 
the Software Pack CD-ROM.

Setting Your Region
You need to set the region where your printer is used for using the fax service on the printer.

1 Press the  (System) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select Fax Settings.

4 Select Fax Line Settings.

5 Select Region.

6 Select the region where the printer is used, and then select OK.

7 Select Yes, Save.

The printer restarts automatically to apply the settings.

NOTE: 

• When you configure the region setting, the information, which is registered to the device, is initialized.

Setting the Printer ID
You may be required to indicate your fax number on any fax you send. The printer ID, containing your telephone 
number and name or company name, will be printed at the top of each page sent from your printer.

1 Press the  (System) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select Fax Settings.

4 Select Fax Line Settings.

5 Select Fax Number.

6 Enter your fax number using the number pad.

NOTE: 

• If you make a mistake while entering numbers, press the C (Clear) button to delete the last digit.

7 Select OK when the number on the display is correct.

8 Select Company Name.

9 Enter your name or company name using the keyboard.

10 Select OK when the name on the display is correct.

To return to the top level of the System menu, press the  (Clear All) button.
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Setting the Time and Date

NOTE: 

• It may be necessary to reset the correct time and date if loss of power to the printer occurs.

1 Press the  (System) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select System Settings.

4 Select General.

5 Select Date & Time.

6 Select Time Zone.

7 Select the desired time zone, and then select OK.

8 Select Date.

9 Enter the correct date using the number pad, or select the correct date using the  or  button.

NOTE: 

• If you make a mistake while entering numbers, press the C (Clear) button to delete the last digit.

10 Select OK when the date on the display is correct.

11 Select Time.

12 Enter the correct time using the number pad.

13 Select OK when the time on the display is correct.

To return to the top level of the System menu, press the  (Clear All) button.

Changing the Clock Mode
You can set the current time using either the 12-hour or the 24-hour format.

1 Press the  (System) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select System Settings.

4 Select General.

5 Select Date & Time.

6 Select Time.

7 Select the desired format, and then select OK.

To return to the top level of the System menu, press the  (Clear All) button.
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Sending a Fax

Loading an Original Document on the ADF

IMPORTANT: 

• Do not load more than 15 sheets into the automatic document feeder (ADF) or allow more than 15 sheets to be fed to the 
document output tray. The document output tray should be emptied before it exceeds 15 sheets or your original documents 
may be damaged.

NOTE: 

• To get the best scan quality, especially for gray scale images, use the document glass instead of the ADF.

• You cannot load the following documents in the ADF. Be sure to place them on the document glass.

1 Place the document(s) facing up on the ADF with the top edge of the documents in first. Then adjust the 
document guides to the correct document size.

2 Adjust the document resolution, referring to "Resolution" on page 178.

Curled originals Pre-punched paper

Lightweight originals Folded, creased or torn originals

Cut and paste originals Carbon paper
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Loading an Original Document on the Document Glass

1 Open the document cover.

2 Place the document facing down on the document glass and align it with the registration guide on the top left 
corner of the document glass.

3 Adjust the document resolution, referring to "Resolution" on page 178.

4 Close the document cover.

NOTE: 

• Make sure that no document is in the ADF. If any document is detected in the ADF, it takes priority over the document on the 
document glass. 

• If you are faxing a page from a book or magazine, lift the document cover until its hinges are caught by the stopper and then 
close the document cover. If the book or magazine is thicker than 20 mm, start faxing with the document cover open.

CAUTION:

• Do not apply excessive force to hold thick document on the document glass. It may break the glass and cause 
injuries.
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Lighten / Darken
To adjust the contrast to make the fax lighter or darker than the original:

1 Press the  (Services Home) button.

2 Select Fax.

3 Select Lighten / Darken.

4 Select the desired setting, and then select OK.

NOTE: 

• The value marked by an asterisk (*) is the factory default setting.

Resolution
To specify the resolution level to be used for fax transmission:

1 Press the  (Services Home) button.

2 Select Fax.

3 Select Resolution.

4 Select the desired setting, and then select OK.

NOTE: 

• The value marked by an asterisk (*) is the factory default setting.

NOTE: 

• Faxes scanned in the Super Fine mode transmit at the highest resolution supported by the receiving device. 

Lighten2 Makes the fax lighter than the original. Works well with dark print.

Lighten1

Normal * Works well with normal typed or printed documents.

Darken1 Makes the fax darker than the original. Works well with light print or faint pencil 
markings.Darken2

Standard * Suitable for documents with normal sized characters.

Fine Suitable for documents containing small characters or thin lines or documents 
printed using a dot-matrix printer.

Super Fine Suitable for documents containing extremely fine detail. The Super Fine mode 
is enabled only if the remote machine also supports the super fine resolution.

Ultra Fine Suitable for documents containing photographic images.
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Original Type
To select the default document type for the current fax job:

1 Press the  (Services Home) button.

2 Select Fax.

3 Select Original Type.

4 Select the desired setting, and then select OK.

NOTE: 

• The value marked by an asterisk (*) is the factory default setting.

 Inserting a Pause
For some telephone systems, it is necessary to dial an access code and listen for a second dial tone. A pause must 
be entered in order for the access code to function. For example, enter the access code 9 and then press the Redial 
/ Pause button before entering the telephone number. "-" appears on the touch panel to indicate when a pause is 
entered.

Text * Suitable for documents with text.

Photo Suitable for documents with photos.
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Sending a Fax Automatically

1 Load the document(s) facing up with top edge in first into the ADF or place a single document facing down on 
the document glass and close the document cover.

See also: 

• "Loading an Original Document on the ADF" on page 176

• "Loading an Original Document on the Document Glass" on page 177

2 Press the  (Services Home) button.

3 Select Fax.

4 Adjust the document resolution to suit your fax documents.

See also: 

• "Resolution" on page 178

• "Inserting a Pause" on page 179

5 Select a fax number in one of the following ways:

• Select  , and then select one of the following:

Device Address Book - Individuals - Select an individual fax number and then select OK.

Device Address Book - Groups - Select a group dial number and then select OK.

Search Network Address Book - Search and select a fax number from the LDAP server and then 
select OK.

• Select  .

Enter the speed dial number using the number pad, and then select  .

NOTE: 

• For more information on address book and server address book, see "Address Book" on page 195.

• The fax number needs to be registered before you can select Address Book.

6 Press the  (Start) button.

When the document is placed on the document glass, the display prompts you for another page. If you want to 
place a new document, replace the document with a new document, and then select Scan Another Page. 
When you have finished loading documents, select Done. Fax Now.

The printer starts dialing the number, and then sending the fax when the remote fax machine is ready.

NOTE: 

• Press the  (Stop) button to cancel the fax job at any time while sending the fax.
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Sending a Fax Manually

1 Load the document(s) facing up with top edge in first into the ADF or place a single document facing down on 
the document glass and close the document cover.

See also: 

• "Loading an Original Document on the ADF" on page 176

• "Loading an Original Document on the Document Glass" on page 177

2 Press the  (Services Home) button.

3 Select Fax.

4 Adjust the document resolution to suit your fax needs.

See also: 

• "Resolution" on page 178

• "Inserting a Pause" on page 179

5 Select OnHook, and then select Manual Send.

6 Enter the remote fax machine's fax number using the number pad.

You can also select the recipient by using speed dial number or address book.

See also: 

• "Automatic Redialing" on page 181

NOTE: 

• You can enter a fax number using the ten key, *, and #.

• Pressing the Redial / Pause button enables you to enter a pause in the fax number.

7 Press the  (Start) button.

NOTE: 

• Press the  (Stop) button to cancel the fax job at any time while sending the fax.

Confirming Transmissions 
When the last page of your document has been sent successfully, the printer beeps and returns to the standby 
mode. 

If something goes wrong while sending your fax, an error message appears on the touch panel.

If you receive an error message, select OK to clear the message and try to send the document again. 

You can set your printer to print a confirmation report automatically after each fax transmission.

See also: 
• "Fax Transmit" on page 227

• "Fax Broadcast" on page 227

Automatic Redialing
If the number you have dialed is busy or there is no answer when you send a fax, the printer will automatically redial 
the number every minute based on the number set in the redial settings.

To change the time interval between redials and the number of redial attempts, see "Auto Redial Setup" on 
page 225.

NOTE: 

• The printer will not automatically redial a number that was busy when the number was manually entered.
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Sending a Delayed Fax

The Delayed Send mode can be used to save scanned documents for transmission at a specified time to take 
advantage of lower long distance rates. 

1 Load the document(s) facing up with top edge in first into the ADF or place a single document facing down on 
the document glass and close the document cover.

See also: 

• "Loading an Original Document on the ADF" on page 176

• "Loading an Original Document on the Document Glass" on page 177

2 Press the  (Services Home) button.

3 Select Fax.

4 Adjust the document resolution to suit your fax needs.

See also: 

• "Resolution" on page 178

• "Inserting a Pause" on page 179

5 Select the Options tab, and then select Delayed Send.

6 Select On.

7 Enter the start time using the number pad, and then select OK.

8 Select the Fax tab.

9 Enter the fax number of the recipient using the number pad.

You can also use speed or group dial numbers.

See also: 

• "Automatic Dialing" on page 191

10 Press the  (Start) button.

Once the Delayed Send mode is activated, your printer stores all the documents to be faxed to its memory 
and sends them at the specified time. After faxing in the Delayed Send mode is complete, the data in the 
memory will be cleared.
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Sending a Fax from the Driver (Direct Fax)

You can send a fax directly from the computer running a Microsoft® Windows® operating system or Mac OS X by 
using the driver.

NOTE: 

• Only black and white faxes can be sent using Direct Fax.

• The IPP protocol is not available for Direct Fax.

For Windows

NOTE: 

• The following procedure uses Windows 7 as an example. The names of the windows and the buttons may be different from 
those given in the following procedure depending on the OS and application you are using. 

• To use this feature, you must install the fax driver.

See also: 
• "Configuring Printer and Installing Software on Windows" on page 60

1 Open the file you want to send by fax. 

2 Open the print window from the application, and then select your fax driver.

3 Click Preferences.
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4 Specify the fax settings. For more information, click Help of the driver.

NOTE: 

• The settings performed here are only applied to a single fax job. 

5 Click OK to close the Printing Preferences window. 

6 Click Print. 

The Set / Check Fax Transmission window appears. 
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7 Specify the destination for the recipient in one of the following ways:

• Enter a name and phone number directly.

• Select a recipient from the PC Fax Address Book saved on your computer or Device Address Book.

• Select a recipient from a database other than the PC Fax Address Book or Device Address Book.

For more information on how to specify the destination, click Help to see the Help of the fax driver.

NOTE: 

• Enter the password in the Password field in the Authorization area before sending a fax if the Fax service is locked with 
a password.

8 Click Start Sending.
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For Mac OS X

NOTE: 

• The following procedure uses OS X 10.9 TextEdit as an example. The names of the windows and the buttons may be different 
from those given in the following procedure depending on the OS and application you are using.

• To use this feature, you must install the fax driver.

See also: 
• "Configuring Printer and Installing Software on Mac OS X" on page 83

1 Open the file you want to send by fax.

2 Open the print window from the application, and then select your fax driver.

3 Specify the fax settings.

NOTE: 

• The settings performed here are only applied to a single fax job. 

4 Click Print. 

The Set/Check Fax Transmission window appears.
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5 Specify the destination for the recipient in one of the following ways:

• Specify a recipient directly.

a Enter a name and phone number directly.

b Click Add.

OR

• Select a recipient from the PC Fax Address Book saved on your computer.

a Click Look Up Address Book.

The Refer To Address Book window appears.

b On the Look Up Address Book tab, select a recipient and then click Add.

c Click OK.

OR

• Select a recipient from the Device Address Book.

a Click Look Up Address Book.

The Refer To Address Book window appears.

b On the Look Up Device Address Book tab, select a recipient and then click Add.

c Click OK.

NOTE: 

• Enter the password in the Password field in the Authorization area before sending a fax if the Fax service is locked with 
a password.

6 Click Start Sending.
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Receiving a Fax

About Receiving Modes
There are five receiving modes; TEL Mode, FAX Mode, TEL/FAX Mode, Ans/FAX Mode, and DRPD Mode.

NOTE: 

• To use TEL/FAX Mode or Ans/FAX Mode, attach an external telephone or answering machine to the phone connector ( ) 
on the rear of your printer.

See also: 
• "Receiving a Fax Automatically in the FAX Mode" on page 188

• "Receiving a Fax Manually in the TEL Mode" on page 188

• "Receiving a Fax Automatically in the TEL/FAX Mode or Ans/FAX Mode" on page 188

• "Using an Answering Machine" on page 197

• "Receiving Faxes Using the DRPD Mode" on page 189

Loading Paper for Receiving Faxes 
The instructions for loading paper in the standard 150 sheet tray is the same whether you are printing, faxing, or 
copying, except that faxes can only be printed on letter-, A4-, or legal-size paper.

See also: 
• "Loading Print Media in the Standard 150 Sheet Tray" on page 96

• "Setting Paper Sizes and Types" on page 104

Receiving a Fax Automatically in the FAX Mode
Your printer is preset to FAX Mode at the factory. 

If you receive a fax, the printer automatically goes into the fax receive mode after a specified period of time and 
receives the fax.

To change the interval at which the printer goes into the fax receive mode after receiving an incoming call, see "Auto 
Answer Setup" on page 223.

Receiving a Fax Manually in the TEL Mode
You can receive a fax by picking up the handset of the external telephone and then pressing the remote receive 
code (see "Available Fax Setting Options" on page 200), or by selecting Manual Receive in OnHook (you can 
hear voice or fax tones from the remote machine) and then pressing the  (Start) button.

The printer begins receiving a fax and returns to the standby mode when the reception is completed.

Receiving a Fax Automatically in the TEL/FAX Mode or Ans/FAX 
Mode

To use TEL/FAX Mode or Ans/FAX Mode, you must attach an external telephone to the phone connector ( ) on 
the rear of your printer. 

In the TEL/FAX Mode, if the printer receives an incoming fax, the external telephone rings for the time specified in 
Auto Answer TEL/FAX, and then the printer automatically receives a fax.

In the Ans/FAX Mode, if the caller leaves a message, the answering machine stores the message as it would 
normally. If your printer hears a fax tone on the line, it automatically starts to receive a fax. 

NOTE: 

• If you have set Auto Answer Fax and your answering machine is turned off, or no answering machine is connected to your 
printer, your printer will automatically go into the fax receive mode after a predefined time.

See also: 
• "Using an Answering Machine" on page 197
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Receiving a Fax Manually Using an External Telephone
This feature works best when you are using an external telephone connected to the phone connector ( ) on the 
rear of your printer. You can receive a fax from someone you are talking to on the external telephone without having 
to go to the printer.

When you receive a call on the external telephone and hear fax tones, press the two-digit keys on the external 
telephone.

The printer receives the document.

Press the buttons slowly in sequence. If you still hear the fax tone from the remote machine, try pressing the two-
digit keys once again.

Remote Receive is set to Off at the factory. You can change the two-digit number to whatever you choose. For 
details on changing the code, see "Remote Receive" on page 225.

NOTE: 

• Set the dialing system of your external telephone to DTMF.

Receiving Faxes Using the DRPD Mode
The Distinctive Ring Pattern Detection (DRPD) is a telephone company service which enables a user to use a single 
telephone line to answer several different telephone numbers. The particular number someone uses to call you on is 
identified by different ringing patterns, which consist of various combinations of long and short ringing sounds.

Before using the DRPD option, Distinctive Ring service must be installed on your telephone line by the telephone 
company. To set up DRPD, you will need another telephone line at your location, or someone available to dial your 
fax number from outside. 

To set up the DRPD:

1 Press the  (System) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select Fax Settings.

4 Select Fax Line Settings.

5 Select DRPD Pattern.

6 Select the desired pattern, and then select OK.

7 Reboot the printer by turning the power switch off and then on again.

To receive faxes in the DRPD mode, you need to set the menu to DRPD Mode. For details, see "Available Fax 
Setting Options" on page 200.

See also: 
• "DRPD Pattern" on page 222

Receiving Faxes in the Memory
Since your printer is a multi-tasking device, it can receive faxes while you are making copies or printing. If you 
receive a fax while you are copying, printing, or run out of paper or toner, your printer stores incoming faxes in the 
memory. Then, as soon as you finish copying, printing, or re-supply the toner cartridges, the printer automatically 
prints the fax.
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Polling Receive
You can receive faxes from the remote fax machine when you want to receive it.

1 Press the  (Services Home) button.

2 Select Fax.

3 Select the Options tab, and then select Polling Receive.

4 Select On, and then select OK.

5 Enter the number of the remote machine using the number pad.

NOTE: 

• For information on how to enter the fax number of the remote machine, see "Sending a Fax Automatically" on page 180 
or "Sending a Fax Manually" on page 181.

6 Press the  (Start) button.
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Automatic Dialing

Speed Dialing
You can store up to 99 frequently dialed numbers in speed dial locations (01 – 99). 

When the speed dial job specified in the delayed fax or redial exists, you cannot change the speed dial number from 
the operator panel or CentreWare Internet Services.

Storing a Number for Speed Dialing

1 Press the  (System) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select Fax Address Book.

4 Select Individuals.

5 Select the desired speed dial number between 1 and 200.

6 Select the Name text box.

7 Enter the name, and then select OK.

8 Select the Fax Number text box.

9 Enter the number you want to store using the number pad, and then select OK.

To insert a pause between numbers, press the Redial / Pause button. "-" appears on the LCD panel.

10 Select OK.

To store more fax numbers, repeat steps 5 to 10.

To return to the top level of the System menu, press the  (Clear All) button.
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Sending a Fax Using a Speed Dial

1 Load the document(s) facing up with top edge in first into the ADF or place a single document facing down on 
the document glass and close the document cover.

See also: 

• "Loading an Original Document on the ADF" on page 176

• "Loading an Original Document on the Document Glass" on page 177

2 Press the  (Services Home) button.

3 Select Fax and then select  .

4 Enter the speed dial number between 001 and 200 using the number pad, and then select  .

5 Adjust the document resolution to suit your fax needs.

See also: 

• "Resolution" on page 178

• "Inserting a Pause" on page 179

6 Press the  (Start) button.

The document scans into the memory.

When the document is placed on the document glass, the display prompts you for another page. If you want to 
place a new document, replace the document with a new document, and then select Scan Another Page. 
When you have finished loading documents, select Done. Fax Now.

The fax number stored in the speed dial location is automatically dialed. The document is sent when the remote 
fax machine answers.

NOTE: 

• Using the asterisk (*) in the first digit, you can send a document to multiple locations. For example, if you enter 00*, you 
can send a document to the locations registered between 001 and 009.

Group Dialing
If you frequently send the same document to several destinations, you can create a group of these destinations. You 
can create up to six groups. This enables you to use a group dial number setting to send the same document to all 
the destinations in the group.

NOTE: 

• You cannot include one group dial number within another group dial number.
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Setting Group Dial

1 Press the  (System) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select Fax Address Book and then select Groups.

4 Select the group dial number that you want to edit, and then select Edit.

5 Select the Enter Group Name text box.

6 Enter the name, and then select OK.

7 Select Add from Address Book.

8 Select the desired speed dial numbers.

9 Select OK, and then select OK again.

To store more group dial numbers, repeat steps 4 to 9. 

To return to the top level of the System menu, press the  (Clear All) button.

Editing Group Dial
You can delete a specific speed dial number from a selected group or add a new number to the selected group.

1 Press the  (System) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select Fax Address Book and then select Groups.

4 To change the group dial name:

a Select the group dial number that you want to edit, and then select Edit.

b Select Enter Group Name text box.

c Enter a new name, and then select OK twice.

To delete a speed dial number from the group dial number:

a Select the group dial number that you want to edit, and then select Edit.

b Select the speed dial number that you want to edit.

c Select Remove.

d Select OK.

To delete the group dial:

a Select the group dial number.

b Select Remove.

c Select Delete.

NOTE: 

• When you delete the last speed dial in a group, the group itself is not deleted.

5 If you want to edit another group dial number, repeat step 4.

To return to the top level of the System menu, press the  (Clear All) button.
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Sending a Fax Using Group Dialing (Multi-address Transmission)
You can use group dialing for broadcasting or delayed transmissions.

Follow the procedure of the desired operation (For delayed transmission, see "Sending a Delayed Fax" on 
page 182).

You can use one or more group numbers in one operation. Then continue the procedure to complete the desired 
operation. 

Your printer automatically scans the document loaded in the ADF or on the document glass into the memory. The 
printer dials each of the numbers included in the group.

Printing a Fax Address Book List
You can check your automatic dial setting by printing a Fax Address Book list.

1 Press the  (System) button.

2 Select Report / List.

3 Select Address Book List, and then select Print.

A list of your Fax Address Book entries is printed.
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Address Book

You can select the registered phone numbers from the address books.

1 Load the document(s) facing up with top edge in first into the ADF or place a single document facing down on 
the document glass.

For details about loading a document, see "Loading an Original Document on the ADF" on page 176 or 
"Loading an Original Document on the Document Glass" on page 177.

2 Press the  (Services Home) button.

3 Select Fax.

4 To select the registered phone numbers from the address books:

a Select Device Address Book - Individuals or Device Address Book - Groups.

b Select the desired speed dial number or group dial number.

c Select OK.

NOTE: 

• The fax number needs to be registered before you can select address book.

5 Press the  (Start) button to send the fax.
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Other Ways to Fax

Using the Secure Receiving Mode
You may need to prevent your received faxes from being accessed by unauthorized people. You can turn on the 
secure receiving mode using the Secure Receive option to restrict printing out all of the received faxes when the 
printer is unattended. In the secure receiving mode, all incoming faxes will get saved in the memory. When the mode 
turns off, any faxes stored will be printed.

NOTE: 

• Before operation, make sure that Panel Lock Set is set to Enable.

To turn the secure receiving mode on:

1 Press the  (System) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select Fax Settings.

4 Select Incoming Defaults.

5 Select  until Secure Receive appears, and then select Secure Receive.

6 Select Secure Receive Set.

7 Select Enable, and then select OK.

8 Enter a four-digit password using the number pad, and then select OK.

To return to the top level of the System menu, press the  (Clear All) button.

When a fax is received in the secure receiving mode, your printer stores it into memory and the active jobs 
screen displays Secure Receive to let you know that there is a fax stored.

To print received documents:

1 Press the  (Job Status) button.

2 Select Secure Fax Receive.

3 Enter the passcode, and then select OK.

The faxes stored in memory are printed.

To turn the secure receiving mode off:

1 Access the Secure Receive Set menu by following steps from 1 to 6 in "To turn the secure receiving mode 
on:" on page 196.

2 Select Disable, and then select OK.

To return to the top level of the System menu, press the  (Clear All) button.
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Using an Answering Machine

You can connect a telephone answering device (TAD) directly to the rear of your printer as shown above.

• Set your printer to Ans/FAX Mode in Receive Mode and set Auto Answer Ans/FAX in Auto Answer 
Setup to specify the time for the TAD to respond.

• When the TAD picks up the call, the printer monitors and takes the line if fax tones are received and then starts 
receiving the fax.

• If the answering device is off, the printer automatically goes into the fax receive mode after the ring tone sounds 
for a predefined time.

• If you answer the call and hear fax tones, the printer will answer the fax call if you

– Select Manual Receive in OnHook (you can hear voice or fax tones from the remote machine), and 
then press the  (Start) button and hang up the receiver.

OR

– Press the two-digit remote receive code and hang up the receiver.

Using a Computer Modem

If you want to use your computer modem for faxing or for a dial-up Internet connection, connect the computer 
modem directly to the rear of your printer with the TAD as shown above.

• Set your printer to Ans/FAX Mode in Receive Mode and set Auto Answer Ans/FAX in Auto Answer 
Setup to specify the time for the TAD to respond.

• Turn off the computer modem's fax-receive feature.

• Do not use the computer modem if your printer is sending or receiving a fax.

• Follow the instructions provided with your computer modem and fax application to fax via the computer 
modem.

To the 
wall jack

Printer
Line

Telephone Answering Device Phone

To the 
Internet

Computer

Printer

Line

Telephone Answering Device Phone
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Setting Sounds

Speaker Volume

1 Press the  (System) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select Fax Settings.

4 Select Fax Line Settings.

5 Select Line Monitor.

6 Select the desired volume, and then select OK.

7 Reboot the printer by turning the power switch off and then on.

Ringer Volume

1 Press the  (System) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select Fax Settings.

4 Select Incoming Defaults.

5 Select Ring Tone Volume.

6 Select the desired volume, and then select OK.

7 Reboot the printer by turning the power switch off and then on.
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Specifying the Fax Settings

Changing the Fax Settings Options

1 Press the  (System) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select Fax Settings.

4 Select the desired menu item.

5 Select the desired setting or enter the value using the number pad.

6 Select OK to save the selection.

7 Confirm that Settings Become Effective After Restart appears, and then press any button.

8 If necessary, repeat steps 4 to 6.

To return to the top level of the System menu, press the  (Clear All) button.

For details on available menu items, see "Available Fax Setting Options" on page 200.
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Available Fax Setting Options
You can use the following setting options for configuring the fax system:

Option Description

Fax Number Specifies the fax number of the printer, which will be printed on the header of 
faxes. This feature is available when you set Send Header to On. The 
number specified in Fax Number is used in the printer ID.

Region You can select the region where the printer is used.

You can change this setting when:

• No jobs in operation

• No fax jobs waiting in the memory

Company Name Specifies the sender's name to be printed on the header of faxes.

Line Type You can select the default line type.

• PSTN

• PBX

Line Monitor Sets the volume of the line monitor, which audibly monitors a transmission 
through the internal speaker until a connection is made.

DRPD Pattern Before using the Distinctive Ring Pattern Detection (DRPD) option, distinctive 
ring service must be installed on your telephone line by the telephone 
company. After the telephone company has provided a separate number for 
faxing with a distinctive ring pattern, configure the fax setup to monitor for that 
specific ring pattern.

Extel Hook Threshold You can select the external telephone hook detection threshold for the 
condition in which a telephone line is not being used.

Receive Mode TEL Mode Automatic fax reception is turned off. You can receive a fax by picking up the 
handset of the external telephone and then pressing the remote receive code, 
or by selecting Manual Receive in OnHook (you can hear voice or fax tones 
from the remote machine) and then pressing the  (Start) button.

FAX Mode* Automatically receives faxes.

TEL/FAX Mode When the printer receives an incoming fax, the external telephone rings for the 
time specified in Auto Answer Setup, and then the printer automatically 
receives a fax. If an incoming call is not a fax, the printer beeps from the 
internal speaker indicating that the call is a telephone call.

Ans/FAX Mode The printer can share a telephone line with an answering machine. In this 
mode, the printer will monitor the fax signal and pick up the line if there are fax 
tones.

DRPD Mode Before using the Distinctive Ring Pattern Detection (DRPD) option, distinctive 
ring service must be installed on your telephone line by the telephone 
company. After the telephone company has provided a separate number for 
faxing with a distinctive ring pattern, configure the fax setup to monitor for that 
specific ring pattern.

Ring Tone Volume Sets the volume of the ring tone, which indicates that an incoming call is a 
telephone call through the internal speaker when Receive Mode is set to 
TEL/FAX Mode.

Auto Answer 
Setup

Auto Answer 
Fax

Sets the interval at which the printer goes into the fax receive mode after 
receiving an incoming call. The interval can be specified within the range of 0 
to 255 seconds. The default is 0 second.

Auto Answer 
TEL/FAX

Sets the interval at which the printer goes into the fax receive mode after the 
external telephone receives an incoming call. The interval can be specified 
within the range of 0 to 255 seconds. The default is 6 seconds.

Auto Answer 
Ans/Fax

Sets the interval at which the printer goes into the fax receive mode after the 
external answering machine receives an incoming call. The interval can be 
specified within the range of 0 to 255 seconds. The default is 21 seconds.

Junk Fax Filter You can reject faxes sent from unwanted stations. The system only accepts 
faxes from the remote stations registered in the speed dial. This feature is 
useful for blocking any unwanted faxes.

Select Off to turn the feature off. Anybody can send you a fax.

Select On to turn the feature on.
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Secure Receive Secure Receive 
set

Allows you to password protect all the incoming faxes. When the Secure 
Receive feature is enabled, the printer stores incoming faxes and prints them 
when the correct password is entered on the operator panel.

Forward Settings You can set your printer to forward incoming faxes to another fax number, an 
e-mail address, or a server.

When a fax arrives at your printer, it is stored in the memory. Then, the printer 
does one of the following:

• Dials the fax number you have specified in Forwarding Number

• Sends an e-mail to the address you have specified in Forwarding E-mail 
Address 1-5. The fax is converted to a pdf and is attached to the e-mail

• Saves a pdf version of the fax to a shared folder on a server you have 
specified in Forward to Server Settings

Select Off not to forward incoming faxes.

Select Forward to forward incoming faxes without printing. If an error occurs 
during forwarding a received fax, the printer prints the fax.

Select Forward and Print to forward and print incoming faxes.

Select Forward to E-mail to forward incoming faxes to e-mail.

Select E-mail and Print to print incoming faxes and also forward to 
e-mail.

Select Forward to Server to forward incoming faxes to a server.

Select Forward to Server and Print to print incoming faxes and also 
forward to a server.

To forward to a fax number, you need to register a fax number on Forwarding 
Number. To forward to an e-mail address, you need to register information on 
E-mail and Forwarding E-mail Address. To forward to a server, you need to 
register the server information on Forward to Server Settings.

For information on E-mail and Forwarding E-mail Address, see the Help on 
CentreWare Internet Services. For information on Forwarding Number, see 
"Forward Settings" on page 224. For information about shared folders on 
servers and Forward to Server Settings, see the Help on CentreWare Internet 
Services.

Remote Receive You can receive a fax by pressing the remote receive code on the external 
telephone after picking up the handset of the telephone.

Discard Size When receiving a document as long as or longer than the paper installed in 
your printer, you can set the printer to discard any excess at the bottom of the 
page. If the received page is outside the margin you set, it will print on two 
sheets of paper at the actual size. When the document is within the margin 
and Discard Size is set to Auto Reduction, the printer reduces the 
document to fit it onto the appropriate sized paper and discard does not occur. 
If Discard Size is set to other than Auto Reduction, the data within the 
margin will be discarded.

Auto Redial 
Setup

Number of 
Redial

You can specify the number of redial attempts to make when the destination 
fax number is busy, within the range of 0 to 9. If you enter 0, the printer will not 
redial.

Redial 
Interval

Your printer can automatically redial a remote fax machine if it was busy. 
Intervals from 1–15 minutes can be entered.

Interval Timer You can specify the interval between transmission attempts within the range of 
3 to 255 seconds. The default is 8 seconds.

Dial Type You can select the dialing type.

• PB

• DP (10PPS)

• DP (20PPS)

Prefix Dial You can specify whether or not to set a prefix dial number.

Fax Cover Page You can set whether to attach a cover page to faxes when sending faxes.

Option Description
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• Prefix Dial

NOTE: 

• Prefix Dial only supports the environment where you send a fax to the external line number. To use Prefix Dial, you 
must do the following from the operator panel. 

1 Press the  (System) button.

2 Select the Tools tab, and then select Admin Settings.

3 Select Fax Settings.

4 Select Fax Line Settings.

5 Select Line Type.

6 Select PBX.

7 Access the Fax Settings menu by following steps from 1 to 3.

8 Select Transmission Defaults.

9 Select Prefix Dial.

10 Select On, and then select OK.

11 Enter an up-to-five-digit prefix number from 0 – 9, *, and #, and then select OK.

12 Reboot the printer by turning the power switch off and then on.

Send Header Prints the sender's information on the header of faxes. 

Select Off to turn this feature off. 

Select On to turn this feature on.

For information on the region setting, see "Setting Your Region" on page 174.

ECM You can set whether to enable or disable the ECM (Error Correction Mode).

Modem Speed You can set the modem speed.

Display Manual Fax Recipients To set whether to display the fax number of the recipient when manually 
sending a fax.

Fax Reports Fax Activity You can set whether to automatically print a fax activity report after every 50 
incoming and outgoing fax communications.

Fax Transmit You can set whether to print a transmission result after a fax transmission.

Fax Broadcast You can set whether to print a transmission result after a fax broadcast to 
multiple locations.

Option Description
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Changing the Default Settings

The fax menu options can be set to the most frequently used modes.

To create your own default settings:

1 Press the  (System) button.

2 Select the Tools tab, and then select Default Settings.

3 Select Fax Defaults.

4 Select the desired menu item.

5 Select the desired setting or enter the value using the number pad, and then select OK.

To return to the top level of the System menu, press the  (Clear All) button.
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Printing a Report

The following reports may be useful when using fax:

• Address Book List

This list shows all the addresses currently stored in the memory of the printer as Address Book information.

• Protocol Monitor

This report shows the status of the protocol when the latest fax was being sent.

• Fax Activity

This report shows information about the faxes you recently received or sent.

To print a report or list:

1 Press the  (System) button.

2 Select Report / List.

3 Select the report or list you want to print, and then select Print.

The selected report or list is printed.
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9
Using the Operator Panel Menus and Keypad

• "Understanding the Printer Menus" on page 206

• "Panel Lock Function" on page 250

• "Limiting Access to Printer Operations" on page 252

• "Changing the Language" on page 253

• "Setting the Time for the Power Saver Mode" on page 254

• "About the Concurrent Jobs Feature" on page 255

• "Resetting to Factory Defaults" on page 256

• "Entering Characters" on page 257
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Understanding the Printer Menus

This section describes menu options that can be accessed by pressing the  (System) button on the operator 
panel.

NOTE: 

• The access to Admin Settings and Report / List can be limited with a password by enabling the Panel Lock function. 
For more information, see "Panel Lock Function" on page 250.

Report / List
Use Report / List to print various types of reports and lists.

NOTE: 

• A password is required to enter the Report / List menu when Panel Lock Set is set to Enable. In this case, enter the 
password you specified, and then select OK.

System Settings
Purpose:

To print a list of the information such as the printer name, serial number, and print volume.

Network settings are also printed.

Panel Settings
Purpose:

To print a detailed list of all the settings on the operator panel menus.

PCL Fonts List
Purpose:

To print a sample of the available PCL fonts.

PS Fonts List
Purpose:

To print a sample of the available PS fonts.

Job History
Purpose:

To print a detailed list of the jobs that have been processed. This list contains the last 50 jobs.

Error History
Purpose:

To print a detailed list of paper jams and fatal errors.

Demo Page
Purpose:

To print a test page.

Protocol Monitor
Purpose:

To print a detailed list of monitored protocols.
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Address Book List
Purpose:

To print the list of all addresses stored as Address Book information.

Fax Activity
Purpose:

To print the report of faxes you recently received or sent.

Stored Documents

NOTE: 

• Stored Documents feature is available only when RAM Disk under System Settings is set to On.

Purpose:

To print a list of all files stored for Secure Print in the RAM disk.

Meter Readings
Use Meter Readings to check the total number of printed pages.

Values:

*1 This item always shows 0 on your printer.

Wi-Fi Status
Use the Wi-Fi Status menu to confirm the connection status of wireless settings. And also configures a wireless 
connection using Wi-Fi Setup or Wi-Fi Direct Setup.

Admin Settings
Use Admin Settings to configure a variety of printer features.

NOTE: 

• A password is required to enter Admin Settings when Panel Lock Set is set to Enable. In this case, enter the 
password you specified, and then select OK.

Fax Address Book
Use the Fax Address Book menu to configure the individuals and groups settings.

• Individuals
Purpose:

To store up to 99 frequently dialed numbers in Individuals locations.

NOTE: 

• The first eight entries are assigned to the one-touch buttons on the operator panel.

See also: 
• "Storing a Number for Speed Dialing" on page 191

Meter1 Displays the total number of color prints.

Meter2 Displays the total number of monochrome prints.

Meter3*1 Displays the total number of large size color prints.

Meter4 Displays the total number of color and monochrome prints (Meter1 + Meter2).
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• Groups
Purpose:

To create a group of fax destinations and register it under a 2-digit dial code. Up to 6 group dial codes can be 
registered.

See also: 
• "Setting Group Dial" on page 193

PCL
Use the PCL Settings menu to change printer settings that only affect jobs using the PCL emulation printer 
language.

NOTE: 

• The value marked by an asterisk (*) is the factory default setting.

• Paper Size
Purpose:

To specify the default paper size.

Values:

mm series

*1 The default for Paper Size varies depending on region-specific factory.

inch series

A4*1

A5

B5

Letter

Folio (8.5  13")

Legal

Executive

Monarch

DL Env.

C5 Env.

#10 Env.

Custom Size Width(x) 210 mm*

77 – 215 mm

Specifies the length of the custom size paper.

Length(y) 297 mm*

127 – 355 mm

Specifies the length of the custom size paper.

Letter

Folio (8.5  13")

Legal

A4*1

A5

B5

Executive

Monarch

DL Env.

C5 Env.

#10 Env.
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*1 The default for Paper Size varies depending on region-specific factory.

NOTE: 

• Selecting Custom Size for the paper size prompts you to enter a custom length and width.

• Orientation
Purpose:

To specify how text and graphics are oriented on the page.

Values:

Custom Size Width(x) 8.3 inch*

3.0 – 8.5 mm

Specifies the length of the custom size paper.

Length(y) 11.7 inch*

5.0 – 14.0 mm

Specifies the length of the custom size paper.

Portrait* Prints text and graphics parallel to the short edge of the paper.

Landscape Prints text and graphics parallel to the long edge of the paper.
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• Font
Purpose:

To specify the default font from the fonts registered in the printer.

Values:

Courier* Arial Bd N C Schbk BdIt

CG Times Arial It Times Roman

CG Times Bd Arial BdIt Times Bd

CG Times It Times New Times It

CG Times BdIt Times New Bd Times BdIt

CG Omega Times New It ZapfC MdIt

CG Omega Bd Times New BdIt Symbol

CG Omega It Helvetica SymbolPS

CG Omega BdIt Helvetica Bd Wingdings

Coronet Helvetica Ob ZapfDinbats

Clarendon Cd Helvetica BdOb Courier Bd

Univers Md HelveticaNr Courier It

Univers Bd HelveticaNr Bd Courier BdIt

Univers MdIt HelveticaNr Ob LetterGothic

Univers BdIt HelveticaNrBdOb LetterGothic Bd

Univers MdCd Palatino Roman LetterGothic It

Univers BdCd Palatino Bd CourierPS

Univers MdCdIt Palatino It CourierPS Bd

Univers BdCdIt Palatino BdIt CourierPS Ob

AntiqueOlv ITC A G Go Bk CourierPS BdOb

AntiqueOlv Bd ITC A G Go Dm Line Printer

AntiqueOlv It ITC A G Go BkOb

GaramondAntiqua ITC A G Go DmOb

Garamond Hlb ITCBookman Lt

Garamond Krsv ITCBookmanDm

GaramondKrsvHlb ITCBookman LtIt

Marigold ITCBookmanDm It

Albertus Md N C Schbk Roman

Albertus XBd N C Schbk Bd

Arial N C Schbk It
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• Symbol Set
Purpose:

To specify a symbol set for a specified font.

Values:

• Font Size
Purpose:

To specify the font size for scalable typographic fonts, within the range of 4.00 to 50.00. The default is 12.00. 

Font size refers to the height of the characters in the font. One point equals approximately 1/72 of an inch.

NOTE: 

• The Font Size menu is only displayed for typographic fonts.

• Font Pitch
Purpose:

To specify the font pitch for scalable mono spaced fonts, within the range of 6.00 to 24.00. The default is 10.00.

Font pitch refers to the number of fixed-space characters in a horizontal inch of type. For nonscheduled mono 
spaced fonts, the pitch is displayed, but cannot be changed.

NOTE: 

• The Font Pitch menu is only displayed for fixed or mono spaced fonts.

• Form Line
Purpose:

To set the number of lines in a page.

Values:

*1 The default for Form Line varies depending on the default paper size.

The printer sets the amount of space between each line (vertical line spacing) based on the Form Line and 
Orientation menu items. Select the correct Form Line and Orientation before changing Form Line.

See also: 
• "Orientation" on page 209

ROMAN-8 MS PUB DNGBTSMS

ROMANEXT MATH-8 ISO L6

ISO L1 PS MATH PC-1004

ISO L2 PI FONT PC-775

ISO L5 LEGAL WINBALT

PC-8* ISO-4 UCS-2

PC-8 DN ISO-6

PC-850 ISO-11

PC-852 ISO-15

PC-8 TK ISO-17

WIN L1 ISO-21

WIN L2 ISO-60

WIN L5 ISO-69

DESKTOP WIN 3.0

MC TEXT SYMBOL

PS TEXT WINGDINGS

64*1 Sets the value in increments of 1.

5–128



212 Using the Operator Panel Menus and Keypad

• Quantity
Purpose:

To specify the number of copies to print.

Values:

• Image Enhance
Purpose:

To specify whether to enable the Image Enhance feature, which makes the boundary line between black and white 
smoother to decrease jagged edges and enhance the visual appearance.

Values:

• Draft Mode
Purpose:

To save toner by printing in the draft mode. The print quality is reduced when you print in the draft mode.

Values:

• Line Termination
Purpose:

To add the line termination commands.

Values:

• Output Color
Purpose:

To specify the color mode to Color or Black & White. This setting is used for a print job that does not specify a 
print mode.

Values:

1* Sets the value in increments of 1.

1–999

Off Disables the Image Enhance feature.

On* Enables the Image Enhance feature.

Disable* Does not print in the draft mode.

Enable Prints in the draft mode.

Off* The line termination command is not added.

CR=CR, LF=LF, FF=FF

Add-LF The LF command is added.

CR=CR-LF, LF=LF, FF=FF

Add-CR The CR command is added.

CR=CR, LF=CR-LF, FF=CR-FF

CR-XX The CR and LF commands are added.

CR=CR-LF, LF=CR-LF, FF=CR-FF

Black & White Prints in the black and white mode.

Color* Prints in the color mode.
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PS
Use the PS Settings menu to change printer settings that only affect jobs using the PostScript 3 Compatible 
printer language.

NOTE: 

• The value marked by an asterisk (*) is the factory default setting.

• PS Error Report
Purpose:

To specify whether to print the contents of PostScript 3 Compatible errors.

Values:

NOTE: 

• Instructions from the PS driver override the settings specified on the operator panel.

• PS Job Timeout
Purpose:

To specify the runtime of one PostScript 3 Compatible job.

Values:

• Output Color
Purpose:

To specify the color mode to Color or Black & White. This setting is used for a print job which does not specify a 
print mode.

Values:

• Image Depth
Purpose:

To specify the image depth setting to 1 bit or 2 bit.

Values:

PDF
Use the PDF Settings menu to change printer settings that only affect the PDF jobs.

NOTE: 

• The value marked by an asterisk (*) is the factory default setting.

Off Discards the print job without printing an error message.

On* Prints an error message before it discards the job.

Off* Job timeout does not occur.

On 1min A PostScript 3 Compatible error occurs if processing is not completed after the 
specified time.1 – 900min

Color* Prints in color mode.

Black & White Prints in black and white mode.

1 Bit Prints in 2 bit color or if you use the other PS driver not provided with this printer, it 
prints in 1 bit color.

2 Bit* Prints in 2 bit color.
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• Quantity
Purpose:

To specify the number of copies to print.

Values:

• Print Mode
Purpose:

To specify the print mode.

Values:

• PDF Password
Purpose:

To specify the password to print the secure PDF.

Value:

• Paper Size
Purpose:

To specify the output paper size for PDF.

Values:

*1 The default paper size is displayed.

• Layout
Purpose:

To specify the output layout.

Values:

• Output Color
Purpose:

To specify the output color.

Values:

1* Sets the value in increments of 1.

1–999

Normal* For documents with normal sized characters.

High Quality For documents with small characters or thin lines, or documents printed using a 
dot-matrix printer.

Enter PDF Password Enter the password to print the secure PDF.

Auto*

A4*1

Letter*1

Fit to Paper*

100% (No Scaling)

2 Pages Up

4 Pages Up

Color*

Black and White
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Network
Use the Network Setup menu to change the printer settings affecting jobs sent to the printer through the wired or 
wireless network.

NOTE: 

• The value marked by an asterisk (*) is the factory default setting.

• Ethernet / Wireless

NOTE: 

• When using a wired network, Ethernet is displayed. When the Ethernet cable is disconnected, Wireless is displayed.

Purpose:

To confirm or specify network settings.

Wi-Fi

Purpose:

To enable the wireless connection.

Values:

Wireless Setup Wizard

NOTE: 

• Wireless Setup Wizard is available only when the printer is connected using the wireless network.

Purpose:

To configure the wireless network interface. The printer automatically searches and list available access points. 
Select one of the access points, and enter a passphrase or WEP key to complete the wireless setup. You can also 
specify and configure the wireless network manually.

Values:

Off

On*

Select access 
point

Select the access point from the list. The access points are listed starting with the one in the best 
communication condition.

Enter 10 or 26 
Digit Key

When you select an access point using WEP as the security method, enter the 
WEP key. For 64bit keys, enter 10 hexadecimal characters. For 128bit keys, 
enter 26 hexadecimal characters.

Enter Password When you select an access point using WPA, WPA2, or Mixed as the encryption 
type, enter the passphrase of 8 to 63 alphanumeric (or 64 hexadecimal) 
characters.
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Manual SSID 
Setup

SSID Specify a name to identify the wireless network. Up to 32 alphanumeric 
characters can be entered.

Infrastructure Select to configure the wireless settings through the access point such as a 
wireless router.

No Security Select to configure the wireless settings with no encryption 
settings.

Mixed mode 
PSK

Select to configure the wireless settings with the Mixed 
mode PSK encryption. Mixed mode PSK automatically 
selects the encryption type from either WPA-PSK-AES or 
WPA2-PSK-AES.

Enter 
Password

Specify the passphrase of 8 to 63 
alphanumeric (or 64 hexadecimal) 
characters.

WPA2-PSK-AES Select to configure the wireless settings with the WPA2-
PSK-AES encryption.

Enter 
Password

Specify the passphrase of 8 to 63 
alphanumeric (or 64 hexadecimal) 
characters.

WEP Select to configure the wireless settings with the WEP 
encryption.

Enter WEP Key Specify the WEP key to use through the 
wireless network. For 64bit keys, enter 
10 hexadecimal characters. For 128bit 
keys, enter 26 hexadecimal characters.

Transmit Key Select a transmit key from WEP Key 1, 
WEP Key 2, WEP Key 3, and WEP Key 
4.

Ad-hoc Select to configure the wireless setting without the access point such as a 
wireless router.

No Security Select to configure the wireless settings with no encryption 
settings.

WEP Select to configure the wireless settings with the WEP 
encryption.

Enter WEP Key Specify the WEP key to use through the 
wireless network. For 64bit keys, enter 
10 hexadecimal characters. For 128bit 
keys, enter 26 hexadecimal characters.

Transmit Key Select a transmit key from WEP Key 1, 
WEP Key 2, WEP Key 3, and WEP Key 
4.
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WPS Setup

NOTE: 

• WPS Setup is available only when the printer is connected using the wireless network.

Purpose:

To configure the wireless network using Wi-Fi Protected Setup™ (WPS).

Values:

*1 WPS-PBC stands for Wi-Fi Protected Setup-Push Button Configuration.

*2 WPS-PIN stands for Wi-Fi Protected Setup-Personal Identification Number.

NOTE: 

• WPS 2.0 compliant. WPS 2.0 works on access points with the following encryption types: Mixed Mode PSK, WPA-PSK-AES, 
WPA2-PSK-AES, Open (No Security)

IP Mode

Purpose:

To configure the IP mode.

Values:

NOTE: 

• To set an IP address for IPv6 in Dual Stack mode, use the CentreWare Internet Services. For more information, refer to the 
online Help on the CentreWare Internet Services.

TCP/IP

Purpose:

To configure TCP/IP settings. The change becomes effective after the printer is turned off and then on.

Values:

Push Button 
Configuration

Start 
Configuration

Configures the wireless setting with WPS-PBC*1.

PIN Code Start 
Configuration

Configures the wireless setting using WPS-PIN*2 assigned automatically by 
the printer.

Print PIN Code Prints the PIN code. Confirm it when you enter the PIN code to your computer.

Dual Stack* Uses both IPv4 and IPv6 to set the IP address.

IPv4 Mode Uses IPv4 to set the IP address.

Get IP Address DHCP / 
AutoIP*

Sets the IP address automatically. A random value in the range of 169.254.1.0 
to 169.254.254.255 that is not currently in use on the network is set as the IP 
address. The subnet mask is set as 255.255.0.0.

BOOTP Sets the IP address using BOOTP.

RARP Sets the IP address using RARP.

DHCP Sets the IP address using DHCP.

Panel Use this option when you want to set the IP address manually on the operator 
panel.

IP Address When an IP address is being set manually, the IP is allocated to the printer using 
the format nnn.nnn.nnn.nnn. Each octet that makes up nnn.nnn.nnn.nnn is 
a value in the range of 0 to 254. 127 and any value in the range of 224 to 254 
cannot be specified for the first octet of a gateway address.

Subnet Mask When an IP address is being set manually, the subnet mask is specified using the 
format nnn.nnn.nnn.nnn. Each octet that makes up nnn.nnn.nnn.nnn is a 
value in the range of 0 to 255.255.255.255.255 cannot be specified as the 
subnet mask.

Gateway 
Address

When an IP address is being set manually, the gateway address is specified using 
the format nnn.nnn.nnn.nnn. Each octet that makes up nnn.nnn.nnn.nnn is 
a value in the range of 0 to 254. 127 and any value in the range of 224 to 254 
cannot be specified for the first octet of a gateway address.
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IPsec

NOTE: 

• IPsec feature is available only when IPsec is enabled on the CentreWare Internet Services.

Purpose:

Disables IPsec. 

Value:

Reset Wireless

NOTE: 

• Reset Wireless feature is available only when the printer is connected using the wireless network.

Purpose:

To reset the wireless connection settings. After executing this function, all information about the access point is 
cleared.

Value:

Connection Speed

NOTE: 

• Connection Speed feature is available only when the printer is connected using the wired network.

Purpose:

To specify the communication speed and the duplex settings of Ethernet. The change becomes effective after the 
printer is turned off and then on again.

Values:

• Wi-Fi Direct
Purpose:

To configure the Wi-Fi Direct® settings.

Values:

Disable Disables IPsec.

Reset Resets the wireless connection settings.

Auto* Detects the Ethernet settings automatically.

10Base-T Half Uses 10Base-T Half-duplex.

10Base-T Full Uses 10Base-T Full-duplex.

100Base-T Half Uses 100Base-T Half-duplex.

100Base-T Full Uses 100Base-TX Full-duplex.

Wi-Fi 
Direct

Disable* Disables the Wi-Fi Direct connection.

Enable Enables the Wi-Fi Direct connection.

Connection 
Status

No Entry Indicates that no device is available.

Displays the 
connected device 
name and current 
role.

Disconnect 
now

Disconnect the connected device when using Wi-Fi Direct.

Disconnect 
and Reset 
Passphrase

Disconnect the connected device and reset passphrase when 
using Wi-Fi Direct.

Device Name Displays the printer name.

SSID Specify a name to identify the wireless network.

Passphrase Print 
Passphrase

Prints the passphrase. Confirm it when you enter the passphrase to your mobile 
device.

Reset 
Passphrase

Resets the passphrase.
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• Protocols
Purpose:

To enable or disable each protocol. The change becomes effective after the printer is turned off and then on again.

Values:

*1 To add a printer using an IPP port on Windows®, insert port number "631" in the URL of the printer. For example: http:// [Printer's 
IP address]:631/ipp

*2 HTTP-SSL/TLS is available only when a digital certificate is created using CentreWare Internet Services. For details about 
creating a digital certificate, see the Help on the CentreWare Internet Services.

Group Role Group Owner* Sets your printer as the group owner for Wi-Fi Direct.

Auto Automatically resolves the group role for Wi-Fi Direct.

WPS Setup Push Button 
Configuration

Configures the Wi-Fi Direct settings with the security method of WPS-PBC.

PIN Code Configures the Wi-Fi Direct settings using the PIN code with 
your mobile device.

Print PIN 
Code

Prints the PIN code. Confirm it when you enter the PIN code to 
your mobile device.

Reset PIN 
Code

Resets the PIN code.

P2P TCP/IP IP Address Displays the IPv4 address allocated to the printer when using Wi-Fi Direct.

Subnet Mask Displays the subnet mask when using Wi-Fi Direct.

LPD Disable Disables the Line Printer Daemon (LPD) port.

Enable* Enables the LPD port.

Port 9100 Disable Disables the Port9100 port.

Enable* Enables the Port9100 port.

IPP*1 Disable Disables IPP port.

Enable* Enables IPP port.

WSD

(Web Services on 
Devices)

Disable Disables Web Services on Devices (WSD) scan.

Enable* Enables Web Services on Devices (WSD) scan.

SNMP Disable Disables the Simple Network Management Protocol (SNMP) UDP port.

Enable* Enables the SNMP UDP port.

StatusMessenger Disable Disables the StatusMessenger feature.

Enable* Enables the StatusMessenger feature.

Internet Services Disable Disables an access to CentreWare Internet Services embedded in the printer.

Enable* Enables an access to CentreWare Internet Services embedded in the printer.

Bonjour(mDNS) Disable Disables Bonjour (mDNS).

Enable* Enables Bonjour (mDNS).

HTTP-SSL/TLS*2 Disable* Disables HTTP-SSL/TLS.

Enable Enables HTTP-SSL/TLS.

Google Cloud 
Print

Disable* Disables Google Cloud Print™.

Enable Enables Google Cloud Print.

SNTP Disable* Disables SNTP.

Enable Enables SNTP.
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• Advanced Settings
Purpose:

To specify advanced network settings.

IP Filter

NOTE: 

• IP Filter feature is available only when Protocols is set to LPD or Port9100.

Purpose:

To block data received from certain IP addresses through the wired or wireless network. You can set up to five IP 
addresses.

Values:

Adobe Protocol

Purpose:

To specify the PostScript 3 Compatible communication protocol for a parallel interface, you can configure the Adobe 
Protocol settings for the wired network. The change becomes effective after the printer is turned off and then on 
again.

Values:

• Reset Network Setup
Purpose:

To initialize the network settings stored in the NVM (non-volatile memory). After executing this function and 
rebooting the printer, all network settings are reset to their default values.

Value:

Fax Settings
Use the Fax Settings menu to configure the basic fax settings.

NOTE: 

• The value marked by an asterisk (*) is the factory default setting.

• Fax Line Settings
Purpose:

To configure basic settings for the fax line.

n (n is 1-5) IP Address Sets the IP address for Filter n.

Subnet Mask Sets the address mask for Filter n.

Mode Off* Disables the IP Filter feature for Filter n.

Accept Accepts an access from the specified IP address.

Reject Rejects an access from the specified IP address.

Auto* Sets the PostScript 3 Compatible communications protocol automatically.

Standard Sets the PostScript 3 Compatible communications protocol to Standard.

BCP Sets the PostScript 3 Compatible communications protocol to BCP.

TBCP Sets the PostScript 3 Compatible communications protocol to TBCP.

Reset Initializes the network settings stored in the NVM.
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Fax Number

Purpose:

To set the fax number of the printer, which will be printed on the header of a fax message.

NOTE: 

• Make sure to specify Fax Number before using Junk Fax Filter.

Region

Purpose:

To select the region where the printer is used. The change becomes effective after the printer is turned off and then 
on.

Values:

Company Name

Purpose:

To set the sender name to be printed on the header on faxes.

Line Type

Purpose:

To select the default line type. The change becomes effective after the printer is turned off and then on.

Values:

Line Monitor

Purpose:

To set the volume of the line monitor, which audibly monitors a transmission through the internal speaker until a 
connection is made.

Values:

Unknown*

Australia

Cambodia

China 

Hong Kong

Indonesia

Laos

Malaysia

Myanmar

New Zealand

Philippines

Singapore

South Korea

Taiwan

Thailand

Vietnam

PSTN* Uses PSTN.

PBX Uses PBX.

Off Turns off the volume of the line monitor.

Min Sets the volume of the line monitor to minimum.

Middle* Sets the volume of the line monitor to middle.

Max Sets the volume of the line monitor to maximum.
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DRPD Pattern

Purpose:

To provide a separate number for faxing with a distinctive ring pattern.

Values:

Extel Hook Threshold

Purpose:

To select the external telephone hook detection threshold for the condition in which a telephone line is not being 
used.

Values:

Pattern1-7 DRPD is a service provided by some telephone companies. DRPD patterns are 
specified by your telephone company. The patterns provided with your printer are 
shown below:

Ask your telephone company which pattern you need to select to use this service. 
For example, Pattern7 is the New Zealand FaxAbility distinctive ringing pattern: 
rings for 400 ms, stops for 800 ms, rings for 400 ms and stops for 1400 ms. This 
pattern is repeated over and over again. This printer only responds to Distinctive 
Alert cadence(s) DA4 in New Zealand.

Lower Sets the external telephone hook detection threshold to Lower.

Normal* Sets the external telephone hook detection threshold to Normal.

Higher Sets the external telephone hook detection threshold to Higher.

Pattern1

Pattern2

Pattern3

Pattern4*

Pattern5

Pattern6

Pattern7
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• Incoming Defaults
Purpose:

To configure settings for incoming fax.

Receive Mode

Purpose:

To select the default fax receiving mode.

Values:

Ring Tone Volume

Purpose:

To set the volume of the ring tone, which indicates that an incoming call is a telephone call through the internal 
speaker when Receive Mode is set to TEL/FAX Mode.

Values:

Auto Answer Setup

Purpose:

To configure settings for automatic fax reception.

Values:

TEL Mode Automatic fax reception is turned off. You can receive a fax by picking up the 
handset of the external phone and then pressing the remote receive code, or by 
selecting Manual Receive in OnHook to On (you can hear voice or fax tones 
from the remote machine) and then pressing the  (Start) button. For details 
about Manual Receive, see "Receiving a Fax Manually in the TEL Mode" on 
page 188.

FAX Mode* Automatically receives faxes.

TEL/FAX Mode When the printer receives an incoming fax, the external telephone rings for the 
time specified in Auto Receive TEL/FAX, and then the printer automatically 
receives a fax. If an incoming call is not a fax, the printer beeps from the internal 
speaker indicating that the call is a telephone call.

Ans/FAX Mode The printer can share a telephone line with an answering machine. In this mode, 
the printer will monitor the fax signal and pick up the line if there are fax tones. If 
the phone communication in your region is serial, this mode is not supported.

DRPD Mode Before using the Distinctive Ring Pattern Detection (DRPD) option, a distinctive 
ring service must be installed on your telephone line by the telephone company. 
After the telephone company has provided a separate number for faxing with a 
distinctive ring pattern, configure the fax setup to monitor for that specific ring 
pattern.

Off Turns off the volume of the ring tone.

Min Sets the volume of the ring tone to minimum.

Middle Sets the volume of the ring tone to middle.

Max* Sets the volume of the ring tone to maximum.

Auto Answer Fax 0* Sets the interval at which the printer goes into the fax receive mode after receiving 
an incoming call. The value is set in increments of 1 second.0-255

Auto Answer 
TEL/FAX

6* Sets the interval at which the printer goes into the fax receive mode after the 
external telephone receives an incoming call. The value is set in increments of 1 
second.

0-255

Auto Answer 
Ans/Fax

21* Sets the interval at which the printer goes into the fax receive mode after the 
external answering machine receives an incoming call. The value is set in 
increments of 1 second.

0-255
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Junk Fax Filter

Purpose:

To reject unwanted faxes by accepting faxes only from the fax numbers registered in the Fax Address Book.

Values:

Secure Receive

NOTE: 

• Secure Receive feature is available only when Panel Lock Set is set to Enable.

Purpose:

To specify whether to require a passcode to receive faxes, and to set or change the passcode.

Values:

*1 This item is available only when Secure Receive Set is set to Enable.

Forward Settings

NOTE: 

• The E-mail and Print feature is available only when E-mail information and Forwarding E-mail Address are registered. 
For information on E-mail, see the Help on CentreWare Internet Services.

• The Forward to Server and Forward to Server and Print feature are available only when information about 
shared folders and servers are registered in Forward to Server Settings. For details about shared folders on servers, see the 
Help on the CentreWare Internet Services.

• The forwarding fax job may fail when Forward Settings is set to Forward to E-mail. Because your printer judges that 
forwarding is finished when a fax reaches the first SMTP server even if it does not reach the destination e-mail address. Also 
your printer deletes the received faxes, so you cannot resend or print the fax job.

Purpose:

To set whether to forward incoming faxes to a specified destination.

Values:

Off* Does not reject faxes sent from unwanted numbers.

On Rejects faxes sent from unwanted numbers.

Secure Receive 
Set

Disable* Does not require a passcode to receive faxes.

Enable Requires a passcode to receive faxes. 

Change Password*1 0000-9999 Sets or change the passcode required to receive faxes

Off* Does not forward incoming faxes.

Forward Forwards incoming faxes to a specified destination. Prints incoming faxes if an 
error occurs during the transfer.

Forwarding 
Number

Specifies  the Fax number of the destination to which incoming faxes will be 
forwarded.

Forward and 
Print

Forwards incoming faxes to a specified destination and also prints incoming 
faxes.

Forwarding 
Number

Specifies  the Fax number of the destination to which incoming faxes will be 
forwarded.

Forward to E-mail Forwards incoming faxes to a specified e-mail address.

E-mail and Print Forwards incoming faxes to a specified e-mail address and also prints incoming 
faxes.

Forward to Server Forwards incoming faxes to a specified server.

Forward to Server and Print Prints incoming faxes and also forwards them to a specified server.
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Remote Receive

Purpose:

To receive a fax by pressing a remote receive code on the external telephone after picking up the handset of the 
telephone.

Values:

Discard Size

Purpose:

To set the printer to discard images or any text at the bottom of a fax page when the entire page does not fit the 
output paper.

Values:

• Transmission Defaults
Purpose:

To configure settings for transmitting fax.

Auto Redial Setup

Purpose:

To configure settings for automatic redial.

Values:

*1 The default for Number of Redial varies depending on region-specific factory.

Dial Type

Purpose:

To select the dialing type.

Values:

NOTE: 

• The dialing type that you can select differs depending on the region setting.

Off* Does not receive a fax by pressing a remote receive code on the external telephone.

On Receives a fax by pressing a remote receive code on the external telephone.

Remote Receive 
Tone

Specifies the tone in two digits to start Remote Receive.

Off Prints excess images or text at the bottom of a fax page without discarding it.

On Discards any excess images or text.

Auto Reduction* Automatically reduces a fax page to fit it onto the appropriate paper size.

Number of Redial 3*1 Sets the number of redial attempts to make when the destination fax number is 
busy. If you enter 0, the printer will not redial. The value is set in increments of 1.0-9

Redial Interval 1* Sets the interval between redial attempts. The value is set in increments of 1 
minute.1-15

Interval Timer 8* Sets the interval between re-send attempts. The value is set in increments of 1 
second.3-255

PB* Uses tone dialing.

DP(10PPS) Sets DP (10PPS) (Dial Pulse, 10 Pulse Per Second) as the dial type.

DP(20PPS) Sets DP (20PPS) (Dial Pulse, 20 Pulse Per Second) as the dial type.
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Prefix Dial

Purpose:

To select whether to set a prefix dial number.

Values:

Fax Cover Page

Purpose:

To set whether to attach a cover page to faxes.

Values:

Send Header

Purpose:

To print the information of the sender on the header of the faxes.

Values:

ECM

Purpose:

To set whether to enable or disable the Error Correction Mode (ECM). To use the ECM, the remote machines must 
also support the ECM.

Values:

Modem Speed

Purpose:

To adjust the fax modem speed when a fax transmission or reception error occurs.

Values:

Off* Does not set a prefix dial number.

On Sets a prefix dial number.

Prefix Dial Number Sets prefix dial number of  up to five digits. This number dials before any auto dial 
number is started. It is useful for accessing the Private Automatic Branch 
Exchange (PABX).

Off* Does not attach a cover page to faxes.

On Attaches a cover page to faxes.

Off* Does not print the sender's information on the header of faxes.

On Prints the sender's information on the header of faxes.

Off Disables the ECM.

On* Enables the ECM.

2.4 Kbps

4.8 Kbps

9.6 Kbps

14.4 Kbps

33.6 Kbps*
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Display Manual Fax Recipients

Purpose:

To set whether to display the fax number of the recipient on the sending fax screen when manually sending a fax.

Values:

• Fax Reports
Purpose:

To configure settings for fax reports.

Fax Activity

Purpose:

To set whether to automatically print a fax activity report after every 50 incoming and outgoing fax communications.

Values:

Fax Transmit

Purpose:

To set whether to print a transmission result after a fax transmission.

Values:

Fax Broadcast

Purpose:

To set whether to print a transmission result after a fax transmission to multiple destinations.

Values:

Off Does not display the fax number when manually sending a fax.

On* Displays the fax number when manually sending a fax.

Auto Print* Automatically prints a fax activity report after every 50 incoming and outgoing fax 
communications.

No Auto Print Does not automatically print a fax activity report after every 50 incoming and 
outgoing fax communications.

Print Always Prints a transmission report after every fax transmission. 

Print On Error* Prints a transmission report only when an error occurs.

Print Disable Does not print a transmission report after a fax transmission.

Print Always* Prints a broadcast report after every fax broadcast.

Print On Error Prints a broadcast report only when an error occurs.

Print Disable Does not print a broadcast report after a fax broadcast to multiple destinations.
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System Settings
Use the System Settings menu to configure a variety of printer features.

NOTE: 

• The value marked by an asterisk (*) is the factory default setting.

• General
Purpose:

To configure general settings for the printer.

Power Saver Timer

Purpose:

To specify the time for transition to the power saver mode.

Values:

When you specify 5min for Low Power Timer, the printer enters the power saver mode 5 minutes after it finishes 
a job. This uses much less energy, but requires more warm-up time for the printer. Specify 5min if your printer 
shares an electrical circuit with room lighting and you notice lights flickering.

Select a high value if your printer is in constant use. In most circumstances, this keeps the printer ready to operate 
with minimum warm-up time. Select a value between 5 and 30 minutes for Low Power Timer if you want a 
balance between energy consumption and a shorter warm-up period.

The printer automatically returns to the standby mode from the power saver mode when it receives data from the 
computer or remote fax machine. You can also change the status of the printer to the standby mode by pressing the 

(Power Saver) button on the operator panel.

Date & Time

Purpose:

To specify the date and time formats.

Values:

Measurements

Purpose:

To specify the default measurement unit displayed after the numeric value on the operator panel.

Values:

NOTE: 

• The default for Measurements varies depending on other settings, such as Region and Original Size.

Low Power Timer 5min* Specifies the time taken by the printer to enter the low power mode after it finishes 
a job.5–30min

Sleep Timer 6min* Specifies the time taken by the printer to enter the sleep mode after it has entered 
the low power mode.1–6min

Time Zone Sets the time zone.

Date Sets the date depending on the Format settings.

Format YYYY/MM/DD Sets the date format.

DD/MM/YYYY* 

MM/DD/YYYY

Time Sets the time.

Format 12 Hour Sets the time in 12-hour format.

24 Hour Sets the time in 24-hour format.

Millimeters(mm)* Selects millimeter as the default measurement unit.

Inches(") Selects inch as the default measurement unit.
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Display Brightness

Purpose:

To adjust the screen brightness of the touch panel.

Values:

Audio

Purpose:

To configure settings for tones emitted by the printer during operation or when a warning message appears.

Values:

Low Toner Alert Message

Purpose:

To specify whether to show the alert message when the toner is low.

Values:

5* Sets the brightness in 10 levels, with 10 being the brightest.

1-10

Panel Select Tone Off* Does not emit a tone when the operator panel input is correct.

Soft Emits a tone when the operator panel entry is correct.

Normal

Loud

Panel Alert Tone Off* Does not emit a tone when the operator panel entry is incorrect.

Soft Emits a tone when the operator panel entry is incorrect.

Normal

Loud

Job Tone Off* Does not emit a tone when a job is complete.

Soft Emits a tone when a job is complete.

Normal

Loud

Alert Tone Off* Does not emit a tone when a problem occurs.

Soft Emits a tone when a problem occurs.

Normal

Loud

Out of Paper Off* Does not emit a tone when the printer runs out of paper.

Soft Emits a tone when the printer runs out of paper.

Normal

Loud

Auto Clear Alert Off* Does not emit a tone 5 seconds before the printer performs auto clear.

Soft Emits a tone 5 seconds before the printer performs auto clear.

Normal

Loud

All Tones Off* Disables all the alert tones.

Soft Sets the volume of all the alert tones at once.

Normal

Loud

Off Does not show the alert message when the toner is low.

On* Shows the alert message when the toner is low.
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Off Hook Wake Up

Purpose:

To specify whether to wake up from the low power or sleep mode when you pick up the handset of the external 
telephone.

Values:

RAM Disk

Purpose:

To allocate memory to the RAM disk file system for the Secure Print features. The change becomes effective after 
the printer is turned off and then on again.

Values:

NOTE: 

• Restart your printer when you change the settings for the RAM Disk menu.

Fax Server Address Book

Purpose:

To specify whether to search the phone numbers from the Address Book for the LDAP server.

Values:

NOTE: 

• You can search the phone numbers only from the local Address Book when Fax Server Address Book is set to Off.

E-mail Server Address Book

Purpose:

To specify whether to search the e-mail addresses from the Address Book for the LDAP server.

Values:

NOTE: 

• You can search the e-mail addresses only from the local Address Book when E-mail Server Address Book is set to 
Off.

Off Does not wake up from the low power or sleep mode when you pick up the 
handset of the external telephone.

On* Wakes up from the low power or sleep mode when you pick up the handset of the 
external telephone.

Off Does not allocate memory to the RAM disk file system. Secure Print jobs will abort 
and be recorded to the job log.

On* 40 MB* Sets the allocation of memory to the RAM disk file system in increments of 40 MB.

40–80 MB

Off* Does not search the phone numbers from the Address Book for the LDAP server.

On Searches the phone numbers from the Address Book for the LDAP server.

Off* Does not search the e-mail addresses from the Address Book for the LDAP 
server.

On Searches the e-mail addresses from the Address Book for the LDAP server.
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Power On Wizard

Purpose:

To perform initial settings for the printer.

See also: 
• "Setting Initial Settings on the Operator Panel" on page 32

Values:

Show Paper Size/Type Error

Purpose:

Specifies whether to use paper of a different size when the paper that is loaded in the standard 150 sheet tray does 
not match the paper size settings for the current job.

Values:

• Timers
Purpose:

To configure timer settings.

Control Panel

Purpose:

To specify the time for the printer to automatically return to the standby mode. When the setting is not complete in 
the specified time, the previous setting is restored.

Values:

Fault Timeout

Purpose:

To specify the amount of time the printer waits before canceling a job that stops abnormally. The print job is canceled 
if the time-out time is exceeded.

Values:

Start Performs the initial settings for the printer.

On Shows the alert message when the paper size loaded in the tray is different from 
the paper size set for the current job.

On(except A4/Ltr)* Shows the alert message except for the time A4 size paper is loaded in the tray 
and letter size is set for the current job and for the other way around.

Off No tray size substitute accepted.

45 seconds*

1 Minute

2 Minute

3 Minute

4 Minute

Off Disables the fault time-out.

On* 60 sec* Sets the amount of time the printer waits before canceling a job that stops 
abnormally.3–300 sec
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Job Timeout

Purpose:

To specify the amount of time the printer waits for data to arrive from the computer. The print job is canceled if the 
time-out time is exceeded.

Values:

Maintenance
Use the Maintenance menu for maintenance work including initialization of the NVM (non-volatile memory).

NOTE: 

• The value marked by an asterisk (*) is the factory default setting.

• Adjust Paper Type
Purpose:

To adjust the paper type.

Values:

• Adjust BTR
Purpose:

To specify the optimum voltage settings for printing for the transfer roller (BTR). To lower the voltage, set negative 
values. To increase, set positive values.

The default settings may not give the best output on all paper types. If you see mottles on the print output, try to 
increase the voltage. If you see white spots on the print output, try to decrease the voltage.

NOTE: 

• The print quality changes depending on the values you select for this item.

Values:

Off Disables the job time-out.

On* 30 sec* Sets the time the printer waits for data to arrive from the computer.

5–300 sec

Plain Lightweight

Heavyweight*

Labels Lightweight

Heavyweight*

Plain 0*

-3 – 3

Bond 0*

-3 – 3

Light Card 0*

-3 – 3

LW Gloss Card 0*

-3 – 3

Labels 0*

-3 – 3

Recycled 0*

-3 – 3

Envelope 0*

-3 – 3
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• Adjust Fusing Unit
Purpose:

To specify the optimum temperature settings for printing for the fusing unit. To lower the temperature, set negative 
values. To increase, set positive values.

The default settings may not give the best output on all paper types. When the printed paper has curled, try to lower 
the temperature. When the toner does not fuse on the paper properly, try to increase the temperature.

NOTE: 

• The print quality changes depending on the values you select for this item.

Values:

• Auto Reg Adjust
Purpose: 

To automatically start adjusting color registration.

Values:

• Color Registration
Purpose:

To manually perform color registration adjustment.

Manual color registration adjustments are required when the printer is initially installed and after the printer is moved.

Values:

Plain 0*

-3 – 3

Bond 0*

-3 – 3

Light Card 0*

-3 – 3

LW Gloss Card 0*

-3 – 3

Labels 0*

-3 – 3

Recycled 0*

-3 – 3

Envelope 0*

-3 – 3

Off Does not automatically adjust color registration.

On* Automatically adjusts color registration.

Auto 
Registration

Start Automatically performs color registration correction.

Print 
Registration 
Chart

Print Prints a color registration chart. The color registration chart prints a lattice pattern 
of yellow magenta, and cyan lines. On the chart, find the values on the right side 
that are next to the line that is perfectly straight for each of the three colors. If the 
value for this line is 0, color registration adjustment is not required.

If the value for this line is any value other than 0, specify the adjustment values 
under lateral adjustment and process adjustment in Enter Registration 
values.
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NOTE: 

• Make sure that you remove the paper from the standard 150 sheet tray before performing Auto Registration.

• Clean Developer
Purpose:

To rotate the developer motor and stir the toner in the toner cartridge.

Values:

• Toner Refresh
Purpose:

To use up a toner cartridge when you need to replace it before the end of its life, or to stir the toner in a new toner 
cartridge.

Values:

• BTR Refresh
Purpose:

To specify whether to execute counter measures for curling/separating discharge of the paper.

Values:

• Machine Life
Purpose:

To specify whether to continue print operations when the printer comes to the end of its service life.

Values:

NOTE: 

• When the printer no longer operates showing the error code 191-310 on the touch panel, press the 8 and 0 buttons on the 
number pad at the same time for three seconds. The top service menu screen with message appears, and change the 
Machine Life setting to Continue Print. Then, you can keep using the printer.

• Although you can keep using the printer after the end of its service life by changing the setting to Continue Print, the 
printing quality is not guaranteed. 

Enter 
Registration 
Values

LY -5 to +5 Sets lateral (perpendicular to paper feed direction) and process (paper feed 
direction) color adjustment values individually for yellow magenta, and cyan. Enter 
a number in order of color adjustment values individually for yellow, magenta, and 
cyan.

Enter a number in order of lateral adjustment (left), lateral adjustment (right), and 
process adjustment. Select OK to save all the settings.

LM

LC

RY -5 to +5

RM

RC

Y -5 to +5

M

C

Start Stirs the toner in a new toner cartridge.

Yellow(Y) Refresh Cleans the toner in the yellow toner cartridge.

Magenta(M) Refresh Cleans the toner in the magenta toner cartridge.

Cyan(C) Refresh Cleans the toner in the cyan toner cartridge.

Black(K) Refresh Cleans the toner in the black toner cartridge.

Start Automatically executes counter measures for curling/separating discharge of the 
paper.

Continue Print Continues print operations after the end of service life.

Stop Print* Stops print operations at the end of service life.
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• Initialize NVM
Purpose:

To initialize NVM for system parameters, Address Book data for fax, or Address Book data for e-mail and server 
address. After executing this function and rebooting the printer, the menu parameters or data, except the parameters 
for the network, are reset to their factory default values.

See also: 
• "Resetting to Factory Defaults" on page 256

Values:

• Non-Genuine Toner
Purpose:

To use toner cartridges of another manufacturer.

NOTE: 

• Using a non-Fuji Xerox toner cartridge may severely damage your printer. The warranty does not cover damages caused by 
using non-Fuji Xerox toner cartridges.

Values:

• Adjust Altitude
Purpose:

To specify the altitude of the location where the printer is installed.

The discharge phenomenon for charging the photo conductor varies with barometric pressure. Adjustments are 
performed by specifying the altitude of the location where the printer is being used.

NOTE: 

• An incorrect altitude adjustment setting leads to problems such as poor printing quality and incorrect indication of remaining 
toner.

Values:

• Clear Job History
Purpose:

To clear the job history of all finished jobs.

Values:

• Adjust Touchscreen
Purpose:

To calibrate the touch panel.

User Fax Section Initialize Initializes the fax number entries in the Address Book.

User Scan Section Initialize Initializes the e-mail and server address entries in the Address Book.

System Section Initialize Initializes the system parameters.

Off* Does not use toner cartridges of another manufacturer.

On Uses toner cartridges of another manufacturer.

0m* Specifies the altitude of the location where the printer is installed.

1000m

2000m

3000m

Start Clears the log of all finished print job.
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Secure Settings
Use the Secure Settings menu to set a password to limit access to the menus. This prevents items from being 
changed accidentally.

NOTE: 

• The value marked by an asterisk (*) is the factory default setting.

• Panel Lock
Purpose:

To restrict access to Admin Settings and Report / List with a password.

See also: 
• "Panel Lock Function" on page 250

NOTE: 

• You can select Disable for Panel Lock Set when all items under Service Lock are set to Unlocked and Secure 
Receive Set is set to Disable.

Values:

• Service Lock
Purpose:

To specify whether to enable each of the printer services or to require a password to use the services, and to set or 
change the password.

See also: 
• "Limiting Access to Printer Operations" on page 252

NOTE: 

• You can access to the items under Service Lock only when Panel Lock Set is set to Enable.

Values:

Panel Lock Set Disable* Does not restrict access to Admin Settings and Report / List with a 
password.

Enable Restricts access to Admin Settings and Report / List with a password.

Change 
Password

0000*–9999 Sets or changes the password required to access Admin Settings and 
Report / List.

Copy Unlocked* Enables the Copy service.

Password 
Locked

Enables the Copy service, but requires a passcode to use the 
service.

Color Password 
Locked

Enables the Copy service with a color mode, but requires a 
passcode.

Locked Disables the Copy service.

E-mail Unlocked* Enables the E-mail service.

Password 
Locked

Enables the E-mail service, but requires a passcode to use the 
service.

Locked Disables the E-mail service.

Fax Unlocked* Enables the Fax service.

Password 
Locked

Enables the Fax services, but requires a passcode to send faxes 
(does not require a passcode to receive incoming faxes).

Locked Disables the Fax service (the printer will not send or receive faxes).

Scan to Network Unlocked* Enables the Scan To Network service.

Password 
Locked

Enables the Scan To Network service, but requires a passcode to 
use the service.

Locked Disables the Scan To Network service.
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*1 WSD stands for Web Services on Devices.

• Edit E-mail From Field
Purpose:

To specify whether to enable editing of the transmission source when you use Scan to E-mail.

Values:

• Confirm Recipients

NOTE: 

• If the Confirm Recipients menu is set to Confirm Recipient, recipients can only be selected from Fax Address 
Book. You cannot directly enter an address or fax number.

Purpose:

To specify whether to confirm the recipient before sending a fax or scan.

Values:

• Domain Filtering

NOTE: 

• Set the domains from SMTP Domain Filtering on the CentreWare Internet Services.

Purpose:

To specify whether to only send e-mails to specified domains.

Scan To PC / WSD Scan*1 Unlocked* Enables the Scan To PC / WSD (Web Services on Devices) Scan 
service.

Password 
Locked

Enables the Scan To PC / WSD (Web Services on Devices) Scan 
service, but requires a passcode to use the service.

Locked Disables the Scan To PC / WSD (Web Services on Devices) Scan 
service.

Scan To USB Unlocked* Enables the Scan To USB service.

Password 
Locked

Enables the Scan To USB service, but requires a passcode to use 
the service.

Locked Disables the Scan To USB service.

Print from USB Unlocked* Enables the Print from USB service.

Password 
Locked

Enables the Print from USB service, but requires a passcode.

Color Password 
Locked

Enables the Print from USB service with a color mode, but requires 
a passcode.

Locked Disables the Print from USB service.

ID Card Copy Unlocked* Enables the ID Card Copy service.

Locked Disables the ID Card Copy service.

USB 
Services

Show USB 
Pop Up 
Menu

Disable Does not show the USB Drive Detected menu when a USB 
storage device is inserted in to the printer.

Enable* Shows the USB Drive Detected menu when a USB storage 
device is inserted in to the printer.

Display 
USB Memory 
Services

Hide until USB 
inserted

Hides menus concerning USB storage device until a USB storage 
device is inserted to the printer.

Always 
Display*

Menus concerning USB storage device are shown without a USB 
storage device inserted to the printer.

Change Password Changes the passcode that is set under the Service Lock menu.

Disable Disables editing of the transmission source.

Enable* Enables editing of the transmission source.

No Confirmation* Does not display a screen to reconfirm the recipient before the job is actually sent.

Reconfirm Recipient Displays a screen to reconfirm the recipient before the job is actually sent.
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Values:

• Software Download
Purpose:

To enable or disable download of firmware updates.

Values:

• Display of Network Information
Purpose:

To show or hide network information in the message field of the top service menu screen.

Values:

• Login Attempts

NOTE: 

• Login Attempts feature is available only when Panel Lock Set is set to Enable.

Purpose:

To specify the number of error entry attempts allowed when you log in as an administrator in the Admin Settings 
and Report / List menu.

Values:

USB Setup
Use the USB Settings menu to change printer settings affecting a USB port.

NOTE: 

• The value marked by an asterisk (*) is the factory default setting.

• Port Status
Purpose:

To enable or disable the USB interface.

Values:

Disable* Disables Domain Filtering.

Enable Only allows e-mails to be sent to specified domains.

Disable Disables firmware updates.

Enable* Enables firmware updates.

Show IPv4 Address* Shows the IPv4 address of the printer.

Show Host Name Shows the host name of the printer.

Hide Network Information Does not show network information.

Off* Does not allow an administrator to log in after one error entry attempt.

On 5* Sets the number of error entry attempts allowed when an administrator logs in.

1-10

Disable Disables the USB interface.

Enable* Enables the USB interface.
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• PS Data Format
Purpose:

To specify the PostScript 3 Compatible communication protocol. You can configure the PS Data Format settings 
for the wired network.

Values:

Defaults Settings
Use the Defaults Settings menu to configure the default copy, scan, and fax settings of the printer. 

Copy Defaults
Use the Copy Defaults menus to configure a variety of copy features.

NOTE: 

• The value marked by an asterisk (*) is the factory default setting.

• Output Color
Purpose:

To select color or black and white copying.

Values:

• Collation
Purpose:

To sort the copy job.

Values:

• Reduce / Enlarge
Purpose:

To set the default copy reduction/enlargement ratio.

Values:

mm series

Auto* Sets the PostScript 3 Compatible communications protocol automatically.

Standard Sets the PostScript 3 Compatible communications protocol to Standard.

BCP Sets the PostScript 3 Compatible communications protocol to BCP.

TBCP Sets the PostScript 3 Compatible communications protocol to TBCP.

Full Color* Copies in color mode.

Black & White Copies in black and white mode.

Uncollated* Does not sort the copy job.

Collated Sorts the copy job.

100%*

50%

70%
A4A5

84%
B5A5

118%
A5B5
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inch series

NOTE: 

• You can also use the number pad to input the desired zoom ratio from 25% to 400%, or select  to enlarge the zoom ratio or 
select  to reduce the zoom ratio in 1% intervals.

• This item is available only when Sides Per Pages is set to Off or Manual.

• Original Size
Purpose:

To specify the default document size.

Values:

mm series

*1 The default for Original Size varies depending on region-specific factory.

inch series

*1 The default for Original Size varies depending on region-specific factory.

NOTE: 

• When Auto is selected, the printer assumes that the document size is the size of the print media loaded in the standard 150 
sheet tray.

141%
A5A4

200%

100%*

50%

64%

78%
8.5  14"8.5  11"

129%
8.5  11"8.5  14"

154%

200%

A4*1

A5

B5

Letter

US Folio

Legal

Executive

Letter

US Folio

Legal

A4*1

A5

B5

Executive
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• Original Type
Purpose:

To select the copy image quality.

Values:

• Lighten / Darken
Purpose:

To set the default copy density level.

Values:

• Sharpness
Purpose:

To set the default sharpness level.

Values:

• Auto Background Suppression
Purpose:

To suppress the background of the original to enhance text on the scanned image.

Values:

• Color Balance
Color Balance

Purpose:

To specify the default color balance level within the range of -3 to +3.

Values:

Photo & Text* Suitable for documents with both text and photos/gray tones.

Text Suitable for documents with text.

Photo Suitable for documents with photos.

Lighten2 Makes the copy lighter than the original. Works well with dark print. 

Lighten1

Normal* Works well with standard type or printed documents. 

Darken1 Makes the copy darker than the original. Works well with light print or faint pencil 
markings. Darken2

Sharpen2 Makes the scanned image sharper than the original.

Sharpen1

Normal* Does not make the scanned image sharper or softer than the original.

Soften1 Makes the scanned image softer than the original.

Soften2

Off Does not suppress the background.

On* Suppresses the background of the original to enhance text on the scanned image.

Red -3 to +3 Sets the color balance level of density red.

Green -3 to +3 Sets the color balance level of density green.

Blue -3 to +3 Sets the color balance level of density blue.
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Gray Balance

Purpose:

To specify the default gray balance level within the range of -3 to +3.

Values:

• Sides Per Pages
Purpose:

To print two original pages to fit onto one sheet of paper.

Values:

• Edge Erase
Purpose:

To specify the value of the top and bottom margins.

Values:

• Paper Error
Purpose:

To specify whether to display the paper size error.

Values:

Fax Defaults
Use the Fax Defaults menus to configure a variety of fax features.

NOTE: 

• The Fax service cannot be used unless you set up a region code under Region. The touch panel displays an error message 
when the region code is not set up.

• The value marked by an asterisk (*) is the factory default setting.

Gray -3 to +3 Sets the color balance level of density gray.

Off* Does not perform multiple-up printing.

Auto Automatically reduces the original pages to fit onto one sheet of paper.

Manual Prints the original pages onto the one sheet of paper in the size specified in 
Reduce/Enlarge.

Top/Bottom
(050 mm)
(02.0 inch)

4* mm (0.2* inch) Sets the value in increments of 1 mm (0.1 inch).

Left/Right
(050 mm)
(02.0 inch)

4* mm (0.2* inch) Sets the value in increments of 1 mm (0.1 inch).

Middle
(050 mm)
(02.0 inch)

0* mm (0* inch) Sets the value in increments of 1 mm (0.1 inch).

Off*

On
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• Resolution
Purpose:

To specify the resolution level to be used for fax transmission.

Values:

NOTE: 

• Faxes scanned in the Super Fine mode transmit at the highest resolution supported by the receiving device.

• Original Type
Purpose:

To select the default document type.

Values:

• Lighten / Darken
Purpose:

To set the default copy density level.

Values:

• Delayed Send
Purpose:

To set a specific time for the fax transmission to start. Once the Delayed Send is activated, your printer stores all of 
the documents to be faxed into its memory and sends them at the specified time. After faxing in the Delayed Send 
mode is complete, the data in the memory is cleared.

Values:

Standard* Suitable for documents with normal sized characters. 

Fine Suitable for documents containing small characters or thin lines or documents 
printed using a dot-matrix printer. 

Super Fine Suitable for documents containing extremely fine detail. The Super Fine mode 
is enabled only if the receiving device also supports the super fine resolution. See 
the notes below.

Ultra Fine Suitable for documents containing photographic images.

Text* Suitable for documents with text.

Photo Suitable for documents with photos.

Lighten2 Makes the fax lighter than the original. Works well with dark print. 

Lighten1

Normal* Works well with standard typed or printed documents. 

Darken1 Makes the fax darker than the original. Works well with light print or faint pencil 
markings. Darken2

Hours Specifies the fax transmission start time when sending a fax at a specified time. 

Minutes
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Scan Defaults
Use the Scan Defaults menus to configure a variety of scanner features.

NOTE: 

• The value marked by an asterisk (*) is the factory default setting.

• File Format
Purpose:

To specify the file format to save the scanned image.

Values:

• Output Color
Purpose:

To specify whether to scan in color, black and white, or gray scale.

Values:

• Resolution
Purpose:

To specify the default scan resolution.

Values:

• Original Size
Purpose:

To specify the default document size.

Values:

mm series

*1 The default for Original Size varies depending on region-specific factory.

PDF*

Multi-Page TIFF

TIFF

JPEG

Color* Scans in color.

Black & White Scans in black and white.

Gray Scale Scans in gray scale.

200 dpi*

300 dpi

400 dpi

600 dpi

A4*1

A5

B5

Letter

US Folio

Legal

Executive
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inch series

*1 The default for Original Size varies depending on region-specific factory.

• Lighten / Darken
Purpose:

To set the default scan density level.

Values:

• Sharpness
Purpose:

To set the default sharpness level.

Values:

• Auto Background Suppression
Purpose:

To suppress the background of the original to enhance text on the scanned image.

Values:

Letter

US Folio

Legal

A4*1

A5

B5

Executive

Lighten2 Makes the scanned image lighter than the original. Works well with dark print. 

Lighten1

Normal* Works well with standard type or printed documents. 

Darken1 Makes the scanned image darker than the original. Works well with light print or 
faint pencil markings. Darken2

Sharpen2 Makes the scanned image sharper than the original.

Sharpen1

Normal* Does not make the scanned image sharper or softer than the original.

Soften1 Makes the scanned image softer than the original.

Soften2

Off Does not suppress the background.

On* Suppresses the background of the original to enhance text on the scanned image.
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• Edge Erase
Purpose:

To specify the value of the top and bottom margins.

Values:

• TIFF File Format
Purpose:

To specify the default TIFF file format.

Values:

• Quality / File Size
Purpose:

To specify the image compression level.

Values:

• Max E-Mail Size
Purpose:

To specify the maximum size of e-mail that can be sent, within the range of 50 K bytes to 16384 K bytes. The default 
is 2048 K bytes.

• File Name
Purpose:

To specify the detailed setting for file name.

Values:

Top/Bottom
(050 mm)
(02.0 inch)

2* mm (0.1* inch) Sets the value in increments of 1 mm (0.1 inch).

Left/Right
(050 mm)
(02.0 inch)

2* mm (0.1* inch) Sets the value in increments of 1 mm (0.1 inch).

Middle
(050 mm)
(02.0 inch)

0* mm (0* inch) Sets the value in increments of 1 mm (0.1 inch).

TIFF V6 Sets the default TIFF file format to TIFF V6.

TTN2* Sets the default Tiff file format to TTN2.

Small Sets the image compression level to smaller.

Normal* Sets the image compression level to Normal.

Large Sets the image compression level to larger.

Auto* Sets the default file name.

Add Prefix Adds texts in front of the file name.

Text String Specifies the texts that are added when Add Prefix is selected.

Add Suffix Adds texts after the file name.

Text String Specifies the texts that are added when Add Suffix is selected.
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• Create Folder
Purpose:

To specify whether to create a folder when saving scanned images.

Values:

Print from USB Defaults
To modify the defaults for the Print from USB menu.

NOTE: 

• The value marked by an asterisk (*) is the factory default setting.

• Output Color
Purpose:

To specify whether to print in black and white or in color.

Values:

• Sides Per Pages
Purpose:

To print two or four original pages to fit onto one sheet of paper.

Values:

• PDF Password
Purpose:

To enter the password when you print the secure PDF job.

Values:

Paper Tray Settings
Use the Tray Contents menu to define the print media loaded in the standard 150 sheet tray.

NOTE: 

• The value marked by an asterisk (*) is the factory default setting.

Purpose:

To specify the default paper size loaded in the standard 150 sheet tray.

Values:

Off Does not create a folder when saving a scanned image.

On* Creates a folder when saving a scanned image.

Full Color* Prints in color.

Black & White Prints in black and white.

Off* Prints one page on one side of a sheet of paper.

2 Sides per Page Prints two pages on one side of a sheet of paper.

4 Sides per Page Prints four pages on one side of a sheet of paper.

Enter PDF Password Enter the password to print the secure PDF job.

Display Tray Prompt Enter a check to display a pop-up message that prompts to set Type and Size when paper is 
loaded in the standard 150 sheet tray. The factory default is on (check).
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*1 The default for Size varies depending on region-specific factory.

NOTE: 

• For more information on supported paper sizes, see "Usable Print Media" on page 95.

Size

mm series

A4*1

A5

B5

Monarch Env.

Letter

Folio (8.5  13")

Legal

Executive

#10 Env.

Monarch L

DL Env.

DL Env. L

C5 Env.

Custom Size Width (x) 210 mm* Specifies the width of 
the custom size paper.77 – 215 mm

Length (y) 297 mm* Specifies the length of 
the custom size paper.127 – 355 mm 

inch series Letter

US Folio

Legal

Monarch Env.

A4*1

A5

B5

Executive

#10 Env.

Monarch L

DL Env. 

DL Env. L

C5 Env.

Custom Size Width (x) 8.3 inches* Specifies the width of 
the custom size paper.3.0 – 8.5 inches

Length (y) 11.7 inches* Specifies the length of 
the custom size paper.5.0 – 14.0 inches 

Type Plain*1

Bond

Light Card

LW Gloss Card

Labels

Recycled

Envelope

Plain S2

Bond S2

Light Card S2

LW Gloss Card S2

Recycled S2
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Language Settings

Panel Settings

NOTE: 

• The value marked by an asterisk (*) is the factory default setting.

Purpose:

To determine the language of the text on the touch panel.

Values:

Keyboard Layout

NOTE: 

• The value marked by an asterisk (*) is the factory default setting.

Purpose:

To determine the keyboard layout of the touch panel.

Values:

English*

Traditional Chinese

Simplified Chinese

Korean

QWERTY*

AZERTY

QWERTZ
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Panel Lock Function

When your printer is configured as a network printer available to a number of users, the access to Admin 
Settings and Report / List can be limited by enabling the Panel Lock function. This prevents unauthorized 
users from changing the settings made by the administrator. However, you can select settings for individual print 
jobs using the print driver.

Enabling the Panel Lock

1 Press the  (System) button.

2 Select the Tools tab.

3 Select Admin Settings.

4 Select Secure Settings.

5 Select Panel Lock.

6 Select Panel Lock Set.

7 Select Enable, and then select OK.

8 Enter the new passcode, and then select OK.

9 Re-enter the passcode to confirm the passcode that you entered, and then select OK.

NOTE: 

• Be sure to remember the password. The procedure described below allows you to reset the password. However, the settings 
for the Address Book would be cleared.

1 Turn off the printer.

2 Turn on the printer with holding the  (System) button.

Changing the Panel Lock Password

1 Press the  (System) button.

2 Select the Tools tab.

3 Select Admin Settings.

4 Select Secure Settings.

5 Select Panel Lock.

6 Select Change Password.

7 Enter the current passcode, and then select OK.

8 Enter the new passcode, and then select OK.

9 Re-enter the passcode to confirm the passcode that you entered, and then select OK.
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Disabling the Panel Lock

NOTE: 

• You can select Disable for Panel Lock Set when all items under Service Lock are set to Unlocked and Secure 
Receive Set is set to Disable.

1 Press the  (System) button.

2 Select the Tools tab.

3 Select Admin Settings.

4 Enter the new passcode, and then select OK.

5 Select Secure Settings.

6 Select Panel Lock.

7 Select Panel Lock Set.

8 Select Disable, and then select OK.

9 Enter the current passcode, and then select OK.
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Limiting Access to Printer Operations

Enabling the Copy lock, E-mail lock, Fax lock, Scan lock, Print from USB lock, and ID Card Copy lock options limits 
access to copy, e-mail, fax, scan, Print from USB, and ID card copy operations.

Taking Fax lock as an example, the following procedure explains how to enable or disable the option. Use the same 
procedure to enable or disable the Copy lock, E-mail lock, Fax lock, Scan lock, Print from USB lock, and ID Card 
Copy lock.

1 Press the  (System) button.

2 Select the Tools tab.

3 Select Admin Settings.

4 Select Secure Settings.

5 Select Panel Lock.

6 Select Panel Lock Set.

7 Select Enable, and then select OK.

8 Enter the new passcode using the number pad and then select OK.

9 Re-enter the passcode and then select OK.

NOTE: 

• The default password is 0000.

10 Select .

11 Select Service Lock.

12 Select FAX.

13 Select one of the following option, and then select OK.

• Unlocked

• Password Locked

• Locked

• Color Password Locked (available only for the Copy lock and Print from USB lock)
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Changing the Language

To change language used on the operator panel:

1 Press the  (System) button.

2 On the Tools tab, select Language Settings, and then select Panel Settings.

3 Select the desired language.

4 Select OK.
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Setting the Time for the Power Saver Mode

The printer switches to the power saver mode after the specified time.

See also: 
• "Power Saver Mode" on page 35

1 Press the  (System) button.

2 Select the Tools tab.

3 Select Admin Settings.

4 Select System Settings.

5 Select General, and then select Power Saver Timer.

6 Select Low Power Timer or Sleep Timer.

7 Enter the desired value using  or , or using the number pad, and then select OK. 

You can select from 5 – 30 minutes for Low Power Timer or 1 – 6 minutes for Sleep Timer.

8 To return to the previous screen, select  .
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About the Concurrent Jobs Feature

This feature enables you to start a concurrent job while a fax job is running. This is performed by temporally 
displaying the top service menu screen and switching to a different function that can be run concurrently such as 
copy or scan.

1 While the printer is sending or receiving a fax, press the  (Services Home) button.

2 Select Copy or Scan To.

3 After setting the copy or scan options, press the  (Start) button.

For details about Copy or Scan To, see "Copying" on page 125 or "Scanning" on page 139.
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Resetting to Factory Defaults

After executing Initialize NVM and rebooting the printer, the menu parameters or data are reset to their factory 
default values.

NOTE: 

• The following procedure does not initialize the network settings.

– To initialize the network settings, refer to "Reset Network Setup" on page 220.

– To reset the wireless connection settings, refer to "Reset Wireless" on page 218.

1 Press the  (System) button.

2 Select the Tools tab.

3 Select Admin Settings.

4 Select Maintenance.

5 Select Initialize NVM.

6 Select the desired setting.

7 Select Initialize.

The printer restarts automatically to apply the settings.



Using the Operator Panel Menus and Keypad 257

Entering Characters

 Using the Keyboard Displayed on the Touch Panel
During operations, a screen for entering text sometimes appears. The following describes how to enter text.

You can enter the following characters: numerals, alphabets, and symbols.

 Using the Number Pad
As you perform various tasks, you may need to enter numbers. For example, when you specify the quantity of 
copies or when you enter fax number directly.

Available Characters
You can enter the characters as follows by using the number pad: 0 to 9, * and #.

Changing Numbers
If you make a mistake while entering a number, press the  (Clear All) button to delete the last digit or character. 
Then enter the correct number.

QWERTY AZERTY QWERTZ

Item Description

Entering alphabets and 
numerals

To enter uppercase letters, select . To return to the lowercase letters, select  again.

Entering symbols Select .

Entering a space Select  or  (when the language of the text on the touch panel is not English).

Deleting characters Select  to delete one character at a time.
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10
Using the Server Address Book and Server 
Phone Book

• "Setting Server Address Book and Server Phone Book" on page 259
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Setting Server Address Book and Server Phone Book

With server address book and server phone book, you can specify an e-mail address or fax number of a recipient 
registered in the external LDAP server when sending a scanned image with e-mail or fax.

To use the server address book and server phone book, the printer needs to be configured in order to access the 
external LDAP server.

NOTE: 

• To configure the settings of the external LDAP server, consult your system administrator.

• You must also set E-mail Server Address Book and Fax Server Address Book to On to specify recipients using the 
server address book and server phone book. For details, see "E-mail Server Address Book" on page 230 and "Fax Server 
Address Book" on page 230.

1 Launch your web browser.

2 Enter the IP address of the printer in the address bar, and then press the Enter key.

The printer's web page appears.

NOTE: 

• For details on how to check the IP address of the printer, see "Verifying the IP Settings" on page 59.

3 Click Properties tab. Click Authentication System under Security.

4 From the Authentication System Settings drop-down menu, select Kerberos or LDAP as the authentication 
method you are using, and then click Apply.

If you select Kerberos in this step, go to step 5.

If you select LDAP in this step, go to step 7.

5 Click Properties tab. Click Kerberos Server under Security.

6 Specify the settings under Kerberos Server, and then click Apply.

7 Click Properties tab. Click LDAP Authentication under Security.

8 Specify the settings under LDAP Authentication, and then click Apply.

9 Click Properties tab. Click LDAP Server under Protocol Settings.

10 Specify the settings under LDAP Server, and then click Apply.

11 Click Properties tab. Click LDAP User Mapping under Protocol Settings.

Specify the attribute names used in the LDAP server. If the attribute names are not customized in the LDAP 
server, leave the settings in this step as they are by default.

Now the settings are complete. See "Sending an E-mail With the Scanned File" on page 167 or "Sending a Fax 
Automatically" on page 180 to use the address information in the external server for sending e-mails or faxes.
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11
Digital Certificates

• "Using Digital Certificates" on page 261
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Using Digital Certificates

The authentication feature using digital certificates upgrades security when sending print data or setting data.

To use digital certificates, set the digital certificate on the printer, and then enable various SSL/TLS communication. 

NOTE: 

• For information about the digital certificate error, see "Understanding Printer Messages" on page 305 and "Digital Certificate 
Problems" on page 303.

Setting a Digital Certificate
The following is a typical setup flow for setting digital certificates.

Preparing to Use HTTPS Communication
Before managing digital certificates, set HTTPS communication with a self-signed certificate.

1 Launch the CentreWare Internet Services by entering IP address of the printer in your web browser.

For more information, see "CentreWare Internet Services" on page 38.

2 Click the Properties tab.

3 Click SSL/TLS Server Communication under Security.

4 Click Create New Certificate.

The Generate Certificate page is displayed.

5 Select the size of the public key from the list of Public Key Size.

6 Specify the issuer of SSL self-signed certificate.

7 Click Generate Certificate.

Your request was successfully processed. is displayed.

8 Click Back.

9 Select the Enabled check box of SSL/TLS Server Communication, and then click Apply.

Settings have been changed. Reboot system for new settings to take effect. is displayed.

10 Click Reboot Machine.

Prepare the printer for HTTPS Communication using a 
self-signed certificate. For details, see "Preparing to 
Use HTTPS Communication" on page 261.

Export the Certificate Signing Request (CSR) from the 
printer. For details, see "Exporting a Certificate Signing 
Request (CSR)" on page 262.

Receive a signed certificate from a certificate authority 
using the Certificate Signing Request (CSR) exported 
from the printer.

Upload a signed certificate. For details, see "Uploading 
a Signed Certificate" on page 262.



262 Digital Certificates

Exporting a Certificate Signing Request (CSR)

NOTE: 

• To export a CSR from the printer, SSL/TLS Server Communication must be enabled with a self-signed certificate. For 
details, see "Preparing to Use HTTPS Communication" on page 261.

• If you are going to use a PKCS #12 digital certificate, do not export the CSR. The text box to enter the password when 
uploading the PKCS #12 digital certificate is displayed only when the CSR is not exported.

1 Launch the CentreWare Internet Services by entering IP address of the printer in your web browser.

For more information, see "CentreWare Internet Services" on page 38.

2 Click the Properties tab.

3 Click SSL/TLS Server Communication under Security.

4 Click Certificate Signing Request (CSR).

The Certificate Signing Request (CSR) page is displayed.

5 Specify each item of the certificate signing request.

6 Click Apply.

7 Confirm the settings of the certificate signing request, and then click Export.

8 Save a CSR file to your computer.

Use this CSR to receive a signed certificate from a trusted certificate authority.

Uploading a Signed Certificate
After you have received the signed certificate from a trusted certificate authority, upload the signed certificate to the 
printer. You can also upload a PKCS #12 digital certificate that you created without using the CSR from the machine.

NOTE: 

• The maximum number of digital certificates that you can upload is one.

1 Launch the CentreWare Internet Services by entering IP address of the printer in your web browser.

For more information, see "CentreWare Internet Services" on page 38.

2 Click the Properties tab.

3 Click SSL/TLS Server Communication under Security.

4 Click Upload Signed Certificate.

The Upload Signed Certificate page is displayed.

5 When uploading a PKCS #12 digital certificate, enter the password that is set on the digital certificate.

NOTE: 

• Password is displayed only when the CSR is not exported from the printer.

If you are uploading a digital certificate that you received using the CSR from the printer, proceed to step 7.

6 Re-enter the password for confirmation.

7 Click Choose File of File Name, and select the file to be imported.

8 Click Import.
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Managing the Digital Certificate

NOTE: 

• To manage digital certificates, you must have a digital certificate set on the printer. For details, see "Setting a Digital 
Certificate" on page 261.

Confirming the Settings of a Digital Certificate

1 Launch the CentreWare Internet Services by entering IP address of the printer in your web browser.

For more information, see "CentreWare Internet Services" on page 38.

2 Click the Properties tab.

3 Click SSL/TLS Server Communication under Security.

4 Click Certificate Management.

The Certificate Management page is displayed.

Deleting a Digital Certificate

1 Launch the CentreWare Internet Services by entering IP address of the printer in your web browser.

For more information, see "CentreWare Internet Services" on page 38.

2 Click the Properties tab.

3 Click SSL/TLS Server Communication under Security.

4 To delete both the signed certificate and the self-signed certificate, click Delete All Certificates.

To delete just the digital certificate that is currently in use, proceed to step 5.

5 Click Certificate Management.

The Certificate Management page is displayed.

6 Click Delete at the upper-right corner.

7 Click Delete.

NOTE: 

• When a digital certificate is deleted, the features associated with the deleted digital certificate are disabled. To delete a 
digital certificate being used, disable the feature in advance or switch the association to another digital certificate, and 
then switch to another operation mode if possible before deleting the digital certificate.

- For an SSL Server, switch to another certificate such as a self-signed certificate.

- For an SSL Client, set the LDAP-SSL/TLS setting to OFF.
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Setting the SSL/TLS Communication Feature

Setting SSL/TLS Server Communication
Set the SSL/TLS Server Communication to use encrypted communication between HTTP and SMTP servers.

1 Launch the CentreWare Internet Services by entering IP address of the printer in your web browser.

For more information, see "CentreWare Internet Services" on page 38.

2 Click the Properties tab.

3 Click SSL/TLS Server Communication under Security.

4 Confirm that the Enabled check box of SSL/TLS Server Communication is displayed.

NOTE: 

• If Disabled is displayed instead of a check box, the digital certificate is not set. For details, see "Setting a Digital 
Certificate" on page 261.

5 Select the Enabled check box of SSL/TLS Server Communication.

6 Click Apply.

Settings have been changed. Reboot system for new settings to take effect. is displayed.

7 Click Reboot Machine.

After restarting the printer, communication is encrypted when communicating with HTTP or SMTP.

Setting the LDAP-SSL/TLS Communication

1 Launch the CentreWare Internet Services by entering IP address of the printer in your web browser.

For more information, see "CentreWare Internet Services" on page 38.

2 Click the Properties tab.

3 Click SSL/TLS Server Communication under Security.

4 Select the Enabled check box of LDAP-SSL/TLS Communication.

5 Click Apply.

Settings have been changed. Reboot system for new settings to take effect. is displayed.

6 Click Reboot Machine.

After restarting the printer, LDAP-SSL/TLS Communication is enabled.
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Clearing Jams

Careful selection of appropriate print media and proper loading allow you to avoid most jams. 

See also: 
• "About Print Media" on page 92

• "Supported Print Media" on page 95

NOTE: 

• Before buying large quantities of any print media, it is recommended that you try a sample first.

Avoiding Jams
• Use only recommended print media. For details, see "About Print Media" on page 92.

• See "Loading Print Media in the Standard 150 Sheet Tray" on page 96 to load print media properly.

• Do not overload the print media sources. Make sure that the stacked print media does not exceed the 
maximum height indicated on the paper width guides.

• Do not load wrinkled, creased, damp, or curled print media.

• Flex, fan, and straighten print media before you load it. If a jam occurs with print media, try feeding one sheet at 
a time through the standard 150 sheet tray.

• Do not use print media that you have cut or trimmed.

• Do not mix print media sizes, weights, or types in the same print media source.

• Make sure that the recommended print side is facing up when you insert the print media.

• Keep print media stored in an acceptable environment. For details, see "Print Media Storage Guidelines" on 
page 94.

• Make sure that all cables connected to the printer are correctly inserted.

• Overtightening the guides may cause jams.
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 Identifying the Location of Paper Jams

IMPORTANT: 
• Do not attempt to clear any jams using tools or instruments. This may permanently damage the printer. 

The following illustration shows where paper jams may occur along the print media path.

CAUTION:

• Do not attempt to remove a paper deeply jammed inside the product, particularly a paper wrapped around the fusing 
unit or the heat roller. Otherwise, it may cause injuries or burns. Switch off the product immediately and contact 
your local Fuji Xerox representative.

1 Center Output Tray

2 Transfer Belt

3 Levers

4 Rear Cover

5 ADF Cover

6 Standard 150 Sheet Tray

3
21

4

6

5
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Clearing Paper Jams From the ADF
When a document jams while it passes through the automatic document feeder (ADF), remove jams in the following 
procedure.

IMPORTANT: 

• To prevent electric shock, always turn off the printer and disconnect the power cord from the grounded outlet before 
performing maintenance.

• To avoid burns, do not clear paper jams immediately after printing. The fusing unit becomes extremely hot during use.

NOTE: 

• To resolve the error displayed on the touch panel, you must clear all print media from the print media path.

1 Open the ADF cover.

2 Remove the jammed document by carefully pulling it in the direction of the arrow shown in the following 
illustration.

3 If you find it difficult to pull the document, open the document feeder tray.
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4 Remove the jammed document from the document output tray.

5 Close the document feeder tray.

6 Close the ADF cover, and then load the documents back into the ADF.

NOTE: 

• Make sure that you adjust the document guides before printing a legal-size document.

7 If you cannot remove the jammed document from the document output tray or cannot find any jammed 
document there, open the document cover.
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8 Remove the document from the ADF feed roller or the feed area by carefully pulling the document in the 
direction of the arrow shown in the following illustration.

Clearing Paper Jams From the Front of the Printer

NOTE: 

• To resolve the error displayed on the touch panel, you must clear all print media from the print media path.

1 Lift up the cover above the standard 150 sheet tray, and remove any paper jammed from the front of the printer.

2 Release the cover above the standard 150 sheet tray.
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Clearing Paper Jams From the Rear of the Printer

IMPORTANT: 

• To prevent electric shock, always turn off the printer and disconnect the power cord from the grounded outlet before 
performing maintenance.

• To avoid burns, do not clear paper jams immediately after printing. The fusing unit becomes extremely hot during use.

NOTE: 

• To resolve the error displayed on the touch panel, you must clear all print media from the print media path.

1 Push the rear cover handle and open the rear cover.

2 Lift up the levers.

3 Remove any paper jammed from the rear of the printer by carefully pulling it in the direction of the arrow shown 
in the following illustration.



272 Troubleshooting

4 Lower the levers to their original position.

5 Close the rear cover.
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Clearing Paper Jams From the Center Output Tray

IMPORTANT: 

• To prevent electric shock, always turn off the printer and disconnect the power cord from the grounded outlet before 
performing maintenance.

• To avoid burns, do not clear paper jams immediately after printing. The fusing unit becomes extremely hot during use.

NOTE: 

• To resolve the error displayed on the touch panel, you must clear all print media from the print media path.

1 Push the rear cover handle and open the rear cover.

2 Lift up the levers.

3 Remove any paper jammed from the rear of the printer by carefully pulling it in the direction of the arrow shown 
in the following illustration.
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4 If no paper is found in the paper path, remove any paper jammed from the center output tray.

5 Lower the levers to their original position.

6 Close the rear cover.
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Jam Problems

Misfeed jam

NOTE: 

• If the problem continues even though you have taken suggested actions described above, contact the Fuji Xerox local 
representative office or an authorized dealer.

Multi-feed jam

NOTE: 

• If the problem continues even though you have taken suggested actions described above, contact the Fuji Xerox local 
representative office or an authorized dealer.

Problem Action

Print media misfeeds occur. Make sure that the standard 150 sheet tray is properly inserted.

If the problem persists, verify that the correct print media is being used.

Depending on the print media you use, take any of the following actions:

• For thick paper, use the one that is 163 gsm or less.

• For thin paper, use the one that is 60 gsm or more.

• For the envelope, make sure that it is properly loaded in the standard 150 
sheet tray as instructed in "Loading Envelope in the Standard 150 Sheet Tray" 
on page 98.

If the envelope is deformed, correct it or use another envelope.

If performing manual duplex printing, make sure that the print media is not curled.

Fan the print media.

If the print media is damp, turn over the print media.

If the problem continues, use print media that is not damp. 

Problem Action

Print media multiple feeds occur. Make sure that the tray or feeder is properly inserted.

If the print media is damp, use print media that is not damp.

Fan the print media. 

A document jam occurs in the ADF if 
scanning of multiple-sheet document 
is canceled while scanning is in 
progress.

Clear the jam. 

See also: 
• "Clearing Paper Jams From the ADF" on page 268
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Basic Printer Problems

Some printer problems can be easy to resolve. If a problem occurs with your printer, check each of the following:

• The power cord is connected to the printer, and to a properly grounded electrical outlet.

• The printer is turned on.

• The electrical outlet is not turned off at any switch or breaker.

• Other electrical equipment plugged into the outlet is working.

• When your printer is connected to the computer with the wireless connection, the Ethernet cable is not 
connected between the printer and the network.

If you have checked all of the above and still have a problem, turn off the printer, wait for 10 seconds, and then turn 
on the printer. This often fixes the problem.

NOTE: 

• If error messages are displayed on the touch panel or on your computer screen, follow the on-screen instructions to resolve 
the printer problems. For details about error messages and error codes, see "Understanding Printer Messages" on page 305.
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Display Problems

Problem Action

Menu settings changed from the 
operator panel have no effect.

Settings in the print driver, or printer utilities have precedence over the settings 
made on the operator panel.

Change the menu settings from the print driver or printer utilities instead of the 
operator panel.
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Printing Problems

Problem Action

Job did not print or incorrect 
characters printed.

Confirm that the top service menu screen appears on the touch panel before you 
send a job to print. Press the  (Services Home) button to return to the top 
service menu screen.

Make sure that print media is loaded in the printer.

Verify that you are using the correct print driver.

If you are using wireless connection, make sure that the wireless connection is 
established.

If you are using USB connection, make sure that you are using the correct USB 
cable and that it is securely connected to the printer.

Verify that the correct print media size is selected.

If you are using a print spooler, verify that the spooler has not stalled.

Check the interface of your printer from Admin Settings.

Determine the host interface you are using. Print a System Settings page to verify 
that the current interface settings are correct. See "Printing a System Settings 
Page" on page 122 for details on how to print a System Settings page.

Print media misfeeds or multiple 
feeds occur.

Make sure that the print media you are using meets the specifications for your 
printer. 

See also: 
• "Usable Print Media" on page 95

Fan the print media before loading it.

Make sure that the print media is loaded correctly.

Make sure that the paper width guides and length guide are adjusted correctly.

Make sure that the standard 150 sheet tray is securely inserted.

Do not overload the print media sources.

Do not force print media into the standard 150 sheet tray when you load it.

Otherwise, it may skew or buckle.

Make sure that the print media is not curled.

Load the recommended print side correctly for the type of print media you are 
using.

See also: 
• "Loading Print Media" on page 96

Turn the print media over or around and try printing again to see if feeding 
improves.

Do not mix print media types.

Do not mix print media sizes.

Remove the top and bottom curled sheets of a ream before loading the print 
media.

Load the print media source only when it is empty.

The envelope is creased after 
printing.

Make sure that the envelope is loaded as instructed in "Loading Envelope in the 
Standard 150 Sheet Tray" on page 98.

Page breaks in unexpected places. Increase the value for Job Timeout in the System Settings menu, that is on the 
Printer Maintenance tab in the Printer Setting Utility.

Increase the time-out value for the protocol in use in the Protocol Settings menu 
on the CentreWare Internet Services.

Printer does not print duplex pages. Select either of the duplex printing options (flip on short edge/flip on long edge) in 
the print driver.

See also: 
• "Manual Duplex Printing" on page 100
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Print Quality Problems

NOTE: 

• In this section, some procedures use the Printer Setting Utility or the SimpleMonitor. Some procedures that use the Printer 
Setting Utility can also be performed using the operator panel.

See also: 
• "Understanding the Printer Menus" on page 206

• "Printer Setting Utility (Windows Only)" on page 39

• "SimpleMonitor (Windows Only)" on page 40



280 Troubleshooting

The Output Is Too Light

NOTE: 

• If the problem continues even though you have taken suggested actions described above, contact the Fuji Xerox local 
representative office or an authorized dealer.

Problem Action

The output is too light. The toner cartridges may be low or need to be replaced. Confirm the amount of 
toner in each toner cartridge. 

1 Check the toner level in the Status tab in the Printer Status window of the 
SimpleMonitor.

2 Replace the toner cartridges as necessary.

Verify that the print media is dry and the correct print media is used.

If not, use the print media recommended for the printer.

See also: 
• "Usable Print Media" on page 95

Try changing the paper type setting in the print driver. The following procedure 
uses the Microsoft® Windows® print driver as an example.

1 On the Paper/Output tab in Printing Preferences of the print driver, change 
the Paper Type setting.

2 Load dry (not damp) and correct size print media, and then click Print Test 
Page in the Properties window of the print driver.

Disable the toner saving feature in the print driver.

See also: 
• "Conserving Supplies" on page 333
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Toner Smears or Print Comes Off/Stain on Back Side

NOTE: 

• If the problem continues even though you have taken suggested actions described above, contact the Fuji Xerox local 
representative office or an authorized dealer.

Random Spots/Blurred Images

NOTE: 

• If the problem continues even though you have taken suggested actions described above, contact the Fuji Xerox local 
representative office or an authorized dealer.

Problem Action

Toner smears or print comes off.
The output has stain on the back 
side.

The print media surface may be uneven. Try changing the paper type setting in 
the print driver. For example, change Plain to Lightweight Cardstock. The 
following procedure uses the Windows print driver as an example.

1 On the Paper/Output tab in Printing Preferences of the print driver, change 
the Paper Type setting.

Verify that the correct print media is being used.

If not, use the print media recommended for the printer.

See also: 
• "Usable Print Media" on page 95

Adjust the temperature of the fusing unit.

1 Launch the Printer Setting Utility, and click Adjust Fusing Unit on the Printer 
Maintenance tab.

2 Adjust the fixing temperature by turning up the value for your printing media.

3 Click Apply New Settings.

Problem Action

The printed result has random spots 
or is blurred.

Make sure that the toner cartridges are installed correctly. 

See also: 
• "Installing a Toner Cartridge" on page 327

If you use non-genuine brand toner cartridges, install genuine brand toner 
cartridges.

Clean up the fusing unit.

1 Load one sheet of paper on the standard 150 sheet tray and then print a solid 
image all over paper.

2 Load the printed sheet with the printed side facing down, and then print a blank 
sheet of paper.
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The Entire Output Is Blank

If this trouble happens, contact the Fuji Xerox local representative office or an authorized dealer.

Streaks Appear on the Output

If this trouble happens, contact the Fuji Xerox local representative office or an authorized dealer.

Pitched Color Dots

If this trouble happens, contact the Fuji Xerox local representative office or an authorized dealer.

Vertical Blanks

NOTE: 

• If the problem continues even though you have taken suggested actions described above, contact the Fuji Xerox local 
representative office or an authorized dealer.

Problem Action

The printed result has vertical blanks. Clean inside the printer and perform a test print.

1 Clean inside the printer by using the print head cleaning rod. 

2 Click Print Test Page in the Properties window of the print driver.

See also: 
• "Cleaning Inside the Printer" on page 320
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Mottle

NOTE: 

• If the problem continues even though you have taken suggested actions described above, contact the Fuji Xerox local 
representative office or an authorized dealer.

Ghosting

NOTE: 

• If the problem continues even though you have taken suggested actions described above, contact the Fuji Xerox local 
representative office or an authorized dealer.

Problem Action

The printed result has mottled 
appearance.

Adjust the transfer bias.

1 Launch the Printer Setting Utility, and click Adjust BTR on the Printer 
Maintenance tab.

2 Adjust the setting for the type of print media being used.

3 Click Apply New Settings.

If you use non-recommended print media, use the print media recommended for 
the printer.

Problem Action

The printed result has ghosting. Adjust the transfer bias.

1 Launch the Printer Setting Utility, and click Chart Print on the Diagnosis tab.

2 Click Ghost Configuration Chart.

The Ghost Configuration Chart is printed.

3 Click BTR Refresh Mode on the Printer Maintenance tab.

4 Select the check box next to On, and then click Apply New Settings.

5 Click Chart Print on the Diagnosis tab.

6 Click Ghost Configuration Chart.

The Ghost Configuration Chart is printed.

The print media surface may be uneven. Try changing the paper type setting in 
the print driver. For example, change Plain to Lightweight Cardstock. The 
following procedure uses the Windows print driver as an example.

1 On the Paper/Output tab in Printing Preferences of the print driver, change 
the Paper Type setting.

Adjust the temperature of the fusing unit.

1 Launch the Printer Setting Utility, and click Adjust Fusing Unit on the Printer 
Maintenance tab.

2 Adjust the fixing temperature by turning up the value for your printing media.

3 Click Apply New Settings.

If you use non-recommended print media, use the print media recommended for 
the printer.
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Fog

Bead-Carry-Out (BCO)

NOTE: 

• If the problem continues even though you have taken suggested actions described above, contact the Fuji Xerox local 
representative office or an authorized dealer.

Problem Action

The entire page is foggy. Contact the Fuji Xerox local representative office or an authorized dealer.

Part of the page is foggy. Start Clean Developer.

1 Launch the Printer Setting Utility, and click Clean Developer on the Diagnosis 
tab.

2 Click Start.

If the problem continues even after performing Clean Developer, start Refresh 
Mode.

1 Launch the Printer Setting Utility, and click Refresh Mode on the Diagnosis 
tab.

2 Select the color that is the same as the fog.

If the problem continues even after performing Refresh Mode, start Refresh 
Mode again.

NOTE: 

• If the problem continues even after performing Refresh Mode twice, contact 
the Fuji Xerox local representative office or an authorized dealer.

Problem Action

Bead-Carry-Out (BCO) is happening. If the printer is installed in a high altitude location, set the altitude of the location.

1 Launch the Printer Setting Utility, and click Adjust Altitude on the Printer 
Maintenance tab.

2 Select the value close to the altitude of the location where the printer is 
installed.

3 Click Apply New Settings.
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Auger Mark

NOTE: 

• If the problem continues even though you have taken suggested actions described above, contact the Fuji Xerox local 
representative office or an authorized dealer.

Problem Action

The printed result has auger mark. The toner cartridges may be low or need to be replaced. Confirm the amount of 
toner in each toner cartridge.

1 Check the toner level in the Status tab in the Printer Status window of the 
SimpleMonitor.

2 Replace the toner cartridges as necessary.

Start Clean Developer.

1 Launch the Printer Setting Utility, and click Clean Developer on the Diagnosis 
tab.

2 Click Start.
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Wrinkled/Stained Paper

NOTE: 

• If the problem continues even though you have taken suggested actions described above, contact the Fuji Xerox local 
representative office or an authorized dealer.

The Top Margin Is Incorrect

NOTE: 

• If the problem continues even though you have taken suggested actions described above, contact the Fuji Xerox local 
representative office or an authorized dealer.

Problem Action

The output is wrinkled.
The output is stained.

Verify that the correct print media is being used.

If not, use the print media recommended for the printer.

If excessive wrinkles occur, use paper or other media from a new package.

See also: 
• "Usable Print Media" on page 95

• "About Print Media" on page 92

If you use the envelope, check whether the crease is within 30 mm of the four edges 
of the envelope.

If the crease is within 30 mm of the four edges of the envelope, this is considered 
normal. Your printer is not at fault.

If not, take the following actions:

• If the envelope is Com 10, which is 220 mm or longer and has a flap on the 
long edge, use a different size envelope.

• If the envelope is C5, which is 220 mm or longer and has a flap on the short 
edge, load it in the standard 150 sheet tray with the flap open and facing up.

• If the envelope is Monarch or DL, which is shorter than 220 mm, load it long 
edge feed in the standard 150 sheet tray with the flap open and facing up.
If the problem continues, use a different size envelope.

Problem Action

The top margin is incorrect. Make sure that the margins are set correctly on the application being used.
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Color Registration Is Out of Alignment

NOTE: 

• If the problem continues even though you have taken suggested actions described above, contact the Fuji Xerox local 
representative office or an authorized dealer.

Problem Action

Color registration is out of alignment. Execute an auto color registration adjustment.

1 Launch the Printer Setting Utility, and click Registration Adjustment on the 
Printer Maintenance tab.

2 Deselect the check box next to On.

3 Click Start next to Auto Correct.

Clean the CTD sensor.

1 Clean the CTD sensor. 

2 Launch the Printer Setting Utility, and click Registration Adjustment on the 
Printer Maintenance tab.

3 Deselect the check box next to On.

4 Click Start next to Auto Correct.

See also: 
• "Cleaning the Color Toner Density (CTD) Sensor" on page 323

Print the color registration chart and manually correct the color registration. 

1 Launch the Printer Setting Utility, and click Registration Adjustment on the 
Printer Maintenance tab.

2 Deselect the check box next to On.

3 Click Start next to Print Color Regi Chart.

The color registration chart is printed.

4 Check the values with the straight lines on the chart.

5 Select the value for each color on the Printer Setting Utility.

6 Click Apply New Settings.

7 Click Start next to Print Color Regi Chart to print the color registration chart 
again.

8 Adjust until all straight lines are at the value of 0.

See also: 
• "Adjusting Color Registration" on page 291
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Protrudent/Bumpy Paper

NOTE: 

• If the problem continues even though you have taken suggested actions described above, contact the Fuji Xerox local 
representative office or an authorized dealer.

Problem Action

Printed surface got 
protrudent/bumpy.

Clean up the fusing unit.

1 Load one sheet of paper on the standard 150 sheet tray, and then print a solid 
image all over the paper.

2 Load the printed sheet with the printed side facing down, and then print a blank 
sheet of paper.
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Copy Problem

Problem Action

A document loaded in the ADF 
cannot be copied.

Make sure that the ADF cover is firmly closed. 
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Copy Quality Problems

NOTE: 

• If the problem continues even though you have taken suggested actions described above, contact the Fuji Xerox local 
representative office or an authorized dealer.

Problem Action

There are lines or streaks in copies 
made from the ADF.

There is debris on the ADF glass. When scanning, the paper from the ADF 
passes over the debris creating lines or streaks. 

Clean the ADF glass with a lint free cloth.

See also: 
• "Cleaning the Scanner" on page 317

There are spots in copies taken from 
the document glass.

There is debris on the document glass. When scanning, the debris creates a spot 
on the image.

Clean the document glass with a lint free cloth.

See also: 
• "Cleaning the Scanner" on page 317

The reverse side of the original is 
showing on the copy.

On the Copy menu, enable Auto Background Suppression.

For information on turning Auto Background Suppression on and off, see 
"Auto Background Suppression" on page 132.

Light colors are washed out or white 
on the copy.

On the Copy menu, disable Auto Background Suppression.

For information on turning Auto Background Suppression on and off, see 
"Auto Background Suppression" on page 132.

Image is too light or dark. Use the Lighten / Darken option on the Copy menu.

For information on making the image lighter or darker, see "Lighten / Darken" on 
page 131.
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Adjusting Color Registration

This section describes how to adjust the color registration when you first install the printer or after moving it to a new 
location.

Performing Auto Correct
Auto Correct allows you to correct the color registration automatically.

Using the Operator Panel

1 Press the  (System) button.

2 Select the Tools tab.

3 Select Admin Settings.

4 Select Maintenance.

5 Select Color Registration.

6 Select Auto Registration.

7 Select Start.

Auto correct is performed.

Using the Printer Setting Utility (Windows Only)
The following procedure uses Windows 7 as an example. 

1 Click Start  All Programs  Fuji Xerox  Fuji Xerox Printer Software for Asia-Pacific  your printer  
Printer Setting Utility.

NOTE: 

• The window to select a printer appears in this step when multiple print drivers are installed on your computer. In this 
case, click the name of the desired printer listed in Printer Name.

The Printer Setting Utility opens.

2 Click the Printer Maintenance tab.

3 Select Registration Adjustment from the list at the left side of the page.

The Registration Adjustment page is displayed.

4 Deselect the check box next to On.

5 Click Start next to Auto Correct.

The color registration is corrected automatically.
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Printing the Color Registration Chart

Using the Operator Panel

1 Press the  (System) button.

2 Select the Tools tab.

3 Select Admin Settings.

4 Select Maintenance.

5 Select Color Registration.

6 Select Print Registration Chart.

7 Select Print.

The color registration chart is printed.

Using the Printer Setting Utility (Windows Only)
The following procedure uses Windows 7 as an example. 

1 Click Start  All Programs  Fuji Xerox  Fuji Xerox Printer Software for Asia-Pacific  your printer  
Printer Setting Utility.

NOTE: 

• The window to select a printer appears in this step when multiple print drivers are installed on your computer. In this 
case, click the name of the desired printer listed in Printer Name.

The Printer Setting Utility opens.

2 Click the Printer Maintenance tab.

3 Select Registration Adjustment from the list at the left side of the page.

The Registration Adjustment page is displayed.

4 Deselect the check box next to On.

5 Click Start next to Print Color Regi Chart.

The color registration chart is printed.



Troubleshooting 293

Determining Values
On the color registration chart printed, find the straightest lines where the two black lines and the colored line are 
most closely aligned for each color (Y, M, and C).

If you find the straightest line, make a note of the value (-5 – +5) indicated by the straightest line for each color.

When the value is 0 for each color, you do not need to adjust the color registration.

When the value is not 0, enter the value according to the procedure in "Entering Values" on page 294.
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Entering Values

Using the Operator Panel

1 Press the  (System) button.

2 Select the Tools tab.

3 Select Admin Settings.

4 Select Maintenance.

5 Select Color Registration.

6 Select Enter Registration Values.

7 Confirm that LY, LM, and LC appear.

8 Select + or - to specify the values for LY, LM, and LC.

9 Select Next.

10 Confirm that RY, RM, and RC appear.

11 Select + or - to specify the values for RY, RM, and RC.

12 Select Next.

13 Confirm that Y, M, and C appear.

14 Select + or - to specify the values for Y, M, and C.

15 Select OK.

NOTE: 

• The registration values are always shown as 0 the next time you enter the menu.

16 Select Print Registration Chart.

17 Select Print.

The color registration chart is printed with the new values.

If the straightest line is not at the value of 0, adjust the values again. Checking the charts before and after the 
adjustments will help you to determine the values to enter.

IMPORTANT: 

• After printing the color registration chart, do not turn off the printer until the printer motor has stopped running.
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Using the Printer Setting Utility (Windows Only)
Enter the values that you found in the color registration chart to make adjustments.

The following procedure uses Windows 7 as an example.

1 Click Start  All Programs  Fuji Xerox  Fuji Xerox Printer Software for Asia-Pacific  your printer  
Printer Setting Utility.

NOTE: 

• The window to select a printer appears in this step when multiple print drivers are installed on your computer. In this 
case, click the name of the desired printer listed in Printer Name.

The Printer Setting Utility opens.

2 Click the Printer Maintenance tab.

3 Select Registration Adjustment from the list at the left side of the page.

The Registration Adjustment page is displayed.

4 Deselect the check box next to On.

5 Select the value you checked in the color registration chart, and then click Apply New Settings.

6 Click Start next to Print Color Regi Chart.

The color registration chart is printed with the new values.

7 Adjust until all straight lines are at the value of 0.

Viewing the images before and after will help.

IMPORTANT: 

• After printing the color registration chart, do not turn off the printer until the printer motor has stopped running.
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Fax Problems

Problem Action

The printer is not working, there is no 
display and the buttons are not 
working.

Unplug the power cord and plug it in again. 

Make sure that there is power to the electrical receptacle. 

No dial tone sounds. Check that the phone line is connected properly. 

See also: 
• "Connecting the Telephone Line" on page 172

Check that the phone socket in the wall is working by plugging in another phone. 

The numbers stored in the memory 
do not dial correctly.

Make sure that the numbers are stored in the memory correctly. Print the Address 
Book List. 

The document does not feed into the 
printer.

Make sure that the document is not wrinkled and you are putting it in correctly. 
Check that the document is of the right size, not too thick or thin. 

Make sure that the ADF cover is firmly closed. 

Faxes are not received automatically. Select FAX Mode for Receive Mode. 

Make sure that there is paper in the standard 150 sheet tray.. 

Check if the touch panel shows Memory Full.

Check the Junk Fax Filter setting.

The printer does not send faxes. Check the other fax machine you are sending to, to see if it can receive your fax. 

The incoming fax has blank spaces 
or is received in poor-quality.

The fax machine sending you the fax may be faulty. Ask the sender to sort out the 
problem and resend the fax.

A noisy phone line can cause line errors. Ask the sender to resend the fax.

Check your printer by making a copy. 

The toner cartridge may be empty. Replace the toner cartridge.

See also: 
• "Replacing Toner Cartridges" on page 324

Some of the words on an incoming 
fax are stretched.

The fax machine sending you the fax had a temporary document jam. Ask the 
sender to clear the document jam and resend the fax.

There are lines on the documents 
you send.

Check your ADF glass for marks and clean it.

See also: 
• "Cleaning the Scanner" on page 317

The printer dials a number, but the 
connection with another fax machine 
fails.

The other fax machine may be turned off, out of paper, or cannot answer incoming 
calls. Ask the sender to sort out the problem and retry. 

Documents are not stored in the 
memory.

There may not be enough memory to store the document. If the touch panel 
shows Memory Full, delete any documents you no longer need from the 
memory and then restore the document, or wait for the job in progress (e.g., a fax 
transmission or reception) to complete.

Blank areas appear at the bottom of 
each page or on other pages, with a 
small strip of text at the top.

You may have chosen the wrong paper settings in the user option setting. Correct 
the paper settings.

See also: 
• "Paper Tray Settings" on page 247
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The printer will not send or receive 
faxes.

Check if the region is set correctly.

1 Press the  (System) button.

2 Select the Tools tab.

3 Select Admin Settings.

4 Select Fax Settings.

5 Select Fax Line Settings.

6 Select Region.

7 Select the correct region, and then select OK.

Check that the phone line is connected properly.

See also: 
• "Connecting the Telephone Line" on page 172

An error often occurs during a fax 
transmission or reception.

Reduce the modem speed.

1 Press the  (System) button.

2 Select the Tools tab.

3 Select Admin Settings.

4 Select Fax Settings.

5 Select Transmission Defaults.

6 Select Modem Speed.

7 Select the desired menu item, and then select OK.

Problem Action



298 Troubleshooting

Scanning Problems

Problem Action

The scanner does not work. Make sure that you place the document to be scanned facing down on the 
document glass, or facing up in the ADF.

There may not be enough available memory to hold the document you want to 
scan. Try the Preview function to see if that works. Try lowering the scan 
resolution rate. 

Check that the Ethernet or USB cable is connected properly. 

Make sure that the Ethernet or USB cable is not defective. Switch the cable with a 
known good cable. If necessary, replace the cable.

Check that the scanner is configured correctly. Check the application you want to 
use to make certain that the scanner job is being sent to the correct port. 

The printer scans very slowly. Graphics are scanned more slowly than text when using the Scan to E-Mail or 
Scan to Network feature. 

Communication speed becomes slow in scan mode because of the large amount 
of memory required to analyze and reproduce the scanned image. 

Scanning images at a high resolution takes more time than scanning at a low 
resolution.

Document misfeeds or multiple feeds 
occur in the ADF.

Make sure that the document's paper type meets the specifications for the printer.

See also: 
• "Preparing a Document" on page 127

• "Making Copies From the ADF" on page 130

Check if the document is properly loaded in the ADF.

Make sure that the document guides are adjusted properly.

Make sure that the number of document sheets do not exceed the maximum 
capacity of the ADF.

Make sure that the document is not curled.

Fan the document well before loading it in the ADF.

Vertical stripes appear on the output 
when scanned using the ADF.

Clean the ADF glass.

See also: 
• "Cleaning the Scanner" on page 317

A smear appears at the same 
location on the output when scanned 
using the document glass.

Clean the document glass.

See also: 
• "Cleaning the Scanner" on page 317

Images are skewed. Make sure that the document is loaded straight in the ADF or on the document 
glass.

Diagonal lines appear jagged when 
scanned using the ADF.

If the document uses thick media, try scanning it from the document glass.
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The printer does not properly transfer 
scan data to a specified destination 
via the Scan to E-Mail or Scan to 
Network feature. 

Check if the following settings have been set correctly on the CentreWare Internet 
Services.

Scan to E-Mail

Check the following setting under Address Book  Personal Address:

• Name

• Phone number

• E-mail Address

Scan to Network

Check the following settings under Address Book  Computer/Server Address 
Book:

• Name (Displayed on Printer)

• Network Type

• Host Address (IP Address or DNS Name)

• Port Number

• Login Name (if required by host)

• Login Password

• Name of Shared Directory

• Subdirectory Path (optional)

Cannot scan using Windows Image 
Acquisition (WIA) on a Windows 
Server® 2003 computer.

Enable Windows Image Acquisition (WIA) on the computer.

To enable Windows Image Acquisition (WIA): 

1 Click Start, point to Administrative Tools, and then click Services.

2 Right-click Windows Image Acquisition (WIA), and then click Properties to 
make sure that Startup type is set to Manual or Automatic.

3 Click OK.

4 Right-click Windows Image Acquisition (WIA), and then click Start.

Cannot scan using TWAIN or 
Windows Image Acquisition (WIA) on 
a Windows Server 2008, Windows 
Server 2008 R2, Windows Server 
2012, or Windows Server 2012 R2 
computer.

Install the Desktop Experience feature on the computer.

To install Desktop Experience:

For Windows Server 2008 and Windows Server 2008 R2:

1 Click Start, point to Administrative Tools, and then click Server Manager.

2 Click Add Features under Features Summary.

3 Select the Desktop Experience check box.

4 If a window appears, follow the on-screen instructions.

5 Click Next, and then click Install.

6 Restart the computer.

For Windows Server 2012 and Windows Server 2012 R2:

1 On the Start screen, click Server Manager.

2 Click Add roles and features to start Add Roles and Features Wizard.

3 On the Before you begin screen, click Next.

4 On the Select installation type screen, confirm that Role-based or feature-
based installation is selected, and then click Next.

5 On the Select destination server screen, select an appropriate server and 
then click Next.

6 On the Select server roles screen, click Next.

7 On the Select features screen, select the Desktop Experience check box 
under User Interfaces and Infrastructure (Installed) in the Features list.

8 On the pop-up window, click Add Features.

9 On the Select features screen, click Next.

10On the Confirm installation selections screen, click Install.

11Restart the computer.

Problem Action
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Scan Driver/Printer Utility Problems

Problem Action

Unable to retrieve the Address Book 
data from the printer on the Address 
Book Editor.

Make sure that your computer and the printer is properly connected with the USB 
cable or Ethernet cable.

Make sure that the printer is turned on.

Make sure that the print driver is installed on your computer. (The Address Book 
Editor retrieves the Address Book data via the print driver.) 

The TWAIN driver cannot connect to 
the printer.

Make sure that your computer and the printer is properly connected with the USB 
cable.

Check if the printer is turned on. If the printer is turned on, reboot it by turning the 
power switch off and then on again.

If a scan application is running, close the application once, restart the application, 
and then try scanning again. 

The scan driver has not been 
registered on your computer and 
cannot be accessed from the 
Express Scan Manager. 

Install the scan driver. If the driver is already installed, uninstall it and then reinstall 
it.

Failed to scan your document on the 
printer via the Express Scan 
Manager.

Make sure that your computer and the printer is properly connected with the USB 
cable.

Check if the printer is turned on. If the printer is turned on, reboot it by turning the 
power switch off and then on again.

If a scan application is running, close the application once, restart the application, 
and then try scanning again. 

Failed to create an image file via the 
Express Scan Manager.

Uninstall the Express Scan Manager on your computer and then reinstall it.

Failed to initialize the Express Scan 
Manager.

Uninstall the Express Scan Manager on your computer and then reinstall it.

Failed to execute the Express Scan 
Manager.

Uninstall the Express Scan Manager on your computer and then reinstall it.

An unexpected error occurred on the 
Express Scan Manager. 

Uninstall the Express Scan Manager on your computer and then reinstall it.



Troubleshooting 301

Wireless Problems

Problem Action

Cannot setup wireless connection. Make sure that the Ethernet cable is disconnected from the printer.

Try disabling the firewall on your computer. The firewall on your computer may be 
blocking communication with your printer.

Cannot setup wireless connection 
with WPS (Wi-Fi Protected Setup™).

Make sure that the security setting of the wireless LAN access point or router is 
WPA™ (Wi-Fi Protected Access®) or WPA2™. (WEP is not supported on WPS.)

Cannot setup wireless connection 
with the WPS-PBC (Wi-Fi Protected 
Setup-Push Button Configuration).

Press the WPS button on the wireless LAN access point or router within two 
minutes after starting the WPS operation on the printer. For details about the 
wireless LAN access point or router, refer to the manual supplied with the wireless 
LAN access point or router.

Cannot setup wireless connection 
with WPS-PIN (Wi-Fi Protected 
Setup-Personal Identification 
Number).

Check if the PIN you have entered on the computer is correct.

Cannot connect to the wireless 
network after setting up wireless 
connection.

Check if the passphrase for WPA/WPA2 encryption or WEP key set on the 
wireless LAN access point or router has been changed. (Passphrase may be 
described as key on some access points or routers.) For details about the 
wireless LAN access point or router, refer to the manual supplied with the wireless 
LAN access point or router.
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Wi-Fi Direct Problems

Problem Action

The device cannot discover the 
printer.

The printer may be connected to another device via Wi-Fi Direct®. Disconnect the 
printer and the device. For details, see "Disconnecting Wi-Fi Direct Network" on 
page 118.

The printer cannot disconnect from 
the device even when the procedure 
in "Disconnecting Wi-Fi Direct 
Network" has been performed.

The device may be automatically reconnecting to the printer. Reset the 
passphrase for Wi-Fi Direct and disconnect the device. For details, see "Resetting 
the Passphrase" on page 118.

The network mode of the printer 
cannot be set to Ad-Hoc mode on 
the CentreWare Internet Services.

Make sure that Wi-Fi Direct is set to Disable.

Wi-Fi Direct cannot be set to 
Enable.

Make sure that the network mode is set to Infrastructure mode on the 
CentreWare Internet Services.
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Digital Certificate Problems

Problem Action

The Certificate Signing Request 
(CSR) / Upload Signed Certificate 
is not displayed.

Create a self-signed certificate and enable SSL/TLS Server Communication. 
For details, see "Preparing to Use HTTPS Communication" on page 261.

The digital certificate cannot be 
uploaded.

Confirm validity period of the digital certificate as well as the time setting of the 
device.

Confirm that the password is correct.

Confirm that the file type is PKCS #7/#12 or x509CACert (extension: 
p7b/p12/pfx/cer/crt).

Confirm that the attribute information (Key usage/Extended key usage) of the 
digital certificate to be imported is set correctly.

Use Internet Explorer®.

Although a digital certificate was 
uploaded, it is not displayed.

To upload a digital certificate for use with the device (own device), import the 
secret key and a digital certificate of the PKCS #12 (p12/pfx) format as a pair.

Server validation is not operating 
correctly.

Although uploading a root certificate (Trusted) to use for server authentication, an 
intermediate certificate may be required when validating the path.

When executing a digital certificate file with the certification authority, create the 
digital certificate with a format including all paths and then import that digital 
certificate.
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Other Problem

Problem Action

Condensation has occurred inside 
the printer.

This usually occurs within several hours after you heat the room in winter. This 
also occurs when the printer is operating in a location where relative humidity 
reaches 85% or more. Adjust the humidity or relocate the printer to an appropriate 
environment.
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Understanding Printer Messages

The printer touch panel displays messages describing the current state of the printer and indicates possible printer 
problems you must resolve. This section describes error codes included in the messages, their meanings, and how 
to clear the messages.

IMPORTANT: 

• When an error message is displayed, the print data remaining on the printer and the information accumulated in the memory 
of the printer are not secured.

Error Code What You Can Do

005-121 Open the ADF cover. Remove the jammed paper and then close the ADF cover.

See also: 
• "Clearing Paper Jams From the ADF" on page 268

005-301

009-950 Replace the specified toner cartridge.

See also: 
• "Replacing Toner Cartridges" on page 324

009-951

009-952

009-953

010-397 Turn off the printer, and then on. If this does not solve the problem, contact the Fuji Xerox local 
representative office or an authorized dealer.

See also: 
• "Online Services" on page 339

016-315

016-317

016-372

016-501

016-502

016-503 Select OK to clear the message. Check if the SMTP server setting is correct by contacting your 
server administrator.

016-504 Select OK to clear the message. Check if the user name and password for the POP3 server are set 
correctly by contacting your server administrator.

016-506 Select OK to clear the message. Check if the SMTP server address and e-mail destination are set 
correctly.

016-507 Select OK to clear the message. Check if the user name and password used for the SMTP server 
are set correctly by contacting your server administrator.

016-718 Select OK to clear the message. Retry when the printer does not process any job.

016-719 Select OK to cancel the current job. Retry when the printer does not process any job.

016-720

016-744 Select OK to clear the message. If this does not solve the problem, contact the Fuji Xerox local 
representative office or an authorized dealer.

See also: 
• "Online Services" on page 339

016-745

016-749 Select OK to cancel the current job. Retry when the printer does not process any job.

016-753 PDL emulation error has occurred. Select OK to clear the message and cancel the current print job. 
Check if the password is correct.016-755

016-764 Select OK to clear the message. Check if the Ethernet cable is properly connected. If this does not 
solve the problem, contact SMTP server administrator.

016-766 Select OK to clear the message. Ping the IP address of the SMTP server and check if the server is 
available. If this does not solve the problem, contact SMTP server administrator.

016-767 Select OK to clear the message. Check if the recipient address is correct, and try scanning again.

016-791 Insert the USB storage device and select OK to clear the message.

016-795 Select OK to clear the message. Check if the file format is correct.

016-797 Select OK to clear the message. Check if the USB storage device is securely connected.

016-920 Select OK to clear the message. Check the wireless setting for the access point and the printer, and 
try wireless settings again.016-921
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016-930 Remove the device from the USB drive and select OK to clear the message.

016-931

016-981 Select OK to cancel the current job. Try copying fewer documents.

016-982 The printer memory is full and cannot continue processing the current print job. Select OK to clear 
the message and cancel the current print job.

016-985 Attached file size is larger than you defined. Select OK to clear the message. Try the following:

• Enlarge Max E-Mail Size. 

• Lower the resolution setting. 

• Change the file format of the scanned image.

017-970 Memory is likely to be full. Select OK to clear the message. Try the following:

• Delete the data stored in the memory. 

• Lower the resolution setting.

• Reduce the number of pages.

017-980 Select OK to clear the message. Retry when the printer does not process any job.

017-981

017-988 Select OK to clear the message. Check if the interface cable is securely connected or your computer 
does not have any problem.

018-338 Turn off the printer, and then on. If this does not solve the problem, contact the Fuji Xerox local 
representative office or an authorized dealer.

See also: 
• "Online Services" on page 339

024-340 Turn off the printer, and then on. If this does not solve the problem, contact the Fuji Xerox local 
representative office or an authorized dealer.

See also: 
• "Online Services" on page 339

024-360

024-371

024-946 Select OK to clear the message. Check for any misfed paper in the standard 150 sheet tray, and set 
the tray to the printer.

024-958 Load the specified paper and select OK to clear the message.

See also: 
• "Loading Print Media in the Standard 150 Sheet Tray" on page 96

024-963 Select OK to clear the message and load the specified paper. Follow the on-screen instruction if one 
appears.

See also: 
• "Loading Print Media in the Standard 150 Sheet Tray" on page 96

026-720 Select OK to clear the message. Check if the USB storage device has enough memory.

026-721 Select OK to clear the message. Check if the USB storage device is write-protected or gets any disk 
problem.026-722

026-723 Select OK to clear the message. Check if the path and file name to save the data is too long.

026-750 Select OK to clear the message. Check if the interface cable is securely connected, or restart the 
application you use.

026-751 Select OK to clear the message. Check if the interface cable is securely connected.

026-752

031-521 Select OK to clear the message. Check if the access setting to the SMB server is correct by 
contacting your server administrator.

031-526 Select OK to clear the message. Check if the domain name of the SMB server is correct. Check DNS 
connection, or check if the name of the forwarding destination server is registered with DNS.

031-529 Select OK to clear the message. Check if the Ethernet cable is properly connected and if the 
password for the SMB server is correct.

031-530 Select OK to clear the message. Check if the working path setting to the SMB server is correct.

Error Code What You Can Do
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031-533 Select OK to clear the message. Check the following:

• If the file name you specified is not used by other users.

• If file or folder that has the same name as the one you specified already exists.

• If the SMB server encounters any write-protection or disk problem.

031-534 Select OK to clear the message. Check if the SMB server encounters any write-protection or disk 
problem.031-535

031-536

031-537 Select OK to clear the message. Check if the storage location has free space.

031-555 Select OK to clear the message. Check if the network is properly connected.

031-556 Select OK to clear the message. Check if the SMB server encounters any write-protection or disk 
problem.

031-557 Select OK to clear the message. Check the following:

• If the file name you specified is not used by other users.

• If file or folder that has the same name as the one you specified already exists.

031-558 Select OK to clear the message. Check if the access setting to the SMB server is correct by 
contacting your server administrator.

031-571 Select OK to clear the message. Check if the printer is properly connected to a network.

031-574 Select OK to clear the message. Check if the domain name of the FTP server is correct. 

031-575 Select OK to clear the message. Check if the host name setting to the FTP server is correct.

031-576 Select OK to clear the message. Check if the FTP server encounters any write-protection or disk 
problem.

031-578 Select OK to clear the message. Check if the Ethernet cable is properly connected and if login name 
(user name) and password for the FTP server are correct.

031-579 Select OK to clear the message. Check if the working path setting to the FTP server is correct.

031-582 Select OK to clear the message. Check if the FTP server encounters any write-protection or disk 
problem.

031-584 Select OK to clear the message. Check the following:

• If the file name you specified is not used by other users. 

• If file or folder that has the same name as the one you specified already exists. 

• If the FTP server encounters any write-protection or disk problem.

031-585 Select OK to clear the message. Check if the FTP server encounters any delete/write-protection or 
disk problem.031-587

031-588 Select OK to clear the message. Check if the FTP server encounters any write-protection or disk 
problem.

031-589 Select OK to clear the message. Check if the storage location has free space.

031-594 Select OK to clear the message. Contact your server administrator to check if the scanned file has 
wrong setting while being stored to FTP server. If this does not solve the problem, contact the Fuji 
Xerox local representative office or an authorized dealer.

See also: 
• "Online Services" on page 339

031-598 Select OK to clear the message. Check if the FTP server encounters any write-protection or disk 
problem.

033-503 Select OK to clear the message. Check the report. Delete the unnecessary data stored in the 
memory.

033-513

033-517 Select OK to clear the message. Check if the password of the fax lock is correct.

033-518 Select OK to clear the message. Check if your region is set correctly.

033-519 Fax service is locked. To continue, select OK and disable the fax lock. 

See also: 
• "Limiting Access to Printer Operations" on page 252

033-787 Select OK to clear the message. The job is canceled.

Error Code What You Can Do
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033-788 Select OK to clear the message. Remove the received fax, or wait for a while until sending a fax is 
completed.

034-700 Select OK to clear the message. If the error continues to appear after the redial for the specified 
number of times, try the following:

• Check if the phone line is connected properly.

• Check if the destination number is correct.

• Set Number of Redial to the larger value.

• Set Interval Timer or Redial Delay longer.

See also: 
• "Connecting the Telephone Line" on page 172

034-701

034-702

034-703 Select OK to clear the message. If the error continues to appear after the redial for the specified 
number of times, try the following:

• Check if the phone line is connected properly.

• Check if the destination number is available and correct.

• Set Number of Redial to the larger value.

• Set Interval Timer or Redial Delay longer.

See also: 
• "Connecting the Telephone Line" on page 172

034-704

034-705

034-706

034-707 Select OK to clear the message. If the error continues to appear after the redial for the specified 
number of times, try the following:

• Set Number of Redial to the larger value.

• Set Interval Timer or Redial Delay longer.

• Lower Modem Speed.

034-708 Select OK to clear the message. If the error continues to appear after the redial for the specified 
number of times, try the following:

• Set Number of Redial to the larger value.

• Set Interval Timer or Redial Delay longer.

• Check if the destination number is available.

• Lower Modem Speed.

034-709 Select OK to clear the message. If the error continues to appear after the redial for the specified 
number of times, try the following:

• Set Number of Redial to the larger value.

• Set Interval Timer or Redial Delay longer.

034-710

034-711 Select OK to clear the message. If the error continues to appear after the redial for the specified 
number of times, try the following:

• Set Number of Redial to the larger value.

• Set Interval Timer or Redial Delay longer.

• Lower Modem Speed.

034-712

034-713

034-714 Select OK to clear the message. If the error continues to appear after the redial for the specified 
number of times, try the following:

• Set Number of Redial to the larger value.

• Set Interval Timer or Redial Delay longer.

• Check if the destination number is available.

034-715 Select OK to clear the message. If the error continues to appear after the redial for the specified 
number of times, try the following:

• Set Number of Redial to the larger value.

• Set Interval Timer or Redial Delay longer.

• Lower Modem Speed.

034-716 Select OK to clear the message. If the error continues to appear after the retry for the specified 
number of times, it will be canceled. When retrying sending the fax, lower Modem Speed.

034-717 Select OK to clear the message. If the error continues to appear after the retry for the specified 
number of times, it will be canceled. Retry sending the fax.

034-718 Select OK to clear the message. If the error continues to appear after the retry for the specified 
number of times, it will be canceled. When retrying sending the fax, lower Modem Speed.034-719

Error Code What You Can Do
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034-720 Select OK to clear the message. If the error continues to appear after the retry for the specified 
number of times, it will be canceled. When retrying sending the fax, try the following:

• Lower Modem Speed.

• Enable ECM.

034-721 Select OK to clear the message. If the error continues to appear after the retry for the specified 
number of times, it will be canceled. When retrying sending the fax, lower Modem Speed.034-722

034-723

034-724

034-725

034-726

034-727 Select OK to clear the message. Check if the destination number is available. If the error continues 
to appear after the retry for the specified number of times, it will be canceled. 

034-750 Select OK to clear the message. Check if the phone line is connected properly.

See also: 
• "Connecting the Telephone Line" on page 172

034-751 Select OK to clear the message. Check if the destination machine blocks your fax as the junk fax. If 
it does, ask the receiver to disable the setting.

034-752 Select OK to clear the message. Check if the phone line is connected properly.

See also: 
• "Connecting the Telephone Line" on page 172

034-753

034-754 Select OK to clear the message. Lower Modem Speed. 

034-755

034-756

034-757

034-758 Select OK to clear the message. Check if the phone line is connected properly. Or, lower Modem 
Speed. 

See also: 
• "Connecting the Telephone Line" on page 172

034-759 Select OK to clear the message. Lower Modem Speed.

034-760

034-761 Select OK to clear the message. Check if the phone line is connected properly. 

See also: 
• "Connecting the Telephone Line" on page 172

034-762 Select OK to clear the message. Try the following:

• Lower Modem Speed.

• Enable ECM. 

034-763 Select OK to clear the message. Lower Modem Speed.

034-764

034-765

034-766

034-767 Select OK to clear the message. Check if the phone line is connected properly. 

See also: 
• "Connecting the Telephone Line" on page 172

034-768 Select OK to clear the message. Lower Modem Speed.

Error Code What You Can Do



310 Troubleshooting

041-340 Turn off the printer, and then on. If this does not solve the problem, contact the Fuji Xerox local 
representative office or an authorized dealer.

See also: 
• "Online Services" on page 339

042-358

042-372

061-370

062-321

062-360

062-790 Select OK to clear the message. The scanned data is deleted. Retry scanning the document.

075-100 Check and clear the paper path, load the paper, and then select OK to clear the message.

See also: 
• "Clearing Paper Jams From the Front of the Printer" on page 270

075-921 Load paper for the second side (odd) pages, and select OK.

See also: 
• "Manual Duplex Printing" on page 100

077-100 Open the rear cover and remove the jammed paper.

See also: 
• "Clearing Paper Jams From the Rear of the Printer" on page 271

077-104

077-106

077-108

077-109

077-304 Close the rear cover.

077-900 Open the rear cover and remove the jammed paper.

See also: 
• "Clearing Paper Jams From the Center Output Tray" on page 273

077-901 Open the rear cover and remove the jammed paper.

See also: 
• "Clearing Paper Jams From the Rear of the Printer" on page 271

091-313 Turn off the printer, and then on. If this does not solve the problem, contact the Fuji Xerox local 
representative office or an authorized dealer.

See also: 
• "Online Services" on page 339

091-402 The service life of your printer is coming to an end and the printer will soon stop running.

If you want to keep using the printer, change the Machine Life setting to Continue Print. 
However, continuous use of the printer will degrade the print quality.

See also: 
• "Machine Life" on page 234

091-441 The printer has exceeded its service life or the settings have been changed to continue using it. The 
quality of printouts will degrade if the printer continues to be used.

See also: 
• "Machine Life" on page 234

092-310 Clean the CTD sensor.

See also: 
• "Cleaning the Color Toner Density (CTD) Sensor" on page 323

092-651 Turn off the printer, and then on. If this does not solve the problem, contact the Fuji Xerox local 
representative office or an authorized dealer.

See also: 
• "Online Services" on page 339

092-661

Error Code What You Can Do
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093-423 Replace the specified toner cartridge soon. 

See also: 
• "Replacing Toner Cartridges" on page 324

093-424

093-425

093-426

093-919 Re-install or replace the specified toner cartridge.

See also: 
• "Replacing Toner Cartridges" on page 324

093-920

093-921

093-922

093-930 Remove the specified toner cartridge and install a new one. If you do not replace the toner cartridge, 
print quality problems may occur. 

See also: 
• "Replacing Toner Cartridges" on page 324

093-931

093-932

093-933

093-926 Replace the specified toner cartridge with the supported one. 

See also: 
• "Replacing Toner Cartridges" on page 324

093-960

093-961

093-962

093-970 Re-install the specified toner cartridge.

See also: 
• "Installing a Toner Cartridge" on page 327

093-971

093-972

093-973

116-210 Turn off the printer, and then on. If this does not solve the problem, contact the Fuji Xerox local 
representative office or an authorized dealer.

See also: 
• "Online Services" on page 339

116-314

116-323

116-325

116-326

116-355

116-395

116-703 PDL emulation error has occurred. Select OK to clear the message and cancel the current print job.

116-720

117-331 Turn off the printer, and then on. If this does not solve the problem, contact the Fuji Xerox local 
representative office or an authorized dealer.

See also: 
• "Online Services" on page 339

117-332

117-333

117-334

117-346

117-348 Retry, and check the report. Turn off the printer, and then on. If this does not solve the problem, 
contact the Fuji Xerox local representative office or an authorized dealer.

See also: 
• "Online Services" on page 339

117-350 Open the rear cover and close to continue. If this does not solve the problem, contact the Fuji Xerox 
local representative office or an authorized dealer.

See also: 
• "Online Services" on page 339

117-366 Turn off the printer, and then on. If this does not solve the problem, contact the Fuji Xerox local 
representative office or an authorized dealer.

See also: 
• "Online Services" on page 339

124-333

134-211

Error Code What You Can Do
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191-310 Although the service life of your printer has been over and the printer stopped running, you can still 
use the printer by pressing the 8 and 0 button on the number pad at the same time for three 
seconds. However, continuous use of the printer will degrade the print quality.

See also: 
• "Machine Life" on page 234

191-311 The life of your printer has been over and you can no longer use the printer.

193-700 This message indicates the printer is in the Non-Genuine mode.

Error Code What You Can Do
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Contacting Service

When you call for printer service, be prepared to describe the problem you are experiencing or the error message on 
the touch panel.

You need to know the model of your printer and serial number. See the label on the rear cover of your printer.
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Getting Help

Fuji Xerox provides several automatic diagnostic tools to help you produce and maintain print quality.

Touch Panel Messages
The touch panel provides you with information and troubleshooting help. When an error or warning condition occurs, 
the touch panel displays a message informing you of the problem. 

See also: 
• "Understanding Printer Messages" on page 305

SimpleMonitor Alerts (Windows Only)
The SimpleMonitor is a tool that is included on the Software Pack CD-ROM. It automatically checks the printer status 
when you send a print job. If the printer is unable to print your job, the SimpleMonitor automatically displays an alert 
on your computer screen to let you know that the printer needs attention.

Obtaining the Product Information

Obtaining the Latest Print Driver
The latest print driver can be obtained by downloading it from our web site.

This section explains the procedures using Windows 7 as an example.

NOTE: 

• The communication fee shall be borne by users. 

1 Click Start  Devices and Printers.

2 Right-click the printer, and then select Printer properties.

3 Select the Configuration tab.

4 Select About.

5 Click Fuji Xerox Web Site. 

Your web browser launches and our web site is displayed.

6 Follow the instructions on the web site and download an appropriate print driver.

NOTE: 

• The URL of the driver download service page is as follows: http://www.fujixeroxprinters.com/ 

• For the latest information about the print driver features, refer to the Help provided for the print driver.

Updating the Printer's Firmware
Our web site also provides a tool that allows you to update the printer's firmware (software embedded within the 
printer) from your computer.

The latest firmware and updating tool can be downloaded from the following URL.

Follow the instructions on the web site and download the correct firmware update.

http://www.fujixeroxprinters.com/ 

NOTE: 

• The communication fee shall be borne by users.

http://www.fujixeroxprinters.com/
http://www.fujixeroxprinters.com/
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Non-Genuine Mode

When toner within a toner cartridge is empty, XXXX Cartridge is Close to Life or Replace XXXX 
Cartridge (XXXX: Yellow, Magenta, Cyan, or Black) appears.

When you want to use the printer in the Non-Genuine mode, enable the Non-Genuine mode and replace the toner 
cartridge.

IMPORTANT: 

• If you use the printer in the Non-Genuine mode, the performance of the printer may not be at its optimum. Any problems that 
may arise from the use of the Non-Genuine mode are not covered by our quality guarantee. The continuous use of the Non-
Genuine mode can also cause the printer to break down, and any repair charges for such break down will be incurred by 
users.

NOTE: 

• To disable the Non-Genuine mode, select Off for Non-Genuine Toner on the operator panel or deselect the check box 
next to On on the Non-Genuine Toner page on the Printer Maintenance tab in the Printer Setting Utility.

Using the Operator Panel

NOTE: 

• Before starting the operation described below, confirm that the top service menu screen is displayed on the touch panel.

1 Press the  (System) button.

2 Select the Tools tab.

3 Select Admin Settings.

4 Select Maintenance.

5 Select Non-Genuine Toner.

6 Select On, and then select OK.

The printer switches to the Non-Genuine mode.

Using the Printer Setting Utility (Windows Only)
The following procedure uses Windows 7 as an example. 

1 Click Start  All Programs  Fuji Xerox  Fuji Xerox Printer Software for Asia-Pacific  your printer  
Printer Setting Utility.

NOTE: 

• The window to select a printer appears in this step when multiple print drivers are installed on your computer. In this 
case, click the name of the desired printer listed in Printer Name.

The Printer Setting Utility opens.

2 Click the Printer Maintenance tab.

3 Select Non-Genuine Toner from the list at the left side of the page.

The Non-Genuine Toner page is displayed.

4 Select the check box next to On, and then click Apply New Settings.
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Cleaning the Printer

This section describes how to clean the printer in order to maintain it in good condition and print clean printouts all 
the time.

Cleaning the Scanner
Keep the scanner clean to ensure the best possible copies. Clean the scanner at the start of each day and during 
the day, as needed.

1 Slightly dampen a soft lint-free cloth or paper towel with water.

2 Open the document cover.

WARNING:

• When cleaning this product, use the designated cleaning materials exclusive to it. Other cleaning materials may 
result in poor performance of the product. Never use aerosol cleaners to avoid catching fire and explosion.

CAUTION:

• When cleaning this product, always switch off and unplug it. Access to a live machine interior may cause electric 
shock.
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3 Wipe the surface of the document glass and ADF glass until they are clean and dry.

4 Wipe the underside of the white document cover and film until they are clean and dry.

5 Close the document cover.

1 Film

2 White Document Cover

3 Document Glass

4 ADF Glass

1

2

3

4
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Cleaning the ADF Feed Roller
Keep the ADF feed roller clean to ensure the best possible copies. Clean the ADF feed roller at regular intervals.

1 Open the ADF cover.

2 Wipe the ADF feed roller with a dry soft lint-free cloth or paper towel until it is clean.

If the ADF feed roller gets soiled with ink stains, paper from the ADF may also be soiled. In this case, slightly 
dampen a soft lint-free cloth or paper towel with a neutral detergent or water, and then remove the 
contamination from the ADF feed roller until it is clean and dry.
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Cleaning Inside the Printer

1 Turn off the printer and disconnect the power cord.

2 Open the toner access cover.

3 Pinch the toner cartridge firmly.

4 Pull the toner cartridge out.

IMPORTANT: 

• Always pull the toner cartridge out slowly so you do not spill any toner. 

5 Pull the other three toner cartridges out as well.
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6 Pull the print head cleaning rod out.

7 Insert the print head cleaning rod fully into the hole beside the arrow on the printer until its tip reaches the 
interior of the printer as illustrated below, and then pull it out.

8 Repeat the same procedure for the other three holes.

9 Insert the print head cleaning rod back to its original location.
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10 Replace the black toner cartridge by adjusting it to the associated cartridge holder, and then insert it firmly by 
pressing near the center of the label until the toner cartridge clicks.

11 Replace the other three toner cartridges as well.

12 Close the toner access cover.

13 Connect the power cord and turn on the printer.
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Cleaning the Color Toner Density (CTD) Sensor
Clean the CTD sensor only when an alert for the CTD sensor is shown on the Printer Status window or operator 
panel.

1 Turn off the printer and disconnect the power cord.

2 Push the rear cover handle and open the rear cover.

3 Clean the CTD sensor inside the printer with a clean dry cotton swab.

4 Close the rear cover.

5 Connect the power cord and turn on the printer.
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Replacing Toner Cartridges

Fuji Xerox toner cartridges are available only through Fuji Xerox.

It is recommended that you use Fuji Xerox toner cartridges for your printer. Fuji Xerox does not provide warranty 
coverage for problems caused by using accessories, parts, or components not supplied by Fuji Xerox.

IMPORTANT: 

• Do not shake the used toner cartridge to avoid spilling of the toner.

• Be sure to use the starter toner cartridge shipped with the printer until it gets empty, and then replace it with a purchased one.

WARNING:

• Never use a vacuum cleaner for spilled toner and residual toner in this product, toner cartridge or toner bottle.
It may catch fire by electric sparks inside a vacuum cleaner and cause explosion.
Use a broom or a wet cloth to wipe off the spills.  If you spill a large volume of toner, contact your local Fuji Xerox 
representative.

• Never throw a toner cartridge into an open flame. Remaining toner in the cartridge may catch fire and cause burn 
injuries or explosion.
If you have a used toner cartridge no longer needed, contact your local Fuji Xerox representative for its disposal.

CAUTION:

• Keep drum cartridges (or drum if not a cartridge type) and toner cartridges out of the reach of children. If a child 
accidentally swallows toner, spit it out, rinse mouth with water, drink water and consult a physician immediately.

• When replacing drum cartridges (or drum if not a cartridge type) and toner cartridges, be careful not to spill the 
toner. In case of any toner spills, avoid contact with clothes, skin, eyes and mouth as well as inhalation.

• If toner spills onto your skin or clothing, wash it off with soap and water. 
If you get toner particles in the eyes, wash it out with plenty of water for at least 15 minutes until irritation is gone. 
Consult a physician if necessary. 
If you inhale toner particles, move to a fresh air location and rinse your mouth with water.
If you swallow toner, spit it out, rinse your mouth with water, drink plenty of water and consult a physician 
immediately.



Maintenance 325

Overview
The printer has toner cartridges of four colors: black (K), yellow (Y), magenta (M), and cyan (C).

When a toner cartridge reaches its usable life-span, the following messages appear on the touch panel.

* This warning appears only when Fuji Xerox toner cartridges are used, and Non-Genuine Toner is set to Off.

IMPORTANT: 

• When placing a used toner cartridge on the floor or on a table, place a few sheets of paper under the toner cartridge to catch 
any toner that may spill.

• Do not reuse old toner cartridges once you remove them from the printer. Doing so can impair print quality.

• Do not shake or pound the used toner cartridges. The remaining toner may spill.

• We recommend you to use up the toner cartridges within one year after removing them from the packaging.

Message (Example) Action

093-426 Printer

Black Cartridge

is Close to Life*

The specified toner cartridge has become low. Prepare a new one.

The error code differs depending on the color of the toner cartridge.

• 093-426: Black

• 093-425: Cyan

• 093-424: Magenta

• 093-423: Yellow

Replace Cart.

093-933 Printer

Replace

Black Cartridge

The specified toner cartridge has become empty. Replace the old toner cartridge with 
a new one.

The error code differs depending on the color of the toner cartridge.

• 093-933: Black

• 093-932: Cyan

• 093-931: Magenta

• 093-930: Yellow
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Removing the Toner Cartridges

1 Turn off the printer.

2 Open the toner access cover.

3 Spread a few sheets of paper on the floor or table where the removed toner cartridge is to be placed.

4 Pinch the toner cartridge firmly.

5 Pull the toner cartridge out.

IMPORTANT: 

• Always pull the toner cartridge out slowly so you do not spill any toner.

6 Place the toner cartridge slowly on the sheets of paper spread in step 3.
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 Installing a Toner Cartridge

1 Unpack a new toner cartridge of the desired color and shake it five to six times to distribute the toner evenly.

NOTE: 

• Confirm that the color of the new toner cartridge matches that on the handle before replacing it.

• Handle the toner cartridge carefully to avoid spilling of the toner.

2 Remove the tape from the toner cartridge.

3 Adjust the toner cartridge to the associated cartridge holder, and then insert it firmly by pressing near the center 
of the label until the toner cartridge clicks.
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4 Close the toner access cover.

5 Turn on the printer.

6 Pack the removed toner cartridge in the box in which the installed toner cartridge was packed up.

7 Take care not to contact with the spilled toner and remove the sheets of paper spread under the removed toner 
cartridge.
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Ordering Supplies

The toner cartridges need to be ordered occasionally. Each toner cartridge includes installation instructions on the 
box.

Consumables

IMPORTANT: 

• Use of consumables not recommended by Fuji Xerox can impair machine quality and performance. Use only consumables 
recommended by Fuji Xerox.

• Average standard pages. Declared yield in accordance with ISO/IEC 19798 and ISO/IEC 24712. These values are estimates 
and vary depending on conditions such as the content being printed, paper size, paper type, the machine's operating 
environment, initializing process performed when you turn on or off the printer, and adjustments to maintain print quality.

NOTE: 

• The printable number of pages for the starter toner cartridges shipped with the printer are approximately 1000 pages for black 
toner cartridge and 700 pages for yellow, magenta, and cyan toner cartridges.

• Each toner cartridge includes installation instructions on the box.

When to Order Toner Cartridges
The touch panel displays a warning when the toner cartridge nears its replacement time. Verify that you have 
replacements on hand. It is important to order a toner cartridge when the messages first appear to avoid 
interruptions to your printing. The touch panel displays an error message when the toner cartridge must be replaced.

To order toner cartridges, contact the Fuji Xerox local representative office or an authorized dealer.

IMPORTANT: 

• This printer is designed to provide the most stable performance and print quality when used with the recommended toner 
cartridges. Not using toner cartridges recommended for this machine degrades the performance and printing quality of the 
printer. You could also incur charges if the machine breaks down. To receive customer support and achieve the optimum 
performance of the printer, be sure to use recommended toner cartridges.

Recycling Supplies
• For environmental protection and efficient use of resources, Fuji Xerox reuses returned toner cartridges and 

drums (photoreceptors) to make recycle parts, recycle materials or energy recovery.

• Proper disposal is required for toner cartridges no longer needed. Do not open toner cartridges. Return them to 
your local Fuji Xerox representative.

Product Name Product Code Printable number of pages

Toner Cartridge [Black] High capacity CT202264 Approx. 2000 pages

Toner Cartridge [Yellow] Standard capacity CT202270 Approx. 700 pages

Toner Cartridge [Yellow] High capacity CT202267 Approx. 1400 pages

Toner Cartridge [Magenta] Standard capacity CT202269 Approx. 700 pages

Toner Cartridge [Magenta] High capacity CT202266 Approx. 1400 pages

Toner Cartridge [Cyan] Standard capacity CT202268 Approx. 700 pages

Toner Cartridge [Cyan] High capacity CT202265 Approx. 1400 pages



330 Maintenance

Storing Consumables

Store consumables in their original packaging until you need to use them. Do not store consumables in:

• Temperatures greater than 40°C (104°F).

• An environment with extreme changes in humidity or temperature.

• Direct sunlight.

• Dusty places.

• A car for a long period of time.

• An environment where corrosive gases are present.

• An environment with salty air.



Maintenance 331

Managing the Printer

Checking or Managing the Printer With the CentreWare Internet 
Services

When the printer is installed in a TCP/IP environment, you can check printer status and configure settings using a 
web browser on a network computer. You can also use the CentreWare Internet Services to check the remaining 
volume of consumables and the paper loaded in this printer.

NOTE: 

• When using the printer as a local printer, you cannot use the CentreWare Internet Services. For details about checking the 
status of a local printer, see "Checking Printer Status With the SimpleMonitor (Windows Only)" on page 331.

Starting the CentreWare Internet Services
Use the following procedure to start the CentreWare Internet Services.

1 Launch your web browser.

2 Enter the IP address of the printer in the address bar, and then press the Enter key.

The CentreWare Internet Services page appears.

• Using Online Help
For details regarding the items that can be set in each CentreWare Internet Services page, click Help to display the 
online Help.

Checking Printer Status With the SimpleMonitor (Windows Only)
The SimpleMonitor is a tool that is installed with your print driver. It automatically checks the printer status when you 
send a print job. The SimpleMonitor can also check the status of the tray and remaining amount of toner cartridges.

Starting the SimpleMonitor
Double-click the SimpleMonitor icon on the taskbar or right-click the icon and select Printer Selection.

If the SimpleMonitor icon is not displayed on the taskbar, open the SimpleMonitor from the Start menu.

The following procedure uses Microsoft® Windows® 7 as an example.

1 Click Start  All Programs  Fuji Xerox  Fuji Xerox Printer Software for Asia-Pacific  your printer  
SimpleMonitor-Ctype for Asia-Pacific.

The window to select a printer appears.

2 Click the name of the desired printer from the list.

The Printer Status Window appears.

For details about the functions of the SimpleMonitor, refer to the Help of the SimpleMonitor.

See also: 
• "SimpleMonitor (Windows Only)" on page 40
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Checking Printer Status Through E-mail
When connected in a network environment where sending and receiving of e-mail is possible, the printer can send 
an e-mail report to specified e-mail addresses containing the following information:

• The network settings and the printer status

• The error status which has occurred on the printer

Setting the E-mail Environment
Activate the CentreWare Internet Services. On the Properties tab, configure the following settings according to your 
e-mail environment. After configuring the settings on each screen, always click Apply. For details about each item, 
refer to the online Help for the CentreWare Internet Services.

Item Item to be configured Description

General Setup > 
StatusMessenger

Recipient's E-mail Address 1

Recipient's E-mail Address 2

Set the e-mail address to which notices about changes 
in printer status or errors are sent.

Notification Items Set the contents of the notices to send in the e-mail.

Port Status StatusMessenger Select the Enabled check box.

Protocol Settings > 
E-mail

SMTP Server Settings

• Machine's E-mail Address

• SMTP Server Address

• SMTP Server Port Number

Send Authentication

• E-Mail Send Authentication

• Login Name

• Password

• Re-enter Password

POP3 Server Settings

• POP3 Server Address

• POP3 Server Port Number

• Login Name

• Password

• Re-enter Password

Select appropriate settings for sending and receiving e-
mail.
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Conserving Supplies

You can change several settings in your print driver to conserve toner cartridge and paper.

Supply Setting Function

Toner cartridge Windows print driver:

Toner Saving Mode in the 
Graphics tab

This feature allows the users to select a print mode that 
uses less toner. 
When this feature is used, the image quality will be lower 
than when it is not used.

Print media Windows print driver:

Multiple Up in the Layout 
tab

The printer prints two or more pages on one side of a sheet. 
The available numbers that each print driver can print one 
sheet of paper are as follows:

• Windows print driver: 2, 4, 8, or 16 pages

Combined with the duplex setting, feature allows you to 
print up to 32 pages on one sheet of paper. (16 images 
on the front and 16 on the back)
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Checking Page Counts

The total number of printed pages can be checked at the operator panel. Three meters are available: Meter 1 
(color prints), Meter 2 (monochrome prints), and Meter 4 (Meter 1 + Meter 2). Meter 3 always shows 0 on 
your printer.

The Meter Readings counts the number of pages printed properly. Single side color print (including pages per 
sheet (N-Up)) is counted as one job, and 2-sided print (including pages per sheet (N-Up)) is counted as two. During 
2-sided printing, if an error occurs after one side is printed properly, it is counted as one page.

When printing color data, which has been converted by using ICC profile on an application, with the Color setting, 
the data is printed by color even if it seems to be black and white data on the monitor. In that case, Meter 1 and 
Meter 4 are increased.

When doing 2-sided printing, a blank page may be inserted automatically depending on the settings of the 
application. In this case, the blank page is counted as one page. However, when doing 2-sided printing for odd 
number of pages, the blank page inserted to the back side of the last odd page is not counted.

See also: 
• "Meter Readings" on page 207

1 Press the  (System) button.

2 Select Meter Readings.

3 Check the values for each meter.
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Moving the Printer

1 Turn off the printer.

2 Disconnect the power cord, interface cable, and any other cables.

3 Remove any paper in the document output tray.

4 Remove any paper in the center output tray if there is.
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5 Close the output tray extension if it is extended.

6 Lift the printer and move it gently.

7 Adjust the color registration before using your printer.

See also: 
• "Adjusting Color Registration" on page 291
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Technical Support

Fuji Xerox recommends the Customer first utilize support materials shipped with the product, product diagnostics, 
information contained on the web, and e-mail support. If unsuccessful, to obtain service under product warranty the 
Customer must notify Fuji Xerox Telephone Support or its authorized service representative of the defect before the 
expiration of the warranty period. Customer will provide appropriate assistance to Telephone Support personnel to 
resolve issues, such as restoration of the operating system, software program and drivers to their default 
configuration and settings, verification of functionality of Fuji Xerox supplied products, replacement of customer 
replaceable units, clearing paper misfeeds and cleaning the unit and other prescribed routine and preventative 
maintenance.

If the Customer's product contains features that enable Fuji Xerox or its authorized service representative to 
diagnose and repair problems with the product remotely, Fuji Xerox may request that the Customer allow such 
remote access to the product.



Contacting Fuji Xerox 339

Online Services

You can find detail Product and Consumable warranty information on our website at 
http://www.fujixeroxprinters.com/ 

Fuji Xerox Online Support Assistant provides instructions and troubleshooting guides to resolve your printer 
problems. It is an easy-to-use, searchable online help. To find out more, please visit our online support at 
http://www.fujixeroxprinters.com/ 

http://www.fujixeroxprinters.com/
http://www.fujixeroxprinters.com/
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